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Read This First

Welcome to the Thermo Scientific Q Exactive HF-X system! 
Q Exactive™ HF-X is a member of the Thermo Scientific™ family of 
mass spectrometer (MS) detectors that are powered by Orbitrap™ 
technology.

About This Guide
This Q Exactive HF-X Software Manual provides reference information 
about the parameters in the Instrument Configuration window, the 
Instrument Setup window, and the Q Exactive HF-X Tune window. For 
information about the operating procedures for the Q Exactive HF-X 
mass spectrometer, we recommend that you read the Exactive Series 
Operating Manual in its entirety.

Who Uses This Guide

This Q Exactive HF-X Software Manual is intended for all personnel that 
need to perform measurements with the Q Exactive HF-X mass 
spectrometer, especially the key operator. This manual should be kept 
near the instrument to be available for quick reference.

Scope of This Guide

The Q Exactive HF-X Software Manual includes the following chapters:

• Chapter 1: “Instrument Configuration Window” describes the 
Instrument Configuration window, which displays configuration 
information.

• Chapter 2: “Q Exactive HF-X Readback Status Page for the 
Information View” describes the page that allows controlling the 
instrument from the Roadmap view of the Xcalibur™ Home Page 
window.

• Chapter 3: “Instrument Setup” describes Instrument Setup, which is 
used to specify instrument settings.

• Chapter 4: “Explore Q Exactive HF-X Tune” provides information 
about Q Exactive HF-X Tune, its views, functions, and features.

• Chapter 5: “Procedures in Q Exactive HF-X Tune” provides 
information about procedures in Q Exactive HF-X Tune.
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• Chapter 6: “Reference Information” provides information about 
various file types and other supplemental information.

Related Documentation

In addition to this guide, Thermo Fisher Scientific provides the 
following documents for the Q Exactive HF-X mass spectrometer:

• Exactive Series Pre-Installation Requirements Guide

• Exactive Series Operating Manual

• Q Exactive HF-X QuickStart Guide

• Manuals for the delivered ion sources and other software.

You can access PDF files of the documents listed above and of this guide 
from the data system computer. The Q Exactive HF-X Tune software 
also provides Help.

❖ To view product manuals

Go to Start > Programs > Thermo Exactive Series > Manuals.

❖ To open Help

• From the Q Exactive HF-X Tune window, choose Help > Help 
Content.

• If available for a specific window or dialog box, click Help or press 
F1 for information about setting parameters.

For more information, including upcoming application notes, visit 
www.thermofisher.com.

http://www.thermoscientific.com
http://www.thermofisher.com
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Contacting Us
There are several ways to contact Thermo Fisher Scientific. 

Assistance

For brochures and ordering information, visit us on the Web:

www.thermofisher.com/orbitrap

Service contact details are available under:

www.unitylabservices.com

Visit our customer SharePoint to download current revisions of user 
manuals and other customer-oriented documents for your product. 
Translations into other languages and software packages may be 
available there as well.

With the serial number (S/N) of your instrument, request access as a 
customer via www.thermoscientific.com/Technicaldocumentation. For 
the first login, you have to create an account. Follow the instructions 
given on screen. Please accept the invitation within six days and log in 
with your created Microsoft™ password.

Changes to the Manual

❖ To suggest changes to this manual

• Please send your comments (in German or English) to:

Editors, Technical Documentation
Thermo Fisher Scientific (Bremen) GmbH
Hanna-Kunath-Str. 11

28199 Bremen

Germany

• Send an e-mail message to the Technical Editor at

documentation.bremen@thermofisher.com

You are encouraged to report errors or omissions in the text or index.
Thank you.

http://www.thermofisher.com/orbitrap
http://www.unitylabservices.com/
http://www.thermoscientific.com/Technicaldocumentation
mailto:documentation.bremen@thermofisher.com
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Typographical Conventions
This section describes typographical conventions that have been 
established for Thermo Fisher Scientific manuals.

Signal Word

Make sure that you follow the precautionary statements presented in 
this manual. The special notices appear different from the main flow of 
text:

NOTICE Points out possible material damage and other important 
information in connection with the instrument. ▲

Data Input

Throughout this manual, the following conventions indicate data input 
and output via the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is identified by quotation marks: 
single quotes for single characters, double quotes for strings.

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled 
F1.

• Any command that requires pressing two or more keys 
simultaneously is shown with a plus sign connecting the keys. For 
example, “press <Shift> + <F1>” means press and hold the <Shift> 
key and then press the <F1> key.

• Any button that you click on the screen is represented in bold face 
letters. For example, “click Close”.
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Topic Headings

The following headings are used to show the organization of topics 
within a chapter:

Chapter 1 Chapter Name

Second Level Topics

Third Level Topics

Fourth Level Topics
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Chapter 1 Instrument Configuration Window

NOTICE Do not change the settings in this window except during 
installation of the instrument. Any changes in this window affect the 
data acquisition or the functionality of your instrument. A later change 
will rarely solve problems users have to face. ▲

The Instrument Configuration window displays Q Exactive HF-X 
configuration information. See Figure 1-1.

Figure 1-1. Instrument Configuration window
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The Instrument Configuration window has the following parameters:

❖ To display this window

1. Choose Programs > Thermo Foundation 3.1 > Instrument 
Configuration.

Parameter Description

Path to instrument files Displays the location of the instrument files.

To change the path, click the folder button on the right side of the text box. A 
dialog box appears where you can select another location.

Path to log files Displays the location of the log files. For information about the content of the log 
files, see “Log Files” on page 6-2.

To change the path, click the folder button on the right side of the text box. A 
dialog box appears where you can select another location

Base port Displays the first TCP/UDP port in use for this particular instrument. Leave the 
field empty for an automatic assignment.

Network address Displays the hardware address of the network card installed in the instrument. 
Leave the field empty for an automatic assignment.

IP address Displays the IP address. Leave the field empty for an automatic assignment.

Public Name Displays the name that is shown in the About dialog box of Q Exactive HF-X 
Tune.

Max. audit record length Use this list box to select the maximum audit record length. The following options 
are available:
• 0 disables auditing
• 50 is common for an Access audit database initialized by Platform’s Database 

Configuration
• 255 is common for an Oracle audit database initialized by Platform’s Database 

Configuration
• 1000 is common if auditing is done by Chromeleon. It is a compromise 

between size and readability

Instrument type Displays the configured instrument type, that is Q Exactive HF-X.

IP address range Displays the IP address or IP address range which should be assigned to the 
instrument during its starting phase. Use the numeric form, for example 
“172.16.2.1-172.16.2.15.”

NOTICE Change only when advised by your network administrator. ▲

Message box Displays information about the instrument and connection status.
Buttons

Apply Saves your changes in this window.

Reset changes Discards your changes in this window.

Help Displays the Help for this window.
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2. From the Instrument Configuration window, click 
Q Exactive HF-X - Orbitrap MS in the Configured Devices area.

3. Click Configure.
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Chapter 2 Q Exactive HF-X Readback Status Page for 
the Information View

The readback status of each Xcalibur-configured instrument appears on 
the Status page of the Information view. When you click an instrument, 
Xcalibur™ displays current readings for the instrument on a page below 
the Run Manager pane. See Figure 2-1.

Right-click any of the instruments to display a shortcut menu where you 
can switch your instrument to On, Off, or Standby mode.

NOTICE This view is normally displayed on the left side of the Home 
Page window. If this view is not displayed, the view has been turned 
off. ▲

Figure 2-1. Q Exactive HF-X Readback Status Page for the Information 
View
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The following functions are available:

❖ To open this page

1. From the Home Page window, choose View > Info View to display 
the Information view. 

2. Click the Status tab.

3. Click Q Exactive HF-X - Orbitrap MS.

Button Description

Communication Status Shows the actual communication status of the system:
• Green: communication with instrument is ok.
• Yellow: only service is accessible (no instrument).
• Red: communication is broken (no instrument, no service).

Instrument Status Shows the actual hardware status of the system (top instrument tree 
state):

• Green: all readbacks are in specifications (green hooks).
• Red: one or more readbacks are out of range.

Performance Status Shows the actual performance status of the system:
• Green: the last evaluation/calibration was successful.
• Yellow: last evaluation/calibration was successful, but is out of 

date.
• Red: the evaluation/calibration was not successful.

Tune Opens the Q Exactive HF-X Tune window.
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Chapter 3 Instrument Setup

After you have selected in the Instrument Configuration program which 
instruments you want Xcalibur to control, use Instrument Setup to 
specify your instrument settings.

Contents

• “Instrument Setup Window” on page 3-2

• “Experiment Setup Page” on page 3-7

• “Summary Page” on page 3-74

• “Dialog Boxes of the Experiment Setup Page” on page 3-75
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Instrument Setup Window
The Instrument Setup window displays the icons of the instruments 
that you have selected using the Instrument Configuration window. (See 
the View bar on the left side of the window.) See Figure 3-1. If you have 
configured more instruments than can be displayed on your screen, a 
vertical scroll bar appears in the View bar. So, you can access all of the 
instruments.

To enter the setup parameters for a particular instrument, click the icon 
for that instrument. Xcalibur displays one or more pages of parameters 
to be set for the one you selected.

NOTICE Before using the Instrument Setup window, use the 
Instrument Configuration program to select the instruments to be used 
for your experiment. ▲

Use Instrument Setup to specify settings for your instruments after you 
have selected with the Instrument Configuration program the 
instruments that you want Xcalibur to control. The Instrument Setup 

Figure 3-1. Instrument Setup window
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window displays the setup parameters required for each instrument that 
you select on the View bar. These might include your autosampler, 
LC pump, mass spectrometer, divert valves, syringe pump, contact 
closure timing sequence, and/or all other Xcalibur supported 
instruments that you have configured.

You can create new methods, modify existing methods, and save method 
files.

❖ To display this window

• Click  from the Roadmap view of the Home Page window.

• Or, choose GoTo > Instrument Setup.

View Bar

The View bar is a vertical bar on the left of the Instrument Setup 
window. It contains buttons for each of the instruments that you have 
selected by using the Instrument Configuration program.

Menus

Instrument Setup contains the following menus:

• File Menu for the Instrument Setup Window

• Help Menu for the Instrument Setup Window

Toolbar

Instrument Setup Window Toolbar

File Menu for the Instrument Setup Window

The File menu provides commands for file and program operations. It 
has the following commands:

Command Description 

New Create a new method file having the appropriate extension.

Open Find and open a file that already exists.

Save Save the active method. Changes will be recorded in Audit Trail after the 
method is saved.
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Help Menu for the Instrument Setup Window

The Help menu lists the following commands:

Save As Edit user and description information, and view header information 
about the active file.

Xcalibur opens the Save As dialog box. Changes will be recorded in Audit 
Trail after the method is saved.

Summary Information Edit user and description information, and view header information 
about the active file.

Change Study Name Select a dataset from a predefined list of names.

The text of this menu item might be different if the administrator chose 
to use another name for a dataset. For example, this menu item might be 
Change Job Name.

Audit Trail View all auditable events and changes made to data files in the current 
application.

Print Print the parameters in your instrument method.

Print Preview View your page setup so that you can see what it looks like before 
printing it.

Print Setup Select the following printing options: printer, form, orientation, and 
one-sided or two-sided printing.

Most Recently Used Files View the paths and names of the last four files used. These are located 
above the Exit command. Both open and closed files are displayed. Click 
a displayed file to load it. If the selected file was closed, it will be opened.

Exit Close the active window. If you exit before clicking OK from an active 
dialog box, Xcalibur asks if you want to save your changes.

Command Description 

Command Description 

Q Exactive HF-X - 
Orbitrap MS Help

Open the Configuration and Setup Help 
for the instrument.

Instrument Setup Help Open Xcalibur Help and display Help for 
the Instrument Setup window.

Help On Current Item View Help for the Instrument Setup page 
that is currently displayed.

Q Exactive HF-X - 
Orbitrap MS Contents 
and Index

View the Contents, Index, and Find Help 
pages for the selected instrument.

Xcalibur Help Open Xcalibur Help.
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Instrument Setup Window Toolbar

The toolbar provides symbol shortcuts for frequently used commands. 
The following functions are available:

Glossary Open the Xcalibur glossary.

How to use Online Help Open Help that describes how to use the 
Help viewer.

About Instrument Setup View the version number of the 
Instrument Setup program and the 
Thermo Fisher Scientific copyright 
notice.

Command Description 

Button Description 

New Create a new instrument method. 

Open Find and open an existing file. 

Save If your method has not been saved before, 
clicking Save opens the Save As dialog box. Select 
the name and location for your instrument 
method. When you click Save, the File Summary 
Information Dialog Box opens. Enter header 
information for your instrument method. The file 
is saved when you click OK.

Print Print the parameters in your instrument method. 

Home Page View the Home Page window—Roadmap view.

Help View Help for the Instrument Setup page that is 
currently displayed.
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Method Editor

Use the Method Editor to specify the type of mass spectrometer 
experiment you plan to perform. See Figure 3-2.

The Method Editor has the following pages:

• Experiment Setup Page

• Summary Page

❖ To display this view

Click Instrument Setup from the Roadmap View of the Home 
Page window or choose GoTo > Instrument Setup.

Figure 3-2. Method Editor
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Experiment Setup Page
Use the Experiment Setup page to set up Q Exactive HF-X mass 
spectrometer experiments. You use this page to specify values for the 
Q Exactive HF-X parameters and save the parameters in an instrument 
method. See Figure 3-3.

The Experiment Setup page comprises four major windows:

• Global Settings Pane

• Experiment Pane

• Graph Pane

• Properties Pane

Figure 3-3. Method Editor—Experiment Setup page

Global Settings pane

Experiment pane Properties paneGraph pane
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Global Settings Pane

The Global Settings pane is located on the top left side of the 
Experiment Setup page. It gives access to global lists, tune files, external 
hardware, chromatogram, and scan groups. See Figure 3-4.

The Global Settings pane contains the following panes:

• Global Lists

• Tune Files

• External Hardware

• Chromatogram

• Scan Groups

Click the title bar of an individual pane to display it. Click again to hide 
it.

Figure 3-4. Method Editor—Global Settings pane
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Global Lists

Use the Global Lists pane of the Experiment Setup page to perform 
intelligent automated MS/MS and SIM type experiments by efficiently 
utilizing the mass spectrometer to characterize parent ions independent 
of the “current segment” model. Use the Global Lists pane to specify 
parent, reject, and/or non-data dependent MS/MS and SIM masses 
with customizable and independent time windows. See Figure 3-5. Scan 
events that reference the mass lists that you create here run only if there 
is a corresponding mass/time window at that particular retention time.

The following dialog boxes are available:

• Lock Masses Dialog Box

• Inclusion List Dialog Box

• Exclusion List Dialog Box

• Neutral Losses Dialog Box

• Tag Masses Dialog Box

To display a dialog box, click the respective icon.

Tune Files

The Tune Files pane shows a graphical representation of the tune files 
usage during the various phases of the experiment. See Figure 3-6. In 
addition to the base tune file, you can specify up to 50 other tune files.

❖ To assign tune files

1. Do one of the following:

• Point to a position on the time bar and right-click. Choose 
Change to another tunefile at <time at pointer position> in 
the shortcut menu.

Figure 3-5. Method Editor—Global Lists pane

Figure 3-6. Method Editor—Tune Files
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• Change the value of the Switch Count parameter in the 
Properties of Tunefiles pane.

2. In the Properties of Tunefiles pane, click the button next to the 
respective box of the Base Tunefile or New Tunefile parameter and 
browse for the new tune method file. See Figure 3-7. Select the tune 
files and assign them to the experiment phases.

The name and path way of the tune files will be shown on the 
respective time bar on the Tune Files pane.

❖ To change the starting time for tune files

• Position the cursor between adjacent tune files and drag the scan 
event along the time bar.

• In the Properties of Tunefiles pane, enter the time in the box of the 
At parameter of the respective Element.

❖ To remove a tune file

1. Position the cursor between adjacent tune files

2. Right-click to display the shortcut menu and choose Remove 
change to tunefile at <time at pointer position>. The tune file to 
the right is removed.

❖ To zoom on the Tune Files pane

• Position the mouse pointer within the time axis area and drag the 
mouse across the time area of interest.

• To zoom in, position the mouse pointer within the pane and roll the 
mouse wheel forward.

• To zoom out, roll the wheel backward.

• To increase the zooming factor by two, keep the <Shift> key pressed 
while using the mouse wheel.

Figure 3-7. Properties of Tunefiles
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❖ To unzoom the Tune Files pane

Right-click in the pane to display the shortcut menu. Choose 
Unzoom.

❖ To display this view

On the External Hardware pane, expand the Tune Files item.

External Hardware

Use the External Hardware pane to configure and control optional 
hardware.

Divert Valve a / Divert Valve b

The Divert Valve items show graphic representations of the activities of 
the optional switching valves during the active acquisition. See 
Figure 3-8. The normal LC flow through the switching valve 
(Position 1-2) is to the mass spectrometer. When the switching valve is 
activated (Position 1-6), LC flow is diverted to waste. 

❖ To display this view

On the External Hardware pane, expand the Divert Valve a or 
Divert Valve b item.

Figure 3-8. Properties of a switching valve that is used
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Use the shortcut menu of a Divert Valve item and the parameters of its 
Properties pane to control its activities:

❖ To activate a switching valve

• Right-click in the pane to display the shortcut menu. Choose 

Activate. The gray color  changes to the blue color 

. See Figure 3-8.

• Click the valve symbol to select it. Set the Used parameter on the 
Properties pane to True.

❖ To deactivate a switching valve

• Right-click in the pane to display the shortcut menu. Choose 

Deactivate. The blue color changes to a gray color . See 
Figure 3-9.

• Click the valve symbol to select it. Set the Used parameter on the 
Properties pane to False.

❖ To change the start position of a switching valve

• Right-click in the pane to display the shortcut menu. Depending on 
the active start position, choose Start in 1-6 or Start in 1-2. The 
valve changes its start position.

• Click the valve symbol to select it. Depending on the active start 
position, set the Start in 1-2 parameter on the Properties pane to 
True or False.

❖ To add a switch position for a switching valve

1. Activate the switching valve as described above.

Figure 3-9. Properties of a switching valve that is not used
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2. Do one of the following:

• Use the mouse:

a. Move the mouse pointer to the position on the time line where 
you want to establish a switch position (5 minutes, for example).

b. Right-click in the pane to display the shortcut menu. Choose 
Add switch at 5.00.

• Use the Properties pane:

a. Click the valve symbol to select it.

b. Set the Switch count parameter on the Properties pane to 1.

A step in the line of the graphic representation indicates the new 
switch point. See Figure 3-8.

3. To change the time of the switch position, do one of the following:

• Drag the step that indicates the switch position to the new time.

• On the Properties pane, set the At parameter of the respective 
Element to the new time.

❖ To delete a switch position

1. Move the mouse pointer to the switch position on the time line (at 
5 minutes, for example).

2. Right-click in the pane to display the shortcut menu. Choose 
Remove switch at 5.00.
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Syringe

The Syringe item shows a graphic representation of the activities of the 
optional syringe pump during the active acquisition. See Figure 3-10.

❖ To display this view

On the External Hardware pane, expand the Syringe Pump item.

Use the shortcut menu of the Syringe Pump item and the parameters of 
its Properties pane to control the activity of the syringe pump:

❖ To activate the syringe pump

• Right-click in the pane to display the shortcut menu. Choose 

Activate. The gray color  changes to the red color 

. See Figure 3-10.

• Click the valve symbol to select it. Set the Used parameter on the 
Properties pane to True.

❖ To deactivate the syringe pump

• Right-click in the pane to display the shortcut menu. Choose 

Deactivate. The red color changes to a gray color .

• Click the valve symbol to select it. Set the Used parameter on the 
Properties pane to False.

Figure 3-10. Syringe Pump pane
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❖ To change the start position of the syringe pump

• Right-click in the pane to display the shortcut menu. Depending on 
the active start position, choose Start in ON or Start in OFF. The 
pump changes its start position.

• Click the syringe symbol to select it. Depending on the active start 
position, set the Start in Off parameter on the Properties pane to 
True or False.

❖ To add a switch position for the syringe pump

1. Activate the syringe pump as described above.

2. Do one of the following:

• Use the mouse:

a. Move the mouse pointer to the position on the time line where 
you want to establish a switch position (5 minutes, for example).

b. Right-click in the pane to display the shortcut menu. Choose 
Add switch at 5.00.

• Use the Properties pane:

a. Click the syringe symbol to select it.

b. Set the Switch count parameter on the Properties pane to 1.

A step in the line of the graphic representation indicates the new 
switch point. See Figure 3-10.

3. To change the time of the switch position, do one of the following:

• Drag the step that indicates the switch position to the new time.

• On the Properties pane, set the At parameter of the respective 
Element to the new time.

❖ To delete a switch position

1. Move the mouse pointer to the switch position on the time line (at 
5 minutes, for example).

2. Right-click in the pane to display the shortcut menu. Choose 
Remove switch at 5.00.
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Contact Closure

The Contact Closure item shows a graphic representation of the contact 
closure activities during the active acquisition. See Figure 3-11.

The settings of the Contact Closure item control the signals that the 
mass spectrometer transmits via the port labeled Start Out at its 
peripheral control output connection.

❖ To display this view

On the External Hardware pane, expand the Contact Closure item.

Use the shortcut menu of the Contact Closure item and the parameters 
of its Properties pane to control the contact closure activities:

❖ To activate the contact closure

• Right-click in the pane to display the shortcut menu. Choose 

Activate. The gray color  changes to the green color 

. See Figure 3-11.

• Click the contact closure symbol to select it. Set the Used parameter 
on the Properties pane to True.

❖ To deactivate the contact closure

• Right-click in the pane to display the shortcut menu. Choose 

Deactivate. The green color changes to a gray color .

• Click the contact closure symbol to select it. Set the Used parameter 
on the Properties pane to False.

❖ To change the start position of the contact closure

• Right-click in the pane to display the shortcut menu. Depending on 
the active start position, choose Start in Open or Start in Closed. 
The contact closure changes its start position.

Figure 3-11. Contact closure
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• Click the contact closure symbol to select it. Depending on the 
active start position, set the Start in Closed parameter on the 
Properties pane to True or False.

❖ To add a switch position for the contact closure

1. Activate the contact closure as described above.

2. Do one of the following:

• Use the mouse:

a. Move the mouse pointer to the position on the time line where 
you want to establish a switch position (5 minutes, for example).

b. Right-click in the pane to display the shortcut menu. Choose 
Add switch at 5.00.

• Use the Properties pane:

a. Click the contact closure symbol to select it.

b. Set the Switch count parameter on the Properties pane to 1.

A step in the line of the graphic representation indicates the new 
switch point. See Figure 3-10.

3. To change the time of the switch position, do one of the following:

• Drag the step that indicates the switch position to the new time.

• On the Properties pane, set the At parameter of the respective 
Element to the new time.

❖ To delete a switch position

1. Move the mouse pointer to the switch position on the time line (at 
5 minutes, for example).

2. Right-click in the pane to display the shortcut menu. Choose 
Remove switch at 5.00.
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Chromatogram

The chromatogram display shows the chromatogram for the selected 
raw file. See Figure 3-12. If you have previously obtained a raw file 
(*.raw) of the chromatographic component separation, you can open 
this file.

❖ To display a chromatogram

1. In the Properties of Chromatogram pane, click into the empty field 
of the Rawfile parameter to display the  button. See Figure 3-13.

2. Click the  button to open a dialog box where you can browse for 
the raw file.

3. Select the raw file.

4. If available, select a scan filter.

5. Select a trace type. See Figure 3-7.

The software updates the chromatogram immediately after a change.

Figure 3-12. Chromatogram Display

Figure 3-13. Selecting a rawfile

Figure 3-14. Properties of Chromatogram
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❖ To zoom on the chromatogram

• Position the mouse pointer within the time axis area and drag the 
mouse across the time area of interest.

• To zoom in, position the mouse pointer within the chromatogram 
and roll the mouse wheel forward.

• To zoom out, roll the wheel backward.

• To increase the zooming factor by two, keep the <Shift> key pressed 
while using the mouse wheel.

❖ To unzoom the chromatogram

Right-click in the Scan Groups pane to display the shortcut menu. 
Choose Unzoom.

NOTICE The chromatogram is also zoomed when the time axis of the 
Scan Groups is zoomed. ▲

❖ To display this view

On the External Hardware pane, expand the Chromatogram item.

Scan Groups

In the Scan Groups pane, time bars represent the scan events during the 
acquisition. See Figure 3-15. The Scan Groups pane is filled when you 
drag experiment symbols from the Experiment pane to the Graph pane.

Use the Properties pane of a scan event to control the activities during 
individual experiments. Red triangles ( ) to the left side of a time bar 
indicate active scan events.

❖ To display the active scan events at a certain time

Click the time line at the position. A red arrow ( ) indicates the 
selected time. A green triangle ( ) to the left side of the time bar 
indicates the active scan event. If scan events overlap at the selected 

Figure 3-15. Scan Groups
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time, green triangles appear for each active scan event. The bottom 
part of the Properties pane shows the parameters for the selected 
scan event.

❖ To change start and end time of a scan event

• Drag the left and right edges of the time bar to the desired positions 
on the time line.

• Enter the times in the Minimum and Maximum boxes of the 
runtime parameter on the Properties pane.

❖ To zoom on the Scan Groups pane

• Position the mouse pointer within the time axis area and drag the 
mouse across the time area of interest.

• To zoom in, position the mouse pointer within the pane and roll the 
mouse wheel forward.

• To zoom out, roll the wheel backward.

• To increase the zooming factor by two, keep the <Shift> key pressed 
while using the mouse wheel.

❖ To unzoom the Scan Groups pane

Right-click in the pane to display the shortcut menu. Choose 
Unzoom.

NOTICE The Scan Groups pane is also zoomed when the time axis of 
the chromatogram display is zoomed. ▲

❖ To display this view

On the External Hardware pane, expand the Scan Groups item.

Experiment Pane

The Experiment pane is located on the bottom left side of the 
Experiment Setup page. It gives access to predefined experiment 
templates. You cannot delete the experiment templates. You cannot 
combine experiment templates from different folders.

Every single experiment is associated with a descriptive icon. This icon 
can be dragged from the Experiment pane to the Graph pane. When 
selected, the icon gives an overview to the operator, which experiment 
and which associated options are active currently. Therefore, this icon 
changes dependent on the settings. Use the Properties pane to specify 
the values for your experiment parameters.
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NOTICE Licenses installed on your instrument may affect the number 
of available experiments and the parameters used by them. ▲

General Experiment Templates

The General folder contains predefined templates for experiments. See 
Figure 3-16.

The Experiment Setup page allows using several system templates in an 
instrument method.

HMR Experiment Templates

The HMR folder contains predefined templates for experiments to be 
performed in High Mass Range (HMR) mode. See Figure 3-17. This 
folder is available only on systems with a valid High Mass Range license.

The Experiment Setup page allows using only one HMR template in an 
instrument method.

NOTICE An HMR Experiment can only be run with a tune file that was 
saved while HMR mode was active. ▲

Figure 3-16. Available general templates

Figure 3-17. Available HMR templates
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Experiment Symbols

The following experiment templates are available on the Experiment 
pane. Click the experiment symbol in the table to display an overview of 
the available parameters and values, which are displayed on the 
Properties Pane.

Template Experiment Symbol Description

General Experiment Templates

Full MS – SIM This experiment comprises a full MS scan or SIM scan 
without HCD fragmentation.

Special features:
• Segmented Master Scans

AIF This All Ion Fragmentation (AIF) experiment will acquire 
MS/MS fragment scans with a wide isolation range. The 
set m/z range defines the quadrupole isolation as well as 
the analyzer detection window.

Special features:
• Stepped Collision Energy (NCE)

Full MS / AIF This experiment* comprises a full MS scan (without 
collision energy) followed by an AIF-scan (with a collision 
energy applied). Ions of the second scan event enter the 
HCD cell, ions of the first do not.

Special features:
• Stepped Collision Energy (NCE)
* This experiment is not available on systems with a valid High Mass Range 

license.

Full MS / dd-MS2 (TopN) This experiment comprises a full MS scan (without 
collision energy) followed by a set of Data Dependent™ 
scans with a collision energy applied. Ions of the second 
scan event enter the HCD collision cell, ions of the first do 
not.

Special features:
• Auto value option: Dynamic Exclusiona

• Segmented Master Scans
• Spectral Multiplexing (MSX)
• Stepped Collision Energy (NCE)

NOTICE Filters for triggering Data Dependent scans are 
listed under dd Settings. ▲
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Targeted-SIM This experiment acquires Single Ion Monitoring (SIM) 
scans depending on the entries of the global inclusion list, 
which is therefore mandatory and always activated. The 
mandatory inclusion list will be processed from first to last 
row without any automated sorting. Inclusion list entries 
with overlapping isolation windows are not multiplexed in 
the same scan event.

Special features:
• Spectral Multiplexing (MSX). 

NOTICE
• Inclusion list entries with overlapping isolation 

windows are not multiplexed in the same scan event. 
Here, triggering the second inclusion list candidate 
will be deferred to the next MSX scan event. 

• Use MSX ID of the inclusion list for user-defined 
sorting of single entries or user-defined 
multiplexing. ▲

PRM This Parallel Reaction Monitoring (PRM) experiment 
comprises MS/MS scans depending on the entries of the 
inclusion list. The mandatory inclusion list will be 
processed from first to last row without any automated 
sorting.

Special features:
• Spectral Multiplexing (MSX)
• Stepped Collision Energy (NCE)

Targeted-SIM / dd-MS2 This experiment comprises a targeted-SIM scan on 
precursor ions followed by a set of Data Dependent 
triggered MS/MS scans.

Special features:
• Auto value option: Dynamic Exclusiona

• Spectral Multiplexing (MSX)
• Stepped Collision Energy (NCE)

NOTICE Filters for triggering Data Dependent scans are 
listed under dd Settings. ▲

Template Experiment Symbol Description
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Full MS / AIF / NL dd-MS2 This experiment* comprises a full MS scan followed by an 
All Ion Fragmentation (AIF) scan. When a user-defined 
m/z loss is recognized between one signal in the full MS 
scan and one signal in the subsequent AIF scan, a Data 
Dependent MS/MS scan will be triggered on the precursor 
ion of the full MS scan. The global Neutral Loss list is 
mandatory for this experiment.

Special features:
• Auto value option: Dynamic Exclusiona

• Spectral Multiplexing (MSX)
• Stepped Collision Energy (NCE)
* This experiment is available only when HMR mode and Protein mode are set 

to Off in the Tune file.

DIA This Data Independent Acquisition (DIA) experiment 
covers the scan range by targeted HCD events with 
isolation windows defined in the inclusion list, which can 
also be acquired in multiplexing mode. The mandatory 
inclusion list will be processed from first to last row 
without any automated sorting.

Special features:
• Spectral Multiplexing (MSX)
• Stepped Collision Energy (NCE)

NOTICE Per multiplexed DIA scan event, isochronous 
injection times are used. ▲

HMR

The parameter ranges of these experiments are modified to allow measuring intact proteins and protein 
complexes up to m/z 8000 under native/non-denaturing conditions. These experiments are available only on 
systems with a valid High Mass Range license.

HMR - Full MS The HMR - Full MS is an experiment to acquire full 
MS scans.

HMR - AIF The HMR - AIF is an experiment to acquire 
HCD MS scans.

a Auto value options: Depending on the experiment type, properties like “Dynamic Exclusion” can be set automatically by the software, dependent 
on the chromatographic peak width (FWHM).

Template Experiment Symbol Description
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Graph Pane

The Graph pane is located at the middle bottom side of the Experiment 
Setup window. It shows a graphic representation of the experiment 
during the acquisition. See Figure 3-18.

❖ To add an experiment to the active method

1. Do one of the following:

• Double-click an experiment symbol on the Experiment pane.

• Drag an experiment symbol from the Experiment pane to the 
gray bar in the Graph pane.

In Xcalibur, the Scan Groups pane shows a corresponding time bar 
for each symbol.

2. Use the Properties pane of an experiment to control the activities 
during individual experiments.

❖ To delete an experiment

1. Right-click the experiment symbol to display the shortcut menu.

2. Choose Delete this <Name of Experiment>.

❖ To zoom in or out on the Graph pane

• Position the mouse pointer within the pane and roll the mouse 
wheel forward to zoom in.

• Roll the wheel backward to zoom out.

The zoom factor ranges from 0.25 to 2. The actual zoom factor is 
displayed in the top right corner of the Graph pane.

Figure 3-18. Graphic representation of the experiment
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Properties Pane

The Properties pane is located at the right side of the Experiment Setup 
page. See Figure 3-19.

The pane consists of two parts:

• Properties of the Method

The upper part is always available. It shows the properties of the 
active method.

The lower part depends on the item that is selected on the left side of 
the Experiment Setup page. One of the following tables is displayed:

• Properties of Tunefiles

The table shows the properties of the tune files selected in the 
Global Settings pane.

• Properties of Divert Valve A / Divert Valve B

The table shows the properties of the switching valve selected in the 
Global Settings pane.

• Properties of Syringe

The table shows the properties of the syringe pump selected in the 
Global Settings pane.

Figure 3-19. Properties pane
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• Properties of Contact Closure

The table shows the properties of the contact closure selected in the 
Global Settings pane.

• The table shows the parameters for the experiment symbol selected 
in the Graph pane:

- Properties of Full MS – SIM

- Properties of AIF

- Properties of Full MS / AIF

- Properties of Full MS / dd-MS2 (TopN)

- Properties of Targeted-SIM

- Properties of PRM

- Properties of Targeted-SIM / dd-MS2

- Properties of Full MS / AIF / NL dd-MS2

- Properties of DIA

The following experiments are available only for systems with a valid 
High Mass Range license:

- Properties of HMR - Full MS

- Properties of HMR - AIF

Properties of the Method

The properties of the method include the following parameters:

Parameter Description

Global Settings

User Role Use this field to specify whether the advanced parameters for scan events are 
displayed or not. To show the advanced parameters, set the field to 
Advanced. To hide the advanced parameters, set the field to Standard. 
Double-click into the field to change the status.
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use lock masses Use the list box to specify how lock masses are used in the active instrument 
method. The following options are available:
• off

No lock masses are used.
• best

Only the most intense lock mass of the global list that is found in the 
spectrum is used for a calibration.

• if all present
Lock masses are used only when all active masses of the global lock mass 
list are present at the same time.

NOTICE If timed lock masses are used, the mass spectrometer takes into 
account only those lock masses whose time windows cover the current 
retention time. ▲

Lock mass injectiona If lock masses are used in the active instrument method, use this field to 
select the scan types for which lock mass will be additionally injected. The 
mass spectrometer will inject all lock masses of the active lock mass list to 
provide additional signals to improve mass accuracy. The decision whether 
found lock masses will be used for the mass correction is not affected and 
depends on the settings for the “use lock masses” parameter.

Enter the scan types manually by using commas as separators for the strings. 
Or, click the down arrow to display a dialog box and select the corresponding 
check boxes. The following options are available:
• Full MS
• MS2

• SIM

Chrom. peak width (FWHM) Use this box to specify the estimated or determined chromatographic peak 
width at full width half maximum for the user’s chromatographic setup.

Based the value in this field, the mass spectrometer may calculate the values 
of other parameters to optimize the settings for HPLC or UHPLC if they are 
set to Auto:
• Automatic pre-scanning for AGC

AGC information will be updated automatically with a high frequency, 
when setting a lower FWHM (for fast chromatography)

• Dynamic exclusion

To change the peak width, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. Or, enter the time in the spin 
box text field. The valid range for the peak width is from 1 to 10000 seconds.

Parameter Description
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Time

Method duration Use this box to specify the total mass spectrometer acquire time, in minutes, 
for the run. Q Exactive HF-X Tune rescales the Segments bar to correspond 
to the specified acquire time.

To change the time, click the arrows in the spin box to increment [up arrow] 
or decrement [down arrow] the value. Or, enter the time in the spin box text 
field. The valid range for the time is from 0.1 to 10000 minutes.

Customized Tolerances (+/-)a

Lock Masses
Inclusion
Exclusion
Neutral Loss
Mass Tags
Dynamic Exclusion

Use the boxes in this group to adjust mass tolerances for global lists in 
different instrument methods. The tolerance can be set independently for 
each list type.

The setting for Neutral Loss tolerances refers to the reference m/z and not to 
the mass difference m/z.

To change a tolerance, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. Or, enter the tolerance in the 
spin box text field. Available options are:
• – (use instrument default)
• 0.1–1000 ppm
• 0.1–50000 mmu

When you directly enter a tolerance in the text field, you can use additional 
units. The software will convert it to ppm or mmu depending of its nature 
(absolute or relative definition). Accepted units are (for absolute definition: 
Da, Th, u, mmu; for a relative definition: ppt, ppb, ppm, %). An empty 
property value field as well as a set value of 0, -, or off will result in using the 
instrument default (displayed as –). 

a This parameter is not available when User Role is set to Standard.

Parameter Description
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Properties of Tunefiles

The properties of the Tune Files item include the following parameters:

❖ To show this view

Click the Tunefiles symbol in the Global Settings pane.

Properties of Divert Valve A / Divert Valve B

The properties of a switching valve include the following parameters:

Parameter Description

General

Switch Count Use this spin box to enter the number of switch positions that are to occur during a run. 
The valid range of positions is 0 through 50. Entering “0” results in the switch 
remaining either On or Off throughout the run. Enter a number between “1” and “50” 
to change the state from Off to On or On to Off at multiple specified times during a 
run.

The number of positions on the Retention Time bar corresponds to the number of 
switch positions you specify using this spin box. When you enter a number different 
from 0, a corresponding number of Element parameter groups is displayed on the 
Properties pane.

Base Tunefile Use this box to specify the current tune method file. To change the tune method file, 
click the button next to the box and browse for the new tune method file.

NOTICE A red dot in the left column indicates that no tune file is selected. ▲

Elementn (n=1–50)

Use the parameters of the Element groups to specify properties for the active item during individual switching 
events. The displayed parameters depend on the active item.

At Use this spin box to specify the time of the switching event.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

New Tunefile Use this box to specify the tune method file for the new element. To change the tune 
method file, click the button next to the box and browse for the new tune method file.

NOTICE A red dot in the left column indicates that no tune file is selected. ▲

Parameter Description

General

Used Use this field to specify whether the switching valve is used during the acquisition or 
not. To use the switching valve, set the field to True. To not use the switching valve, set 
the field to False. Double-click into the field to change the status.
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❖ To show this view

Click the Divert Valve a / Divert Valve b symbol in the External 
Hardware pane.

Properties of Syringe

The properties of the Syringe item include the following parameters:

Start in 1-2 Use this field to specify whether the initial position of the switch at the start of a run is 
1-2 or 1-6. To start the switching valve in position 1-2, set the field to True. To start 
the switching valve in position 1-6, set the field to False. Double-click into the field to 
change the status.

Switch Count Use this spin box to enter the number of switch positions that are to occur during a 
run. The valid range of positions is 0 through 50. Entering “0” results in the switch 
remaining either On or Off throughout the run. Enter a number between “1” and “50” 
to change the state from Off to On or On to Off at multiple specified times during a 
run.

The number of positions on the Retention Time bar corresponds to the number of 
switch positions you specify using this spin box.

Element n (n=1–50)

Use the parameters of the Element groups to specify properties for the active item during individual switching 
events. The displayed parameters depend on the active item.

At Use this spin box to specify the time of the switching event.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

Switches to This display field shows the status to which the contact closure is switched.

Parameter Description

Parameter Description

General

Used Use this field to specify whether the syringe pump is used during the acquisition or not. 
To use the syringe pump, set the field to True. To not use the syringe pump, set the 
field to False. Double-click into the field to change the status.

Start in Off Use this field to specify whether the initial state of the switch at the start of a run is On 
or Off. To start the acquisition with the syringe pump in Off status, set the field to 
True. To start the acquisition with the syringe pump in On status, set the field to False. 
Double-click into the field to change the status.

Stop at end of run Use this field to have the mass spectrometer turn the syringe pump off when the run is 
completed. To turn the syringe pump off, set the field to True. To not have the mass 
spectrometer turn the syringe pump off after the run, set the field to False. 
Double-click into the field to change the status.
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❖ To show this view

Click the Syringe symbol in the External Hardware pane.

Switch Count Use this spin box to enter the number of switch positions that are to occur during a 
run. The valid range of positions is 0 through 50. Entering “0” results in the switch 
remaining either On or Off throughout the run. Enter a number between “1” and “50” 
to change the state from Off to On or On to Off at multiple specified times during a 
run.

The number of positions on the Retention Time bar corresponds to the number of 
switch positions you specify using this spin box.

Pump Setup

Use the settings in this area to specify the syringe type and flow rate of the syringe pump.

Syringe type Use this list box to specify the syringe type (Hamilton, Unimetrics, or Other). If you 
select Hamilton or Unimetrics, you must specify the volume of the syringe in the 
Volume list box. If you select Other, you must specify the inside diameter of the syringe 
in the Inner diameter spin box.

Flow Rate Use this spin box to set the volume of solvent solution passing through the syringe 
pump per unit time. The acceptable range of values depends on the selected syringe 
diameter.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

Inner diameter Use this spin box to specify the inside diameter for syringes other than Hamilton and 
Unimetrics syringes. The acceptable range of values is 0.1 to 35 mm.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

Volume (μL) Use this list box to specify the syringe volume for Hamilton and Unimetrics syringes. 
The acceptable values depend on the syringe type:
• Hamilton:

0.5, 1, 2, 5, 10, 25, 50, 100, 250, and 500 μL.
• Unimetrics:

10, 25, 50, 100, 250, 500, 1000, 2500, 5000, 10000, 25000, and 50000 μL.
Element n (n=1–50)

Use the parameters of the Element groups to specify properties for the active item during individual switching 
events. The displayed parameters depend on the active item.

At Use this spin box to specify the time of the switching event.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

Switches to This display field shows the status to which the syringe pump is switched.

Parameter Description
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Properties of Contact Closure

The properties of the Contact Closure item include the following 
parameters:

❖ To show this view

Click the Contact Closure symbol in the External Hardware pane.

Parameter Description

General

Used Use this field to specify whether a timed contact closure program is used in an 
experiment method or not. To use the contact closure, set the field to True. To not use 
the contact closure, set the field to False. Double-click into the field to change the 
status.

Start in Closed Use this field to specify whether the initial status of the contact closure at the start of a 
run is On or Off. To start the acquisition with the syringe pump in Closed status, set 
the field to True. To start the acquisition with the contact closure in Open status, set 
the field to False. Double-click into the field to change the status.

Switch Count Use this spin box to select the number of switch positions that are to occur during a 
run. The valid range of positions is 0 through 50. Selecting “0” results in the switch 
remaining either Closed or Open throughout the run. Selecting a number between “1” 
and “50” allows you to change the state from Closed to Open or Open to Closed at 
multiple specified times during a run.

The number of positions on the Retention Time bar corresponds to the number of 
switch positions you specify using this spin box.

Element n (n=1–50)

Use the parameters of the Element groups to specify properties for the active item during individual switching 
events. The displayed parameters depend on the active item.

At Use this spin box to specify the time of the switching event.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

Switches to This display field shows the status to which the contact closure is switched.
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Properties of Chromatogram

The properties of the Chromatogram item include the following 
parameters:

Parameter Description

General

Rawfile Use this field to select a previously obtained raw data file corresponding to a similar 
chromatographic separation. Click the button next to the box and browse for the raw 
file.

NOTICE A red dot in the left column indicates that no raw file is selected. ▲

Filter

Scan filter Use this field to select a scan description that tells the data system how to filter the raw 
data.

Selection

Trace type Use this field to select a chromatogram plot type. The software updates the 
chromatogram immediately after a change. The following options are available:
• TIC

Plots the sum of all the ion intensities.
• Neutral Fragment

Plots the sum of the ion intensities of the ions that produce a neutral fragment with 
a mass specified in the Neutral Fragment spin box.

• Base Peak
Plots the ion intensity of the most intense ion in the chromatogram.

• Mass Range
Plots the sum of the ion intensities only for ions in the mass range or ranges 
specified in the Range(s) box.

Neutral Fragment This field is available when you have selected Neutral Fragment as trace type.

To enter the m/z value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

Mass Ranges Use this field to specify the range or ranges of mass-to-charge ratios (m/z) that the mass 
spectrometer can analyze. Use a dash (-) to separate the low and high masses of a range. 
Use a comma (,) to separate ranges.

This field is not available when you have selected TIC as trace type.
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❖ To show this view

Click the Chromatogram symbol in the External Hardware pane.

Properties of Full MS – SIM

The properties of a Full MS – SIM experiment include the following 
parameters:

Mass Tolerance

Tolerance For Neutral Fragment, Mass Range, and Base Peak plot types, use the spin box to 
specify the value of the mass tolerance. Enter a value in the range from 0 to 2000 and 
select the appropriate option in the Units field.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

Unit Use this field to select the units that are used in processing the raw file. Select either the 
mmu (millimass units) option or the ppm (parts per million) option.

Parameter Description

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (Minimum) and the end time 
(Maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range for the start time is from 0 to (end time minus 0.01) minutes. 
The valid range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can set the CID collision energy to any value from 0 
to 100 eV. A value of 0 eV means that the collision energy is switched off.

Full MS – SIM

Use the parameters in this group to specify the properties of the master scan(s).

Microscansa Use this spin box to select the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.
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❖ To show this view

Click the Full MS symbol in the Graph pane.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Number of scan rangesa Use this spin box to enter the number of segments in a segmented master scan. 
The segments can be defined independently from each other. They can be used to 
get a better S/N for specific areas and exclude matrix signals. The m/z ranges are 
acquired one after another and will result one scan for each range.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. The valid range is from 1 to 8 scans.

Scan range n (n=1–8) Use the spin boxes in this field to set values (in mass-to-charge ratio units) for 
Minimum, Maximum, Center, and Width for the current scan range. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value.
• Minimum

Select the minimum value for the scan range. You can enter any value from 
50.0 to 2500.0.

• Maximum
Select the maximum value for the scan range. You can enter any value from 
50.4 to 6000.0.

• Center
Select the center mass of the scan range. You can enter any value from 50.2 to 
4250.0.

• Width
Select the width of the scan range. You can enter any value from 0.4 to 
5600.0.

The actual possible values are interdependent. For Minimum, the highest value is 
Maximum – 0.4. For Maximum, the lowest value is Minimum + 0.4 and the 
highest value is Minimum × 15.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
a This parameter is not available when User Role is set to Standard.

Parameter Description
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Properties of AIF

The properties of an AIF experiment include the following parameters:

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range for the start time is from 0 to (end time minus 0.01) minutes. 
The valid range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can set the CID collision energy to any value from 0 
to 100 eV. A value of 0 eV means that the collision energy is switched off.

AIF

Microscansa Use this spin box to select the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.
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❖ To show this view

Click the AIF symbol in the Graph pane.

(N)CE / Stepped (N)CE Use this box to specify either the absolute collision energy (CE) in eV or the 
normalized collision energy (NCE). The latter is a dimensionless number that is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion 
of mass 500 and charge 1. The actual HCD energy is calculated on basis of mass 
and charge of either the selected precursor ion (Data Dependent MS2 or AIF 
scans) or the center mass of an isolation window (targeted MS2 or AIF scans). 

Specify whether absolute collision energy (CE) or normalized collision energy 
(NCE) is used. In the box, the software adds the prefix “ce:” or “nce:” to collision 
energy values (for example, ce:35) to indicate the selected energy type.

If more than one value is entered, the mass spectrometer will perform a stepwise 
fragmentation on the precursor ion. All fragments created in the steps are 
collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the „Region and Language“ 
settings). Or, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change a value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value. You can 
enter any value from 10 to 200.

Scan range Use the spin boxes in this field to set values (in mass-to-charge ratio units) for 
Minimum, Maximum, Center, and Width for the current scan range. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value.
• Minimum

Select the minimum value for the scan range. You can enter any value from 
50.0 to 2500.0.

• Maximum
Select the maximum value for the scan range. You can enter any value from 
50.4 to 6000.0.

• Center
Select the center mass of the scan range. You can enter any value from 50.2 to 
4250.0.

• Width
Select the width of the scan range. You can enter any value from 0.4 to 
5600.0.

The actual possible values are interdependent. For Minimum, the highest value is 
Maximum – 0.4. For Maximum, the lowest value is Minimum + 0.4 and the 
highest value is Minimum × 15.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
a This parameter is not available when User Role is set to Standard.

Parameter Description
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Properties of Full MS / AIF

The properties of a Full MS / AIF experiment include the following 
parameters:

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range for the start time is from 0 to (end time minus 0.01) minutes. 
The valid range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can set the CID collision energy to any value from 0 
to 100 eV. A value of 0 eV means that the collision energy is switched off.

Full MS

Use the parameters in this group to specify the properties of the master scan(s).

Microscansa Use this spin box to select the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.
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Scan range Use the spin boxes in this field to set values (in mass-to-charge ratio units) for 
Minimum, Maximum, Center, and Width for the current scan range. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value.
• Minimum

Select the minimum value for the scan range. You can enter any value from 
50.0 to 2500.0. 

• Maximum
Select the maximum value for the scan range. You can enter any value from 
50.4 to 6000.0.

• Center
Select the center mass of the scan range. You can enter any value from 50.2 to 
4250.0.

• Width
Select the width of the scan range. You can enter any value from 0.4 to 
5600.0. 

The actual possible values are interdependent. For Minimum, the highest value is 
Maximum – 0.4. For Maximum, the lowest value is Minimum + 0.4 and the 
highest value is Minimum × 15.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
AIF

Microscansa Use this spin box to select the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Parameter Description
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❖ To show this view

Click the Full MS / AIF symbol in the Graph pane.

(N)CE / Stepped (N)CE Use this box to specify either the absolute collision energy (CE) in eV or the 
normalized collision energy (NCE). The latter is a dimensionless number that is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion 
of mass 500 and charge 1. The actual HCD energy is calculated on basis of mass 
and charge of either the selected precursor ion (Data Dependent MS2 or AIF 
scans) or the center mass of an isolation window (targeted MS2 or AIF scans). 

Specify whether absolute collision energy (CE) or normalized collision energy 
(NCE) is used. In the box, the software adds the prefix “ce:” or “nce:” to collision 
energy values (for example, ce:35) to indicate the selected energy type.

If more than one value is entered, the mass spectrometer will perform a stepwise 
fragmentation on the precursor ion. All fragments created in the steps are 
collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the „Region and Language“ 
settings). Or, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change a value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value. You can 
enter any value from 10 to 200.

Scan range Use the spin boxes in this field to set values (in mass-to-charge ratio units) for 
Minimum, Maximum, Center, and Width for the current scan range. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value.
• Minimum

Select the minimum value for the scan range. You can enter any value from 
50.0 to 2500.0.

• Maximum
Select the maximum value for the scan range. You can enter any value from 
50.4 to 6000.0.

• Center
Select the center mass of the scan range. You can enter any value from 50.2 to 
4250.0.

• Width
Select the width of the scan range. You can enter any value from 0.4 to 
5600.0.

The actual possible values are interdependent. For Minimum, the highest value is 
Maximum – 0.4; it cannot exceed the Minimum value for the Full MS scan 
range. For Maximum, the lowest value is Minimum + 0.4 and the highest value is 
Minimum × 15.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
a This parameter is not available when User Role is set to Standard.

Parameter Description
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Properties of Full MS / dd-MS2 (TopN)

The properties of a Full MS / dd-MS2 experiment include the following 
parameters:

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range for the start time is from 0 to (end time minus 0.01) minutes. 
The valid range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can set the CID collision energy to any value from 0 
to 100 eV. A value of 0 eV means that the collision energy is switched off.

Default charge state Use this box to specify the default charge state for Data Dependent scans.

The mass spectrometer uses the charge state to determine the highest 
mass-to-charge ratio and HCD energy for the Data Dependent MSn scan. If the 
mass spectrometer cannot determine the charge state from the preceding scan, it 
uses the default charge state that you specify here. The valid range for the default 
charge state is 1 through 25. The default charge state is 2.

For typical applications, a charge state of +2 is suitable for tryptic digests in which 
the peptide has a charge state of +2. If you are running a different experiment, you 
might want to change the default to a more appropriate value.

Inclusion Use this field to enable the inclusion masses list that is attached to the active 
instrument method. Available options are on (inclusion list enabled) and – 
(inclusion list disabled). Default setting is –.

Exclusion Use this field to enable the exclusion masses list that is attached to the active 
instrument method. Available options are on (exclusion list enabled) and – 
(exclusion list disabled). Default setting is –.

Tags Use this field to enable the tag masses list for the active instrument method. 
Available options are on (list enabled) and – (list disabled). Default setting is –.
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Full MS

Microscansa Use this spin box to enter the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Number of scan rangesa Use this spin box to enter the number of segmented master scans. Segmented 
master scans can be defined independently from each other. They can be used to 
get a better S/N for specific areas and exclude matrix signals. The scan ranges are 
acquired one after another and will result one scan for each range.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. The valid range is from 1 to 8 scan ranges.

Scan range n (n=1–8) Use the spin boxes in this field to enter values (in mass-to-charge ratio units) for 
Minimum, Maximum, Center, and Width for the current scan range. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value.
• Minimum

Select the minimum value for the scan range. You can enter any value from 
50.0 to 2500.0.

• Maximum
Select the maximum value for the scan range. You can enter any value from 
50.4 to 6000.0.

• Center
Select the center mass of the scan range. You can enter any value from 50.2 to 
4250.0.

• Width
Select the width of the scan range. You can enter any value from 0.4 to 
5600.0.

The actual possible values are interdependent. For Minimum, the highest value is 
Maximum – 0.4. For Maximum, the lowest value is Minimum + 0.4 and the 
highest value is Minimum × 15.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.

Parameter Description
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dd-MS2 / dd-SIM

Microscansa Use this spin box to enter the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Loop count Use this spin box to enter the number of repetitions of the corresponding scan 
event before continuing with the next scan event or experiment cycle.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no repetition) to 100 repetitions.

MSX counta Use this spin box to enter the maximum number of precursors to be multiplexed 
in an scan event. In spectra multiplexing, multiple preselected precursors are 
collected in the C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no spectral multiplexing) to 10 fillings.

TopN This field displays the product of the selected values for Loop count and 
MSX count as maximum number of the most abundant precursors that will be 
selected.

Isolation window Use this list box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass 
and ranges one-half of the isolation width to either side of the parent mass. You 
can set the isolation window to any value from m/z 0.4 to 15 times the first mass 
of the Data Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass 
peak or in neighboring isotopic peaks are isolated. Too high a value causes 
interference from neighboring peaks.

Parameter Description
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Isolation offseta Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to 
any value from m/z -50 to +50. Default is m/z 0.

Fixed first massa Use this box to specify whether to use a first mass of the Data Dependent scan. 
After an automated determination of the detection mass range, the first mass will 
be set to the defined fixed first mass. Because only masses up to 15 times the first 
mass can be trapped in the C-Trap, loss of ions in the upper detection range may 
occur. 

You can set Fixed first mass either to – (dynamic first mass) or to any m/z value 
between 50 and 2000. To change the value, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. Default is –.

(N)CE / Stepped (N)CE Use this box to specify either the absolute collision energy (CE) in eV or the 
normalized collision energy (NCE). The latter is a dimensionless number that is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion 
of mass 500 and charge 1. The actual HCD energy is calculated on basis of mass 
and charge of either the selected precursor ion (Data Dependent MS2 or AIF 
scans) or the center mass of an isolation window (targeted MS2 or AIF scans). 

Specify whether absolute collision energy (CE) or normalized collision energy 
(NCE) is used. In the box, the software adds the prefix “ce:” or “nce:” to collision 
energy values (for example, ce:35) to indicate the selected energy type. If more 
than one value is entered, the mass spectrometer will perform a stepwise 
fragmentation on the precursor ion. All fragments created in the steps are 
collected and sent to the Orbitrap analyzer for one scan detection.
Enter up to three values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the „Region and Language“ 
settings). Or, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change a value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value. You can 
enter any value from 10 to 200.

Enter – for Data Dependent SIM scans.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.

Parameter Description
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dd Settings

Use the parameters in this group to specify criteria for selecting one or more ions of interest on which to 
perform subsequent scans.

Minimum AGC target Use this box to specify a minimum value for the AGC target. If the mass peak of 
interest reaches this intensity within the Maximum IT, the mass spectrometer 
initiates a Data Dependent scan. 

Enter the value either as integer or in scientific notation with two decimal places 
(for example, 3.80e4) in the spin box text field. The valid range is from 0 to the 
value for the AGC target of the Data Dependent scan event.

Intensity threshold This field displays the minimum intensity that a mass peak requires to initiate a 
Data Dependent scan.

Apex trigger To obtain the highest quality data in the shortest period of time, it is best to defer 
data acquisition until near the apex of a chromatographic peak. Using the 
chromatographic peak apex detection provides numerous benefits for Data 
Dependent LC/MS/MS, including:
• Improved MS/MS quality and signal levels
• Shorter ion injection times
• Reduced MS/MS acquisition of chemical background
• Less dependence on static or dynamic exclusion lists
• Reduced retriggering of scans on tailing chromatographic peaks

Use this box to enter start (Minimum) and end (Maximum) of a retention time 
window in seconds relative to the occurrence of a precursor. If the mass 
spectrometer finds an apex within the window, it triggers a Data Dependent 
acquisition for the corresponding m/z or range of m/z. The mass spectrometer also 
triggers a Data Dependent scan when the end of the time window is reached 
without detecting an apex. The apex trigger always depends on other selection 
criteria (for example, intensity threshold).
• Minimum

Enter the minimum value for the time window (in seconds). You can enter 
any value from – (0) to 360. The default value is –.

• Maximum
Enter the maximum value for the time window (in seconds). You can enter 
any value from – (0) to 360 as long as it equals or exceeds the Minimum 
value. The default value is –.

Charge exclusion Use the check boxes in this field to reject individual charge states or undetermined 
charge states as precursors for Data Dependent MS/MS scans.

The following options are available:
• – (charge exclusion disabled),
• unassigned (charge state not determined)
• 1–8 (at least one charge state is selected),
• >8

Parameter Description
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Multiple charge statesa Use this field to decrease the number of redundant MS2 spectra by limiting them 
to the most abundant charge state within a charge state distribution. All other 
criteria for dd-MS2 properties must be met.

The following options are available:
• all (All charge states of a charge envelope are triggered.)
• one charge state only (Only the most intense charge state of a charge envelope 

is triggered.)

Peptide match Use this field to enable the mass spectrometer to select small molecules with 
peptide-like isotopic distributions for Data Dependent scanning. The mass 
spectrometer recognizes the monoisotopic mass of an isotopic distribution by 
comparing isotopic intensity ratios to typical peptide-like distributions.

The following options are available:
• on (peptide match enabled)
• – (peptide match disabled)
• preferred (peaks that are determined to belong to peptides are preferred and 

will be selected prior to those that are not, but still meeting all of the other 
Data Dependent filter criteria, for example, charge state and intensity)

Default setting is preferred.

Exclude isotopes Use this field to check whether the most intensive isotope of a cluster has been 
triggered in a Data Dependent scan event. All isotopes of that cluster will be then 
excluded.

Available options are on (isotopes exclusion enabled) and – (isotopes exclusion 
disabled). Default setting is on. Isotopes exclusion is disabled for inclusion list 
entries.

Parameter Description
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❖ To show this view

Click the Full MS / dd-MS2 symbol in the Graph pane.

Properties of Targeted-SIM

The properties of a Targeted-SIM experiment include the following 
parameters:

Dynamic exclusion Use this box to enter a time (in seconds) to prevent an ion from triggering a 
subsequent Data Dependent scan after it has already triggered a Data Dependent 
scan. 

The following input is possible:
• – (no dynamic exclusion)
• 0.1 to 50000
• auto [Dynamic exclusion = 2.5 × Chrom. peak width (FWHM)]

Dynamic exclusion is valuable if the mass spectrometer has obtained enough data 
on an ion or if the base peak corresponds to a contaminant or an ion of non 
interest. If you enable dynamic exclusion, and if the mass spectrometer performs a 
Data Dependent scan on an ion, that ion is placed on the exclusion list (a 
temporary reject mass list) for a user-specified period of time. Then, when the 
mass spectrometer performs another Data Dependent scan on another ion, that 
ion is also placed on the exclusion list, and so on.

if idle Use this field to select the behavior of the mass spectrometer when it has finished 
the Data Dependent scans that were triggered by a mass that meets the established 
criteria for Data Dependent actions. Available options are do not pick others and 
pick other. Default setting is do not pick others.

This parameter is available only when at least one of the parameters Inclusion or 
Tags is set to on.

a This parameter is not available when User Role is set to Standard.

Parameter Description

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into the 
field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. The 
valid range for the start time is from 0 to (end time minus 0.01) minutes. The valid 
range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired positions 
on the time line in the Scan Groups pane.
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Polarity Use this list box to toggle between positive ion and negative ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the value, 
click the arrows in the spin box to increment [up arrow] or decrement [down arrow] 
the value. You can set the CID collision energy to any value from 0 to 100 eV. A value 
of 0 eV means that the collision energy is switched off.

Inclusion Because this experiment requires inclusion masses, this field is always set to on 
(inclusion list enabled).

SIM

Microscansa Use this spin box to enter the number of averaged transients for one scan event. To 
change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. The 
valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. The 
mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time 
increases with increasing resolution and detect time. Available options are 7500, 
15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

MSX counta Use this spin box to enter the maximum number of precursors to be multiplexed in an 
scan event. In spectra multiplexing, multiple preselected precursors are collected in the 
C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. The 
valid range is from 1 (no spectral multiplexing) to 10 fillings.

Isolation window Use this list box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass and 
ranges one-half of the isolation width to either side of the parent mass. You can set the 
isolation window to any value from m/z 0.4 to 15 times the first mass of the Data 
Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass peak or 
in neighboring isotopic peaks are isolated. Too high a value causes interference from 
neighboring peaks.

Parameter Description
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❖ To show this view

Click the Targeted-SIM symbol in the Graph pane.

Properties of PRM

The properties of a PRM experiment include the following parameters:

Isolation offseta Use this spin box to define an absolute offset by which the isolation window is shifted. 
The resulting window is non-symmetric with regard to the precursor m/z. Thus, more 
isotopes of a cluster might be covered, without the need of expanding the isolation 
window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up arrow] 
or decrement [down arrow] the value. You can set the isolation offset to any value from 
m/z -50 to +50. Default is m/z 0.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
a This parameter is not available when User Role is set to Standard.

Parameter Description

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range for the start time is from 0 to (end time minus 0.01) minutes. 
The valid range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can set the CID collision energy to any value from 0 
to 100 eV. A value of 0 eV means that the collision energy is switched off.
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Dynamic RTa Use this list box to enable the retention time correction for time windows of 
targeted compounds according to an internal standard (Pierce™ Peptide Retention 
Time Calibration Mixture, refer to www.fishersci.com, catalog numbers PI88320 
and PI88321). If Dynamic RT is enabled, the time windows (start and end) that 
are entered in the inclusion list are corrected in real-time by a correction factor. 
This factor is calculated by comparing the expected RT to the actual RT of the 
internal standard during run-time. All 15 retention time standards will be 
recognized by the software. The standards that shall be used for correction must 
be entered in the inclusion list in addition to the target analytes. The center of the 
set retention time window for the standards reflects the expected RT.

If the instrument method contains several PRM experiments, only those 
experiments use Dynamic RT where this parameter is set to on. The same 
correction factors are used for all PRM experiments in the instrument method (if 
Dynamic RT is activated).

Available options are on (retention time correction enabled) and off (retention 
time correction disabled).

Default charge state Use this box to specify the default charge state for Data Dependent scans.

The mass spectrometer uses the charge state to determine the highest 
mass-to-charge ratio and HCD energy for the Data Dependent MSn scan. If the 
mass spectrometer cannot determine the charge state from the preceding scan, it 
uses the default charge state that you specify here. The valid range for the default 
charge state is 1 through 25. The default charge state is 2.

For typical applications, a charge state of +2 is suitable for tryptic digests in which 
the peptide has a charge state of +2. If you are running a different experiment, you 
might want to change the default to a more appropriate value.

Inclusion Because this experiment requires inclusion masses, this field is always set to on 
(inclusion list enabled).

MS2

Microscansa Use this spin box to enter the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Parameter Description

http://www.fishersci.com
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Loop count Use this spin box to enter the number of repetitions of the corresponding scan 
event before continuing with the next scan event or experiment cycle.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no repetition) to 100 repetitions.

MSX counta Use this spin box to enter the maximum number of precursors to be multiplexed 
in an scan event. In spectra multiplexing, multiple preselected precursors are 
collected in the C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no spectral multiplexing) to 10 fillings.

MSX isochronous ITsa When this parameter is set to on (enabled), all isolated windows are injected into 
the HCD cell with the same injection time for multiplexing scans. Thermo Fisher 
Scientific recommends that you set this parameter to – (disabled) when you use 
retention time correction (Dynamic RT). 

Isolation window Use this list box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass 
and ranges one-half of the isolation width to either side of the parent mass. You 
can set the isolation window to any value from m/z 0.4 to 15 times the first mass 
of the Data Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass 
peak or in neighboring isotopic peaks are isolated. Too high a value causes 
interference from neighboring peaks.

Isolation offseta Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to 
any value from m/z -50 to +50. Default is m/z 0.

Fixed first massa Use this box to specify whether to use a first mass of the Data Dependent scan. 
After an automated determination of the detection mass range, the first mass will 
be set to the defined fixed first mass. Because only masses up to 15 times the first 
mass can be trapped in the C-Trap, loss of ions in the upper detection range may 
occur. 

You can set Fixed first mass either to – (dynamic first mass) or to any m/z value 
between 50 and 2000. To change the value, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. Default is –.

Parameter Description
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❖ To show this view

Click the PRM symbol in the Graph pane.

Properties of Targeted-SIM / dd-MS2

The properties of a Targeted-SIM / dd-MS2 experiment include the 
following parameters:

(N)CE / Stepped (N)CE Use this box to specify either the absolute collision energy (CE) in eV or the 
normalized collision energy (NCE). The latter is a dimensionless number that is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion 
of mass 500 and charge 1. The actual HCD energy is calculated on basis of mass 
and charge of either the selected precursor ion (Data Dependent MS2 or AIF 
scans) or the center mass of an isolation window (targeted MS2 or AIF scans). 

Specify whether absolute collision energy (CE) or normalized collision energy 
(NCE) is used. In the box, the software adds the prefix “ce:” or “nce:” to collision 
energy values (for example, ce:35) to indicate the selected energy type.

If more than one value is entered, the mass spectrometer will perform a stepwise 
fragmentation on the precursor ion. All fragments created in the steps are 
collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the „Region and Language“ 
settings). Or, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change a value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value. You can 
enter any value from 10 to 200.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
a This parameter is not available when User Role is set to Standard.

Parameter Description

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range for the start time is from 0 to (end time minus 0.01) minutes. 
The valid range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.
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Polarity Use this list box to toggle between positive ion and negative ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can set the CID collision energy to any value from 0 
to 100 eV. A value of 0 eV means that the collision energy is switched off.

Default charge state Use this box to specify the default charge state for Data Dependent scans.

The mass spectrometer uses the charge state to determine the highest 
mass-to-charge ratio and HCD energy for the Data Dependent MSn scan. If the 
mass spectrometer cannot determine the charge state from the preceding scan, it 
uses the default charge state that you specify here. The valid range for the default 
charge state is 1 through 25. The default charge state is 2.

For typical applications, a charge state of +2 is suitable for tryptic digests in which 
the peptide has a charge state of +2. If you are running a different experiment, you 
might want to change the default to a more appropriate value.

Inclusion Because this experiment requires inclusion masses, this field is always set to on 
(inclusion list enabled).

SIM

Microscansa Use this spin box to enter the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Loop count Use this spin box to enter the number of repetitions of the corresponding scan 
event before continuing with the next scan event or experiment cycle.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no repetition) to 100 repetitions.

Parameter Description
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MSX counta Use this spin box to enter the maximum number of precursors to be multiplexed 
in an scan event. In spectra multiplexing, multiple preselected precursors are 
collected in the C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no spectral multiplexing) to 10 fillings.

Isolation window Use this spin box to enter the isolation width (in mass-to-charge ratio units) for 
the parent ion of interest. The mass range for the peak is centered at the parent 
mass and ranges one-half of the isolation width to either side of the parent mass. 
You can set the isolation window to any value from m/z 0.4 to 15 times the first 
mass of the Data Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass 
peak or in neighboring isotopic peaks are isolated. Too high a value causes 
interference from neighboring peaks.

Isolation offseta Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to 
any value from m/z -50 to +50. Default is m/z 0.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
dd-MS2

Microscansa Use this spin box to enter the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Parameter Description
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Loop count Use this spin box to enter the number of repetitions of the corresponding scan 
event before continuing with the next scan event or experiment cycle.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no repetition) to 100 repetitions.

MSX counta Use this spin box to enter the maximum number of precursors to be multiplexed 
in an scan event. In spectra multiplexing, multiple preselected precursors are 
collected in the C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no spectral multiplexing) to 10 fillings.

TopN This field displays the product of the selected values for Loop count and 
MSX count as maximum number of the most abundant precursors that will be 
selected.

Isolation window Use this spin box to enter the isolation width (in mass-to-charge ratio units) for 
the parent ion of interest. The mass range for the peak is centered at the parent 
mass and ranges one-half of the isolation width to either side of the parent mass. 
You can set the isolation window to any value from m/z 0.4 to 15 times the first 
mass of the Data Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass 
peak or in neighboring isotopic peaks are isolated. Too high a value causes 
interference from neighboring peaks.

Isolation offseta Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to 
any value from m/z -50 to +50. Default is m/z 0.

Fixed first mass Use this box to specify whether to use a first mass of the Data Dependent scan. 
After an automated determination of the detection mass range, the first mass will 
be set to the defined fixed first mass. Because only masses up to 15 times the first 
mass can be trapped in the C-Trap, loss of ions in the upper detection range may 
occur. 

You can set Fixed first mass either to – (dynamic first mass) or to any m/z value 
between 50 and 2000. To change the value, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. Default is –.

Parameter Description
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(N)CE / Stepped (N)CE Use this box to specify either the absolute collision energy (CE) in eV or the 
normalized collision energy (NCE). The latter is a dimensionless number that is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion 
of mass 500 and charge 1. The actual HCD energy is calculated on basis of mass 
and charge of either the selected precursor ion (Data Dependent MS2 or AIF 
scans) or the center mass of an isolation window (targeted MS2 or AIF scans). 

Specify whether absolute collision energy (CE) or normalized collision energy 
(NCE) is used. In the box, the software adds the prefix “ce:” or “nce:” to collision 
energy values (for example, ce:35) to indicate the selected energy type.

If more than one value is entered, the mass spectrometer will perform a stepwise 
fragmentation on the precursor ion. All fragments created in the steps are 
collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the „Region and Language“ 
settings). Or, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change a value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value. You can 
enter any value from 10 to 200.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
dd Settings

Use the parameters in this group to specify criteria for selecting one or more ions of interest on which to 
perform subsequent scans.

Minimum AGC target Use this box to specify a minimum value for the AGC target. If the mass peak of 
interest reaches this intensity within the Maximum IT, the mass spectrometer 
initiates a Data Dependent scan. 

Enter the value either as integer or in scientific notation with two decimal places 
(for example, 3.80e4) in the spin box text field. The valid range is from 0 to the 
value for the AGC target of the Data Dependent scan event.

Intensity threshold This field displays the minimum intensity that a mass peak requires to initiate a 
Data Dependent scan.

Parameter Description
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Apex trigger To obtain the highest quality data in the shortest period of time, it is best to defer 
data acquisition until near the apex of a chromatographic peak. Using the 
chromatographic peak apex detection provides numerous benefits for Data 
Dependent LC/MS/MS, including:
• Improved MS/MS quality and signal levels
• Shorter ion injection times
• Reduced MS/MS acquisition of chemical background
• Less dependence on static or dynamic exclusion lists
• Reduced retriggering of scans on tailing chromatographic peaks

Use this box to enter start (Minimum) and end (Maximum) of a retention time 
window in seconds relative to the occurrence of a precursor. If the mass 
spectrometer finds an apex within the window, it triggers a Data Dependent 
acquisition for the corresponding m/z or range of m/z. The mass spectrometer also 
triggers a Data Dependent scan when the end of the time window is reached 
without detecting an apex. The apex trigger always depends on other selection 
criteria (for example, intensity threshold).
• Minimum

Enter the minimum value for the time window (in seconds). You can enter 
any value from – (0) to 360. The default value is –.

• Maximum
Enter the maximum value for the time window (in seconds). You can enter 
any value from – (0) to 360 as long as it equals or exceeds the Minimum 
value. The default value is –.

Charge exclusion Use the check boxes in this field to reject individual charge states or undetermined 
charge states as precursors for Data Dependent MS/MS scans.

The following options are available:
• – (charge exclusion disabled),
• unassigned (charge state not determined),
• 1–8 (at least one charge state is selected),
• >8

Multiple charge statesa Use this field to decrease the number of redundant MS2 spectra by limiting them 
to the most abundant charge state within a charge state distribution. All other 
criteria for dd-MS2 properties must be met.

The following options are available:
• all (All charge states of a charge envelope are triggered.)
• one charge state only (Only the most intense charge state of a charge envelope 

is triggered.)

Parameter Description
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❖ To show this view

Click the Targeted-SIM / dd-MS2 symbol in the Graph pane.

Peptide match Use this field to enable the mass spectrometer to select small molecules with 
peptide-like isotopic distributions for Data Dependent scanning. The mass 
spectrometer recognizes the monoisotopic mass of an isotopic distribution by 
comparing isotopic intensity ratios to typical peptide-like distributions.

The following options are available:
• on (peptide match enabled)
• – (peptide match disabled)
• preferred (peaks that are determined to belong to peptides are preferred and 

will be selected prior to those that are not, but still meeting all of the other 
Data Dependent filter criteria, for example, charge state and intensity)

Default setting is preferred.

Exclude isotopes Use this field to check whether the most intensive isotope of a cluster has been 
triggered in a Data Dependent scan event. All isotopes of that cluster will be then 
excluded.

Available options are on (isotopes exclusion enabled) and – (isotopes exclusion 
disabled). Default setting is on. Isotopes exclusion is disabled for inclusion list 
entries.

Dynamic exclusion Use this box to enter a time (in seconds) to prevent an ion from triggering a 
subsequent Data Dependent scan after it has already triggered a Data Dependent 
scan. 

The following input is possible:
• – (no dynamic exclusion)
• 0.1 to 50000
• auto [Dynamic exclusion = 2.5 × Chrom. peak width (FWHM)]

Dynamic exclusion is valuable if the mass spectrometer has obtained enough data 
on an ion or if the base peak corresponds to a contaminant or an ion of non 
interest. If you enable dynamic exclusion, and if the mass spectrometer performs a 
Data Dependent scan on an ion, that ion is placed on the exclusion list (a 
temporary reject mass list) for a user-specified period of time. Then, when the 
mass spectrometer performs another Data Dependent scan on another ion, that 
ion is also placed on the exclusion list, and so on.

a This parameter is not available when User Role is set to Standard.

Parameter Description
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Properties of Full MS / AIF / NL dd-MS2

The properties of a Full MS / AIF / NL dd-MS2 experiment include the 
following parameters:

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range for the start time is from 0 to (end time minus 0.01) minutes. 
The valid range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can set the CID collision energy to any value from 0 
to 100 eV. A value of 0 eV means that the collision energy is switched off.

Default charge state Use this box to specify the default charge state for Data Dependent scans.

The mass spectrometer uses the charge state to determine the highest 
mass-to-charge ratio and HCD energy for the Data Dependent MSn scan. If the 
mass spectrometer cannot determine the charge state from the preceding scan, it 
uses the default charge state that you specify here. The valid range for the default 
charge state is 1 through 25. The default charge state is 2.

For typical applications, a charge state of +2 is suitable for tryptic digests in which 
the peptide has a charge state of +2. If you are running a different experiment, you 
might want to change the default to a more appropriate value.

Neutral loss This field is a reminder that the active experiment includes a neutral loss list.

Exclusion Use this field to enable the exclusion masses list that is attached to the active 
instrument method. Available options are on (exclusion list enabled) and – 
(exclusion list disabled). Default setting is –.

Full MS

Microscansa Use this spin box to enter the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.
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Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Scan range Use the spin boxes in this field to enter values (in mass-to-charge ratio units) for 
Minimum, Maximum, Center, and Width for the current scan range. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value.
• Minimum

Select the minimum value for the scan range. You can enter any value from 
50.0 to 2500.0.

• Maximum
Select the maximum value for the scan range. You can enter any value from 
50.4 to 6000.0.

• Center
Select the center mass of the scan range. You can enter any value from 50.2 to 
4250.0.

• Width
Select the width of the scan range. You can enter any value from 0.4 to 
5600.0.

The actual possible values are interdependent. For Minimum, the highest value is 
Maximum – 0.4. For Maximum, the lowest value is Minimum + 0.4 and the 
highest value is Minimum × 15.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
AIF

Microscansa Use this spin box to enter the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Parameter Description
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Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

(N)CE / Stepped (N)CE Use this box to specify either the absolute collision energy (CE) in eV or the 
normalized collision energy (NCE). The latter is a dimensionless number that is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion 
of mass 500 and charge 1. The actual HCD energy is calculated on basis of mass 
and charge of either the selected precursor ion (Data Dependent MS2 or AIF 
scans) or the center mass of an isolation window (targeted MS2 or AIF scans). 

Specify whether absolute collision energy (CE) or normalized collision energy 
(NCE) is used. In the box, the software adds the prefix “ce:” or “nce:” to collision 
energy values (for example, ce:35) to indicate the selected energy type.

If more than one value is entered, the mass spectrometer will perform a stepwise 
fragmentation on the precursor ion. All fragments created in the steps are 
collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the „Region and Language“ 
settings). Or, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change a value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value. You can 
enter any value from 10 to 200.

Scan range Use the spin boxes in this field to enter values (in mass-to-charge ratio units) for 
Minimum, Maximum, Center, and Width for the current scan range. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value.
• Minimum

Select the minimum value for the scan range. You can enter any value from 
50.0 to 2500.0.

• Maximum
Select the maximum value for the scan range. You can enter any value from 
50.4 to 6000.0.

• Center
Select the center mass of the scan range. You can enter any value from 50.2 to 
4250.0.

• Width
Select the width of the scan range. You can enter any value from 0.4 to 
5600.0.

The actual possible values are interdependent. For Minimum, the highest value is 
Maximum – 0.4; it cannot exceed the Minimum value for the Full MS scan 
range. For Maximum, the lowest value is Minimum + 0.4 and the highest value is 
Minimum × 15.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.

Parameter Description
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MS2

Microscansa Use this spin box to enter the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Loop count Use this spin box to enter the number of repetitions of the corresponding scan 
event before continuing with the next scan event or experiment cycle.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no repetition) to 100 repetitions.

MSX counta Use this spin box to enter the maximum number of precursors to be multiplexed 
in an scan event. In spectra multiplexing, multiple preselected precursors are 
collected in the C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 (no spectral multiplexing) to 10 fillings.

TopN This field displays the product of the selected values for Loop count and 
MSX count as maximum number of the most abundant precursors that will be 
selected.

Isolation window Use this list box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass 
and ranges one-half of the isolation width to either side of the parent mass. You 
can set the isolation window to any value from m/z 0.4 to 15 times the first mass 
of the Data Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass 
peak or in neighboring isotopic peaks are isolated. Too high a value causes 
interference from neighboring peaks.

Parameter Description
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Isolation offseta Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to 
any value from m/z -50 to +50. Default is m/z 0.

Fixed first mass Use this box to specify whether to use a first mass of the Data Dependent scan. 
After an automated determination of the detection mass range, the first mass will 
be set to the defined fixed first mass. Because only masses up to 15 times the first 
mass can be trapped in the C-Trap, loss of ions in the upper detection range may 
occur. 

You can set Fixed first mass either to – (dynamic first mass) or to any m/z value 
between 50 and 2000. To change the value, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. Default is –.

(N)CE / Stepped (N)CE Use this box to specify either the absolute collision energy (CE) in eV or the 
normalized collision energy (NCE). The latter is a dimensionless number that is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion 
of mass 500 and charge 1. The actual HCD energy is calculated on basis of mass 
and charge of either the selected precursor ion (Data Dependent MS2 or AIF 
scans) or the center mass of an isolation window (targeted MS2 or AIF scans). 

Specify whether absolute collision energy (CE) or normalized collision energy 
(NCE) is used. In the box, the software adds the prefix “ce:” or “nce:” to collision 
energy values (for example, ce:35) to indicate the selected energy type.

If more than one value is entered, the mass spectrometer will perform a stepwise 
fragmentation on the precursor ion. All fragments created in the steps are 
collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the „Region and Language“ 
settings). Or, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change a value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value. You can 
enter any value from 10 to 200.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.

Parameter Description
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dd Settings

Use the parameters in this group to specify criteria for selecting one or more ions of interest on which to 
perform subsequent scans.

Minimum AGC target Use this box to specify a minimum value for the AGC target. If the mass peak of 
interest reaches this intensity within the Maximum IT, the mass spectrometer 
initiates a Data Dependent scan. 

Enter the value either as integer or in scientific notation with two decimal places 
(for example, 3.80e4) in the spin box text field. The valid range is from 0 to the 
value for the AGC target of the Data Dependent scan event.

Intensity threshold This field displays the minimum intensity that a mass peak requires to initiate a 
Data Dependent scan.

Apex trigger To obtain the highest quality data in the shortest period of time, it is best to defer 
data acquisition until near the apex of a chromatographic peak. Using the 
chromatographic peak apex detection provides numerous benefits for Data 
Dependent LC/MS/MS, including:
• Improved MS/MS quality and signal levels
• Shorter ion injection times
• Reduced MS/MS acquisition of chemical background
• Less dependence on static or dynamic exclusion lists
• Reduced retriggering of scans on tailing chromatographic peaks

Use this box to enter start (Minimum) and end (Maximum) of a retention time 
window in seconds relative to the occurrence of a precursor. If the mass 
spectrometer finds an apex within the window, it triggers a Data Dependent 
acquisition for the corresponding m/z or range of m/z. The mass spectrometer also 
triggers a Data Dependent scan when the end of the time window is reached 
without detecting an apex. The apex trigger always depends on other selection 
criteria (for example, intensity threshold).
• Minimum

Enter the minimum value for the time window (in seconds). You can enter 
any value from – (0) to 360. The default value is –.

• Maximum
Enter the maximum value for the time window (in seconds). You can enter 
any value from – (0) to 360 as long as it equals or exceeds the Minimum 
value. The default value is –.

Charge exclusion Use the check boxes in this field to reject individual charge states or undetermined 
charge states as precursors for Data Dependent MS/MS scans.

The following options are available:
• – (charge exclusion disabled),
• unassigned (charge state not determined)
• 1–8 (at least one charge state is selected),
• >8

Parameter Description
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❖ To show this view

Click the Full MS / AIF / NL dd-MS2 symbol in the Graph pane.

Peptide match Use this field to enable the mass spectrometer to select small molecules with 
peptide-like isotopic distributions for Data Dependent scanning. The mass 
spectrometer recognizes the monoisotopic mass of an isotopic distribution by 
comparing isotopic intensity ratios to typical peptide-like distributions.

The following options are available:
• on (peptide match enabled)
• – (peptide match disabled)
• preferred (peaks that are determined to belong to peptides are preferred and 

will be selected prior to those that are not, but still meeting all of the other 
Data Dependent filter criteria, for example, charge state and intensity)

Default setting is preferred.

Dynamic exclusion Use this box to enter a time (in seconds) to prevent an ion from triggering a 
subsequent Data Dependent scan after it has already triggered a Data Dependent 
scan. 

The following input is possible:
• – (no dynamic exclusion)
• 0.1 to 50000
• auto [Dynamic exclusion = 2.5 × Chrom. peak width (FWHM)]

Dynamic exclusion is valuable if the mass spectrometer has obtained enough data 
on an ion or if the base peak corresponds to a contaminant or an ion of non 
interest. If you enable dynamic exclusion, and if the mass spectrometer performs a 
Data Dependent scan on an ion, that ion is placed on the exclusion list (a 
temporary reject mass list) for a user-specified period of time. Then, when the 
mass spectrometer performs another Data Dependent scan on another ion, that 
ion is also placed on the exclusion list, and so on.

a This parameter is not available when User Role is set to Standard.

Parameter Description
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Properties of DIA

The properties of a DIA experiment include the following parameters:

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range for the start time is from 0 to (end time minus 0.01) minutes. 
The valid range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can set the CID collision energy to any value from 0 
to 100 eV. A value of 0 eV means that the collision energy is switched off.

Default charge state Use this box to specify the default charge state for Data Dependent scans.

The mass spectrometer uses the charge state to determine the highest 
mass-to-charge ratio and HCD energy for the Data Dependent MSn scan. If the 
mass spectrometer cannot determine the charge state from the preceding scan, it 
uses the default charge state that you specify here. The valid range for the default 
charge state is 1 through 25. The default charge state is 2.

For typical applications, a charge state of +2 is suitable for tryptic digests in which 
the peptide has a charge state of +2. If you are running a different experiment, you 
might want to change the default to a more appropriate value.

DIA

Microscansa Use this spin box to enter the number of averaged transients for one scan event. 
To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. 
The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 15000, 30000, 45000, 60000, 120000, or 240000.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.
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Maximum IT Use this list box to type or click a maximum allowed injection time (in 
milliseconds) to reach the AGC target value. You can enter either a number 
between 1 and 3000 or auto. If you enter auto, the mass spectrometer chooses a 
value that depends on the highest resolution of the active and the previous scan 
event.

Loop count Use this field to enter the number of repetitions of the corresponding scan event 
before continuing with the next scan event or experiment cycle. The valid range is 
from 1 to 100.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

MSX count Use this spin box to enter the maximum number of precursors to be multiplexed 
in an scan event. In spectra multiplexing, multiple preselected precursors are 
collected in the C-Trap for simultaneous detection in the Orbitrap analyzer.

The following options are available:
• 1 (no spectral multiplexing)

The Method Editor sets the detection window to the isolation window.
• 2–10

The Method Editor sets the detection window to the MSX scan range to show 
all of the multiplexed precursor mass ranges in one scan.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

MSX isochronous ITs When this parameter is set to on, all isolated windows are injected into the HCD 
cell with the same injection time for multiplexing scans. 

The following options are available:
• on (enabled)
• – (disabled)

Isolation window Use this list box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass 
and ranges one-half of the isolation width to either side of the parent mass. You 
can set the isolation window to any value from m/z 0.4 to 15 times the first mass 
of the Data Dependent scan.

Too low a value results in loss of sensitivity because not all of the ions in a mass 
peak or in neighboring isotopic peaks are isolated. Too high a value causes 
interference from neighboring peaks.

Parameter Description
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❖ To show this view

Click the DIA symbol in the Graph pane.

Isolation offseta Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to 
any value from m/z -50 to +50. Default is m/z 0.

Fixed first mass Use this box to specify whether to use a first mass of the Data Dependent scan. 
After an automated determination of the detection mass range, the first mass will 
be set to the defined fixed first mass. Because only masses up to 15 times the first 
mass can be trapped in the C-Trap, loss of ions in the upper detection range may 
occur. 

You can set Fixed first mass either to – (dynamic first mass) or to any m/z value 
between 50 and 2000. To change the value, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. Default is –.

(N)CE / Stepped (N)CE Use this box to specify either the absolute collision energy (CE) in eV or the 
normalized collision energy (NCE). The latter is a dimensionless number that is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion 
of mass 500 and charge 1. The actual HCD energy is calculated on basis of mass 
and charge of either the selected precursor ion (Data Dependent MS2 or AIF 
scans) or the center mass of an isolation window (targeted MS2 or AIF scans). 

Specify whether absolute collision energy (CE) or normalized collision energy 
(NCE) is used. In the box, the software adds the prefix “ce:” or “nce:” to collision 
energy values (for example, ce:35) to indicate the selected energy type.

If more than one value is entered, the mass spectrometer will perform a stepwise 
fragmentation on the precursor ion. All fragments created in the steps are 
collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the „Region and Language“ 
settings). Or, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change a value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value. You can 
enter any value from 10 to 200.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
a This parameter is not available when User Role is set to Standard.

Parameter Description
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Properties of HMR - Full MS

The properties of an HMR - Full MS experiment1 include the following 
parameters:

1. Available only for systems with a valid High Mass Range license.

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into the 
field to display the spin boxes for the start time (Minimum) and the end time 
(Maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. The 
valid range for the start time is from 0 to (end time minus 0.01) minutes. The valid 
range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired positions 
on the time line in the Scan Groups pane.

Polarity HMR experiments can be run only in positive ion polarity.

In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the value, click 
the arrows in the spin box to increment [up arrow] or decrement [down arrow] the 
value. You can set the CID collision energy to any value from 0 to 200 eV. This value 
range is fully applied for NSI sources. If another source is used, the maximum value 
will be reduced to 150 eV automatically. A value of 0 eV means that the collision 
energy is switched off.

Full MS

Use the parameters in this group to specify the properties of the master scan(s).

Microscansa Use this spin box to select the number of averaged transients for one scan event. To 
change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. The 
valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. The 
mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time 
increases with increasing resolution and detect time. Available options are 7500, 
17500, 35000, 45000, 70000, or 140000.

AGC targeta Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum ITa Use this list box to type or click a maximum allowed injection time (in milliseconds) to 
reach the AGC target value. You can enter either a number between 1 and 3000 or 
auto. If you enter auto, the mass spectrometer chooses a value that depends on the 
highest resolution of the active and the previous scan event.
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❖ To show this view

Click the HMR - Full MS symbol in the Graph pane.

Properties of HMR - AIF

The properties of an HMR - AIF experiment1 include the following 
parameters:

Scan range Use the spin boxes in this field to set values (in mass-to-charge ratio units) for 
Minimum, Maximum, Center, and Width for the current scan range. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement [down 
arrow] the value.
• Minimum

Select the minimum value for the scan range. You can enter any value from 350.0 
to 2500.0.

• Maximum
Select the maximum value for the scan range. You can enter any value from 400.0 
to 8000.0.

• Center
Select the center mass of the scan range. You can enter any value from 375.0 to 
5250.0.

• Width
Select the width of the scan range. You can enter any value from 50.0 to 7650.0.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
a This parameter is not available when User Role is set to Standard.

Parameter Description

1. Available only for systems with a valid High Mass Range license.

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. The 
valid range for the start time is from 0 to (end time minus 0.01) minutes. The valid 
range for the end time is from (start time plus 0.01) to 10000 minutes.

Or, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.

Polarity HMR experiments can be run only in positive ion polarity.
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In-source CIDa Use this spin box to enter the in-source CID collision energy. To change the value, 
click the arrows in the spin box to increment [up arrow] or decrement [down 
arrow] the value. You can set the CID collision energy to any value from 0 to 
200 eV. This value range is fully applied for NSI sources. If another source is used, 
the maximum value will be reduced to 150 eV automatically. A value of 0 eV 
means that the collision energy is switched off.

AIF

Microscansa Use this spin box to select the number of averaged transients for one scan event. To 
change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. The 
valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 7500, 17500, 35000, 45000, 70000, or 140000.

AGC targeta Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum ITa Use this list box to type or click a maximum allowed injection time (in 
milliseconds) to reach the AGC target value. You can enter either a number 
between 1 and 3000 or auto. If you enter auto, the mass spectrometer chooses a 
value that depends on the highest resolution of the active and the previous scan 
event.

CE / Stepped CE Use this box to specify the collision energy (CE) in eV. If more than one CE value 
is entered, the mass spectrometer will perform a stepwise fragmentation on the 
precursor ion. All fragments created in the steps are collected and sent to the 
Orbitrap analyzer for one scan detection.

Enter up to three CE values manually separated by blanks or the locally defined 
“list separator” (defined for Microsoft™ Windows™ via the „Region and Language“ 
settings).

Or, click the down arrow to display a dialog box and select the corresponding 
number of check boxes. To change a CE value, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. You can set CE to any 
value from 10 to 200. Default is 35.

Parameter Description
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❖ To show this view

Click the HMR - AIF symbol in the Graph pane.

Scan range Use the spin boxes in this field to set values (in mass-to-charge ratio units) for 
Minimum, Maximum, Center, and Width for the current scan range. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value.
• Minimum

Select the minimum value for the scan range. You can enter any value from 
350.0 to 2500.0.

• Maximum
Select the maximum value for the scan range. You can enter any value from 
400.0 to 8000.0.

• Center
Select the center mass of the scan range. You can enter any value from 375.0 to 
5250.0.

• Width
Select the width of the scan range. You can enter any value from 50.0 to 
7650.0.

Spectrum data typea Use this list box to toggle between Profile data format and Centroid data format.
a This parameter is not available when User Role is set to Standard.

Parameter Description
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Summary Page
The Summary page displays the parameters for mass spectrometer setup, 
syringe pump, divert valves, and contact closure that you specified on 
the Experiment Setup page.

❖ To zoom in or out on the Summary page

• Position the mouse pointer within the pane, press the <Ctrl> key, 
and roll the mouse wheel forward to zoom in.

• Position the mouse pointer within the pane, press the <Ctrl> key, 
and roll the wheel backward to zoom out.

NOTICE The content of this page will be printed together with the 
information for other instruments. ▲

❖ To display this page

In the Instrument Setup window, click the Summary tab.
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Dialog Boxes of the Experiment Setup Page
This section provides a reference to the dialog boxes in the Experiment 
Setup page:

• Use the dialog boxes for global lists to define properties of masses 
that are used for setting up the experiments in the Experiment Setup 
page:

- Lock Masses Dialog Box

- Inclusion List Dialog Box

- Exclusion List Dialog Box

- Neutral Losses Dialog Box

- Tag Masses Dialog Box

• Mass Calculator

NOTICE When importing data from csv files or txt files, pay attention 
to the following guidelines:
• Thermo Fisher Scientific recommends pasting the data from 

comma- or tab-separated files into a table instead of using the 
Import command. This way, the character encoding is usually 
transported and special letters like μ or € or ³ appear as desired.

• Empty lines are ignored when pasting.
• The order and content of columns must match the table if no 

column headers are present. With column headers present, the order 
is taken from the headers.

• Missing columns enforce usage of the default value.
• If a formula is present, the Method Editor always recalculates the 

m/z value of a compound. This prevents computational errors or 
missing significant fractional digits from being carried over. ▲

Lock Masses Dialog Box

Use the Lock Masses dialog box to select a lock mass list for the active 
instrument method and to edit it. See Figure 3-20. Lock masses are 
peaks in the spectrum that the mass spectrometer uses for internal mass 
calibration. Using lock masses improves the mass accuracy of the mass 
analyzer. If you do not specify any lock masses, the mass spectrometer 
uses the external mass calibration.

The dialog box allows defining a time window of activity for each lock 
mass (=timed lock masses). If Start or End is left blank, the lock mass is 
active from the beginning or until the end of the method, respectively. 
In the latter case, the End field displays “end.” The usage of lock masses 
during the active instrument method is specified on the Properties pane 
of the method.
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The table shows the properties of the masses contained in the active lock 
mass list (*.lock-masses). To change the sort order, click the respective 
table column header. To invert the sort order, click again.

The Lock Masses dialog box has the following parameters:

❖ To display this dialog box

1. In the Method Editor, expand the Global Lists pane.

2. Click the  button.

Title Bar

The title bar of a global list displays the name of the dialog box. A 
“modified” indicates a file with unsaved changes.

Figure 3-20. Method Editor—Lock Masses dialog box

Parameter Description

Mass [m/z] Enter the mass-to-charge-ratio of the lock mass into the field (with a maximum of five 
decimals).

To change this value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. Or, enter a value in the spin box text field.

Polarity Use this list box to toggle between positive ion and negative ion polarity. During a scan, the 
mass spectrometer uses only the lock masses with a polarity that matches the active ion mode.

Start [min] Enter the start time in minutes. Or, enter a time in seconds (by appending the letter s) or in 
hours (by appending the letter h). The software automatically converts your input into 
minutes.

End [min] Enter the end time in minutes. Or, enter a time in seconds (by appending the letter s) or in 
hours (by appending the letter h). The software automatically converts your input into 
minutes.

Comment Enter a comment for the lock mass into the field (for example, the compound name). This 
field is optional.
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File Menu

The File menu provides commands for file operations. It has the 
following commands:

Edit Menu

The Edit menu provides commands for editing the active file. It has the 
following commands:

Help Menu

Displays the Help for this dialog box.

Command Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to 
the program-specific data files, you can select *.csv or *.txt files that meet the 
requirements of the program. All available masses are replaced by the masses 
contained in the imported file. Click Open to import the file.

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition 
to using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to 
using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Or, click the Done button at the 
right side of the menu bar.

Command Description 

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text files. When 
the data in the clipboard are not in this format, the command is not available. ▲
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Inclusion List Dialog Box

Use the Inclusion List dialog box to edit a list of specific masses 
(inclusion masses) that can activate a Data Dependent action. See 
Figure 3-21. The dialog box allows defining a time window of activity 
for each inclusion mass. If Start or End is left blank, the inclusion mass 
is active from the beginning or until the end of the method, respectively. 
In the latter case, the End field displays “end.”

To use an inclusion list in a experiment, set the Inclusion parameter on 
the Parameter pane to on. When a inclusion mass list is used in a Data 
Dependent experiment (Full MS / dd-MS2, Targeted-SIM / dd-MS2, 
Full MS /AIF / NL dd-MS2), the ions will be selected for the Data 
Dependent scan event, only if they are: 

1. appearing in the referring master scan (mostly the full scan) and 

2. fulfill all of the other defined selection criteria, such as Intensity 
Threshold.

Because target-based experiments or experiment parts (Targeted-SIM, 
PRM, Targeted-SIM / dd-MS2) are based on an inclusion list, the 
Inclusion parameter is always set to on for these experiments.

The table shows the properties of the masses contained in the active 
inclusion masses list (*.include-masses). To change the sort order, click 
the respective table column header. To invert the sort order, click again.

The Inclusion List dialog box has the following parameters:

Figure 3-21. Method Editor—Inclusion List dialog box

Parameter Description

Mass [m/z] Enter the mass-to-charge-ratio of the inclusion mass into the field (with a maximum of five 
decimals).

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲
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Formula [M] Use this field to describe the structure of the active compound. In addition to chemical 
formulas, you can enter amino acid sequences (one letter code) and peptide sequences (if 
they are structural terminated by H2O). The different ways of definition are called formula 
types. You can either enter the formula directly or use the Mass Calculator. To display this 
editor, click the down arrow in this field. 

If more than one formula type for your input is possible, the Method Editor chooses the 
type with the highest priority (chemical formula > peptides > amino acids). Peptide 
sequences are marked by the prefix “p:” (for example, p: MRFA with m/z = 524.26496), 
amino acids by the prefix “aa:” (for example, aa: MRFA with m/z = 506.25440). Enter a 
prefix directly with the formula to ensure that the right type is applied.

Pay attention to the following restrictions:
• When you enter a valid formula, the Method Editor will set the default values for 

charge state (1) and Species (+H/-H). Then it will display an automatically calculated 
value in the Mass [m/z] field.

• When you enter a formula that the Method Editor cannot interpret, the Mass [m/z] 
field will stay empty. When you save the method, the Method Editor will warn you that 
the method is not in the shape to be executed (due to the missing m/z value). When you 
reopen the method, the Method Editor will display exactly the formula that was 
entered.

• When you enter a formula, The Method Editor requires a value for the charge state to 
calculate an m/z value. You can, however, save the method without specifying a charge 
state for the entry. When you save the method, the Method Editor will warn you that 
the method is not in the shape to be executed (due to the missing charge state). When 
you reopen the method, the Method Editor will display exactly the formula that was 
entered.

• Entries of compounds with calculated m/z values outside the measurement 
specifications of the mass spectrometer (m/z=50–6000) can be saved in an instrument 
method. The instrument software, however, will ignore these entries when it executes 
the method.

• When you change the m/z value that was calculated for the given set of formula, species 
and charge state, the Method Editor will clear the formula and species definition. The 
charge state will be preserved.

• When you change the polarity for a set of calculated m/z, formula, species and charge 
state, the Method Editor will clear the Mass [m/z] field if the species definition is not 
valid for this polarity. You then need to change the species definition.

Parameter Description
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Species Use this text field to define adducts or modifications of the active compound that are 
expected to be formed. The default value is +H for positive polarity and –H for negative 
polarity. The Method Editor will then recalculate the value in the Mass [m/z] field, if 
possible.

The Species field can be used in two ways:

• Click the down arrow to display a list of predefined adducts for each polarity:

- +H, +Na, +K, +NH4 for positive polarity

- -H, +Cl, +OH, +HCOO for negative polarity

- an empty entry to express adducts (for example, radical cations) for both polarities.

The corresponding set will be displayed depending on the selected polarity. 

Selecting an adduct (A) will result in the strict behavior of applying one unit A to the 
compound and using “+H” or “-H” adduct depending on the charge state and active 
polarity.

“+K” = [M + K+ + (z-1)H+]z+; for example, MRFA, +K, CS=2, positive pol. = [M + K+ 
+ H+]2+

• Enter the modifications of the compound by using squared brackets and at least M as 
representation of the basic compound (for example, [M + Na + K] or [2M + Na]). The 
predefined adducts can be entered, too. This definition is used without additional auto 
dependencies, like adding protons. 

NOTICE If you use the Mass Calculator to edit the Formula field, the Species field is 
automatically filled when you exit the editor. ▲

CS [z] Use this spin box to enter the charge state of the ion to be fragmented. The valid range is 1–
100. The required collision energy for fragmenting an ion depends on its charge state. The 
higher the charge state, the lower the required collision energy. If this field is left blank, any 
charge state will be accepted, even unassigned.

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

Polarity Use this list box to toggle between positive ion and negative ion polarity. During a scan, the 
mass spectrometer uses only the inclusion masses with a polarity that matches the active ion 
mode.

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

Start [min] Enter the start of the time window (in minutes) that corresponds to the mass in this row. 
Or, enter a time in seconds (by appending the letter s) or in hours (by appending the letter 
h). The software automatically converts your input into minutes.

Parameter Description
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❖ To display this dialog box

1. In the Method Editor, expand the Global Lists pane.

2. Click the  button.

Title Bar

The title bar of a global list displays the name of the dialog box. A 
“modified” indicates a file with unsaved changes.

End [min] Enter the end of the time window in minutes. Or, enter a time in seconds (by appending 
the letter s) or in hours (by appending the letter h). The software automatically converts 
your input into minutes.

(N)CE Use the spin box to enter a potential gradient in the HCD cell used to fragment ions. The 
default collision energy is 35 eV. In the list box, specify whether absolute collision energy 
CE [eV] is used or normalized collision energy NCE is used. The valid range is 10 to 200 
eV for CE or 10 to 200 for NCE. In the list, the software adds the prefix “ce:” to collision 
energy values (for example, ce:35).

A high collision energy value results in more energy deposition (which generally leads to 
more fragmentation). A low collision energy value results in less energy deposition (which 
generally leads to less fragmentation).

MSX ID Enter the number of the multiplexed scan event in which the inclusion mass was analyzed.

Comment Enter a comment for the inclusion mass into the field (for example, the compound name). 
This field is optional.

Parameter Description
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File Menu

The File menu provides commands for file operations. It has the 
following commands:

Command Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to 
the program-specific data files, you can select *.csv or *.txt files that meet the 
requirements of the program. All available masses are replaced by the masses 
contained in the imported file. Click Open to import the file.

When you want to import *.csv or *.txt files with entries that contain formulas, an 
extra third column “Formula type,” which contains the prefix, must specify the 
formula type. Valid values for the fields that can be (re)interpreted are:
• for Peptide type: “Peptide”, “p”, and “p:” (all case insensitive),
• for Amino acid type: “Amino acid”, “aa”, “aa:” (all case insensitive),
• for Chemical formula type: “Chemical formula”, “c”, “c:” (all case insensitive), 

and “” (empty).

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition 
to using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

When you export *.csv or *.txt files with entries that contain formulas, an extra 
third column “Formula type” specifies the formula type. Values for the fields that 
are:
• for Peptide type: “Peptide”,
• for Amino acid type: “Amino acid”,
• for Chemical formula type: “” (empty).

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to 
using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Or, click the Done button at the 
right side of the menu bar.
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Edit Menu

The Edit menu provides commands for editing the active file. It has the 
following commands:

Help Menu

Displays the Help for this dialog box.

Exclusion List Dialog Box

Use the Exclusion List dialog box to edit a list of specific masses 
(exclusion masses) that will not trigger a subsequent Data Dependent 
scan even if they are present. See Figure 3-22. The dialog box allows 
defining a time window of activity for each exclusion mass. If Start or 
End is left blank, the exclusion mass is active from the beginning or 
until the end of the method, respectively. In the latter case, the End field 
displays “end.”

To use an exclusion list in a experiment, set the Exclusion parameter on 
the Parameter pane to on.

The table shows the properties of the masses contained in the active 
exclusion masses list (*.exclude-masses). To change the sort order, click 
the respective table column header. To invert the sort order, click again.

Command Description 

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text files. When 
the data in the clipboard are not in this format, the command is not available. ▲

Figure 3-22. Method Editor—Exclusion List dialog box
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The Exclusion List dialog box has the following parameters:

Parameter Description

Mass [m/z] Enter the mass-to-charge-ratio of the exclusion mass into the field (with a maximum of five 
decimals).

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

Formula [M] Use this field to describe the structure of the active compound. In addition to chemical 
formulas, you can enter amino acid sequences (one letter code) and peptide sequences (if 
they are structural terminated by H2O). The different ways of definition are called formula 
types. You can either enter the formula directly or use the Mass Calculator. To display this 
editor, click the down arrow in this field. 

If more than one formula type for your input is possible, the Method Editor chooses the 
type with the highest priority (chemical formula > peptides > amino acids). Peptide 
sequences are marked by the prefix “p:” (for example, p: MRFA with m/z = 524.26496), 
amino acids by the prefix “aa:” (for example, aa: MRFA with m/z = 506.25440). Enter a 
prefix directly with the formula to ensure that the right type is applied.

Pay attention to the following restrictions:
• When you enter a valid formula, the Method Editor will set the default values for charge 

state (1) and Species (+H/–H). Then it will display an automatically calculated value in 
the Mass [m/z] field.

• When you enter a formula that the Method Editor cannot interpret, the Mass [m/z] field 
will stay empty. When you save the method, the Method Editor will warn you that the 
method is not in the shape to be executed (due to the missing m/z value). When you 
reopen the method, the Method Editor will display exactly the formula that was entered.

• When you enter a formula, The Method Editor requires a value for the charge state to 
calculate an m/z value. You can, however, save the method without specifying a charge 
state for the entry. When you save the method, the Method Editor will warn you that the 
method is not in the shape to be executed (due to the missing charge state). When you 
reopen the method, the Method Editor will display exactly the formula that was entered.

• Entries of compounds with calculated m/z values outside the measurement specifications 
of the mass spectrometer (m/z=50–6000) can be saved in an instrument method. The 
instrument software, however, will ignore these entries when it executes the method.

• When you change the m/z value that was calculated for the given set of formula, species 
and charge state, the Method Editor will clear the formula and species definition. The 
charge state will be preserved.

• When you change the polarity for a set of calculated m/z, formula, species and charge 
state, the Method Editor will clear the Mass [m/z] field if the species definition is not 
valid for this polarity. You then need to change the species definition.
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Species Use this field to define adducts or modifications of the active compound that are expected to 
be formed. The default value is +H for positive polarity and –H for negative polarity. The 
Method Editor will then recalculate the value in the Mass [m/z] field, if possible.

The Species field can be used in two ways:

• Click the down arrow to display a list of predefined adducts for each polarity:

- +H, +Na, +K, +NH4 for positive polarity

- -H, +Cl, +OH, +HCOO for negative polarity

- an empty entry to express adducts (for example, radical cations) for both polarities.

The corresponding set will be displayed depending on the selected polarity. 

Selecting an adduct (A) will result in the strict behavior of applying one unit A to the 
compound and using “+H” or “-H” adduct depending on charge state and active 
polarity.

“+K” = [M + K+ + (z-1)H+]z+; for example, MRFA, +K, CS=2, positive pol. = [M + K+ + 
H+]2+

• Enter the modifications of the compound by using squared brackets and at least M as 
representation of the basic compound (for example, [M + Na + K] or [2M + Na]). The 
predefined adducts can be entered, too. This definition is used without additional auto 
dependencies, like adding protons. 

If you select or define a species and the Formula field is empty, the species definition will stay 
grayed out.

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

CS [z] Use the spin box to enter the charge state of the ion to be excluded. The valid range is 1–
100. The required collision energy for fragmenting an ion depends on its charge state. The 
higher the charge state, the lower the required collision energy. 

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

Polarity Use this list box to toggle between positive ion and negative ion polarity. During a scan, the 
mass spectrometer uses only the exclusion masses with a polarity that matches the active ion 
mode.

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

Start [min] Enter the start of the time window (in minutes) that corresponds to the mass in this row. Or, 
enter a time in seconds (by appending the letter s) or in hours (by appending the letter h). 
The software automatically converts your input into minutes.

Parameter Description
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❖ To display this dialog box

1. In the Method Editor, expand the Global Lists pane.

2. Click the  button.

Title Bar

The title bar of a global list displays the name of the dialog box. A 
“modified” indicates a file with unsaved changes.

File Menu

The File menu provides commands for file operations. It has the 
following commands:

End [min] Enter the end of the time window in minutes. Or, enter a time in seconds (by appending the 
letter s) or in hours (by appending the letter h). The software automatically converts your 
input into minutes.

Comment Enter a comment for the exclusion mass into the field (for example, the compound name). 
This field is optional.

Parameter Description

Command Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to 
the program-specific data files, you can select *.csv or *.txt files that meet the 
requirements of the program. All available masses are replaced by the masses 
contained in the imported file. Click Open to import the file.

When you want to import *.csv or *.txt files with entries that contain formulas, an 
extra third column “Formula type,” which contains the prefix, must specify the 
formula type. Valid values for the fields that can be (re)interpreted are:
• for Peptide type: “Peptide”, “p”, and “p:” (all case insensitive),
• for Amino acid type: “Amino acid”, “aa”, “aa:” (all case insensitive),
• for Chemical formula type: “Chemical formula”, “c”, “c:” (all case insensitive), 

and “” (empty).

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition 
to using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

When you export *.csv or *.txt files with entries that contain formulas, an extra 
third column “Formula type” specifies the formula type. Values for the fields that 
are:
• for Peptide type: “Peptide”,
• for Amino acid type: “Amino acid”,
• for Chemical formula type: “” (empty).
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Edit Menu

The Edit menu provides commands for editing the active file. It has the 
following commands:

Help Menu

Displays the Help for this dialog box.

Neutral Losses Dialog Box

Use the Neutral Losses dialog box to edit neutral losses that can trigger a 
Data Dependent scan. See Figure 3-23. The neutral losses are applied 
only in the Full MS /AIF / NL dd-MS2 experiment. If a defined 
negative mass distance is found between a peak of the Full MS scan and 
those of the AIF scan, the corresponding peak of the Full MS scan will 
be isolated and fragmented to get the depending fragments.

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to 
using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Or, click the Done button at the 
right side of the menu bar.

Command Description

Command Description 

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text files. When 
the data in the clipboard are not in this format, the command is not available. ▲
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The table shows the mass delta of the neutral loss and the charge state of 
the precursor ion. To change the sort order, click the respective table 
column header. To invert the sort order, click again.

The Neutral Losses dialog box has the following parameters:

❖ To display this dialog box

1. In the Method Editor, expand the Global Lists pane.

2. Click the  button.

Title Bar

The title bar of a global list displays the name of the dialog box. A 
“modified” indicates a file with unsaved changes.

Figure 3-23. Method Editor—Neutral Losses dialog box

Parameter Description

 Mass [m/z] Use this spin box to enter the mass difference of the 
potential neutral loss (with a maximum of five 
decimals) as value independent of the method 
polarity. The valid range is 0.00001 to 
±4000.00000.

CS [z] Use this spin box to enter the charge state (CS) of 
the precursor ion. One entry must be defined per 
CS (for example, m/z=18, CS=1; m/z=9, CS=2; 
m/z=4.5, CS=3;…).

The valid range is 1–100. If this field is left blank, 
any charge state is allowed, even an unassigned.

Comment Enter a comment for the neutral loss into the field 
(for example, the compound name). This field is 
optional.
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File Menu

The File menu provides commands for file operations. It has the 
following commands:

Edit Menu

The Edit menu provides commands for editing the active file. It has the 
following commands:

Help Menu

Displays the Help for this dialog box.

Command Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to 
the program-specific data files, you can select *.csv or *.txt files that meet the 
requirements of the program. All available masses are replaced by the masses 
contained in the imported file. Click Open to import the file.

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition 
to using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to 
using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Or, click the Done button at the 
right side of the menu bar.

Command Description 

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text files. When 
the data in the clipboard are not in this format, the command is not available. ▲
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Tag Masses Dialog Box

An MS/MS scan can be triggered by a mass that has a ‘partner’ mass a 
user-defined delta away. Use the Tag Masses dialog box to edit a list of 
such mass deltas. See Figure 3-20. This is useful for applications where 
mass tags are used, or where mass pairs are known, and can greatly 
reduce the number of MS/MS scans on non-tagged species.

Tag masses can be used only in the Full MS / dd-MS2 experiment. To 
use tag masses, set the Tags parameter on the Parameter pane to on.

The table displays the properties of the available tag masses. To change 
the sort order, click the respective table column header. To invert the 
sort order, click again.

The Tag Masses dialog box has the following parameters:

❖ To display this dialog box

1. In the Method Editor, expand the Global Lists pane.

2. Click the  button.

Figure 3-24. Method Editor—Tag Masses dialog box

Parameter Description

 Mass [m/z] Use this spin box to enter the mass difference (with 
a maximum of five decimals). Depending on the 
sign, one precursor of the pair will be triggered. If 
you want to trigger on the heavy precursor (with a 
tag or isotope label), you need to enter a negative 
sign (for example, –6.02). It will be checked if an 
m/z distance towards lower m/z will be found. If so, 
the precursor at higher m/z will be selected. A 
positive m/z distance leads to the selection of the 
precursor with a lower m/z. If both precursors 
should be selected, two entries are needed, one with 
positive and one with negative sign.

The valid range is 0.00001 to ±4000.00000.

Comment Enter a comment into the field (for example, the 
compound name). This field is optional.
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Title Bar

The title bar of a global list displays the name of the dialog box. A 
“modified” indicates a file with unsaved changes.

File Menu

The File menu provides commands for file operations. It has the 
following commands:

Edit Menu

The Edit menu provides commands for editing the active file. It has the 
following commands:

Command Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to 
the program-specific data files, you can select *.csv or *.txt files that meet the 
requirements of the program. All available masses are replaced by the masses 
contained in the imported file. Click Open to import the file.

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition 
to using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to 
using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Or, select an existing file. Click Save to 
save the file.

This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Or, click the Done button at the 
right side of the menu bar.

Command Description 

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text files. When 
the data in the clipboard are not in this format, the command is not available. ▲
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Help Menu

Displays the Help for this dialog box.

Mass Calculator

Use the Mass Calculator to specify the properties of compounds that are 
used in the Inclusion List dialog box and the Exclusion List dialog box.

When you display the Mass Calculator, its fields are filled with the 
values of the active list fields, if available. Otherwise, its fields are filled 
with the default values. The Method Editor applies the set and 
calculated values of the Mass Calculator to the active list fields, when 
you exit the editor by doing one of the following:

• Press Enter at any position.

• Click at any position outside of the editor.

• Click the down arrow in the Formula field again.

The Mass Calculator has the following parameters:

Figure 3-25. Mass Calculator (Method Editor)

Parameter Description

Compound

Formula Use the text field to specify the basic composition of the compound. Click the 
down arrow to display a list of the last entered compounds.

The syntax rules and interpretation accept the kind of formula that is also 
accepted on the Spectrum Simulation page (Isotope Simulation area) of the 
Qual Browser.
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Type Use the Type list to specify the formula type used in the Formula field:
• Chemical formula Formula is defined as the resulting elemental 

composition of the entered formula. This is the default selection.
• Peptide Formula is defined as the sum of all of the entered amino acids 

additionally terminated with H at the N-terminus and OH at the 
C-terminus.

• Amino Acid Formula is defined as the sum of all of the entered amino acids.

Independent of the entry in the Species field, the elemental composition and the 
mass of the compound, Formula is completely determined by the given formula 
and selected formula type.

Determined or defined formulas types are marked by the addition of a text 
prefix. For peptides it is “p:” (for example, “p: MRFA”); for amino acids it is 
“aa:” (for example, “aa: MRFA”). No prefix is displayed for chemical formulas.

Species Use this text field to define adducts or modifications of the active compound 
that are expected to be formed. The default value is +H for positive polarity and 
–H for negative polarity.

The Species field can be used in two ways:

• Click the down arrow to display a list of predefined adducts for each 
polarity:

- +H, +Na, +K, +NH4 for positive polarity

- -H, +Cl, +OH, +HCOO for negative polarity

- an empty entry to express adducts (for example, radical cations) for both 
polarities.

The corresponding set will be displayed depending on the selected polarity. 

Selecting an adduct (A) will result in the strict behavior of applying one unit 
A to the compound and using “+H” or “-H” adduct depending on the 
charge state and active polarity.

“+K” = [M + K+ + (z-1)H+]z+; for example, MRFA, +K, CS=2, positive pol. 
= [M + K+ + H+]2+

• Enter the modifications of the compound by using squared brackets and at 
least M as representation of the basic compound (for example, [M + Na + K] 
or [2M + Na]). The predefined adducts can be entered, too. This definition 
is used without additional auto dependencies, like adding protons. 

Charge state Use the list box to select the resulting charge state. Available options are 1+ to 
100+ for positive polarity and 1– to 100– for negative polarity. The default 
charge state is 1+ for positive polarity and 1– for negative polarity.

Polarity Use the option buttons to select the applied polarity. The default polarity is 
positive.

Parameter Description
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❖ To display the Mass Calculator

Click the down arrow in a Formula cell of the Inclusion List dialog 
box or the Exclusion List dialog box.

m/z This text field displays the calculated mass-to-charge ratio, with five decimal 
places (for example, 524.26496).

Composition This text field displays the determined total formula (for example, C23 H38 N7 
O5 S).

Parameter Description
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Chapter 4 Explore Q Exactive HF-X Tune

This chapter provides information about Q Exactive HF-X Tune, its 
views, functions, and features.

Contents

• “Q Exactive HF-X Tune Overview” on page 4-2

• “Q Exactive HF-X Tune Menus” on page 4-5

• “Toolbar” on page 4-9

• “Tasks Panel” on page 4-12

• “Display Panel” on page 4-54

• “Dialog Boxes” on page 4-64
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Q Exactive HF-X Tune Overview
The Q Exactive HF-X Tune program is used to operate the 
Q Exactive HF-X mass spectrometer. Figure 4-1 shows 
Q Exactive HF-X Tune. To access information about Q Exactive HF-X 
Tune, use the title bar, the toolbar, menu commands, display views, and 
Help.

❖ To display this window

• Choose Start > Programs > Thermo Exactive Series > Tune, or

• Click  on the desktop.

NOTICE When you are running Q Exactive HF-X Tune, an 
Q Exactive HF-X Tune icon ( ) is displayed in the Microsoft™ 
Windows™ system tray. Double-click the  icon to display the 
Q Exactive HF-X Tune window when it is minimized. Right-click the 

 icon to display a shortcut menu that provides commands for 
restoring or terminating Q Exactive HF-X Tune. ▲

Figure 4-1. Q Exactive HF-X Tune
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Title Bar

The Q Exactive HF-X Tune title bar displays the name of the program, 
the name of the current Tune Method, and the instrument status. An 
asterisk indicates a Tune Method with unsaved changes.

Menus

The Q Exactive HF-X Tune menu bar displays the available menus. The 
Q Exactive HF-X Tune menus are as follows:

• File Menu

• Windows Menu

• Reports Menu

• Help Menu

On the far right side of the menu bar, the active user role is displayed.

Toolbar

The Toolbar provides symbol shortcuts for frequently used commands. 
It is located below the title bar of the Q Exactive HF-X Tune window. 

Tasks Panel

The tasks panel on the left side of the Q Exactive HF-X Tune window 
comprises five windows:

• The Instrument Control Window on the left side of the 
Q Exactive HF-X Tune window comprises three windows:

 Scan Parameters Window for defining a scan depending on the 
scan mode and scan type combination.

 API Source window for displaying and editing parameters of the 
API source. The window adapts name and parameters of the 
currently detected source. At present, Q Exactive HF-X Tune 
provides the following API source windows:

ESI Source Window

HESI Source Window

NSI Source Window

APCI Source Window

APPI Source Window

DART Source Window
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MALDI Source Window

 Acquisition Window for acquiring and storing measurement 
data.

• Mass Traces Window for selecting mass traces that are displayed in 
the Analysis Graphs Window.

• Calibrate Window for performing an automatic optimization of the 
calibration parameters.

• Evaluate Window for performing an automatic check of the 
instrument precision.

• Vacuum / Bakeout Window for displaying the pressure values at the 
vacuum gauges and performing an instrument bakeout.

Display Panel

The display panel on the right side of the Q Exactive HF-X Tune 
window comprises up to five windows:

• Spectrum Window for displaying a real-time data plot. The 
spectrum window is always visible.

• Instrument Status Window for displaying instrument parameters.

• Messages Window for displaying current status information about 
the instrument, the control service, or other programs.

• Analysis Graphs Window for displaying a real-time graph.

• Debug Messages Window for displaying messages that can be used 
during software development. The debug messages window is not 
available for standard users.

In addition to these five windows, the display panel may show 
additional windows for controlling other installed instruments.
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Q Exactive HF-X Tune Menus
The Q Exactive HF-X Tune window has the following menus:

• File Menu

• Windows Menu

• Reports Menu

• Help Menu

User Role

On the far right side of the menu bar, the active user role is displayed. 
The user role specifies the number of parameters that are available for 
the active experiment. Standard User is the user role with the lowest 
number of available parameters.

Click the entry (Advanced, for example) to display a list that displays the 
available user roles. To change the active user role, click the respective 
entry. The number of available user roles depends on the installed 
licenses. See “License Dialog Box” on page 4-66.

File Menu

The File menu provides commands for file and program operations. It 
has the following commands:

Command Description

Load Tune File Displays a dialog box that you can use to find and 
open a tune file (*.mstune) that already exists.

Save Tune File Saves the active tune file with the current settings.

NOTICE Do not overwrite the default tune file 
C:\Xcalibur\methods\HESI_Installation.mstune! ▲

Save Tune File as Opens a dialog box that you can use to enter a new 
file name and to select the location (disk and 
directory) where you want to save it. Click Save to 
save the tune file with the current settings.

NOTICE Do not overwrite the default tune file 
C:\Xcalibur\methods\HESI_Installation.mstune! ▲
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Windows Menu

The Windows menu provides commands for customizing the 
information displayed in the Q Exactive HF-X Tune window. The 
system highlights the icon to the left of a command if the window is 
active. Deselect the command to hide the window.

The Windows menu has the following commands:

Export System 
Settings

Opens a dialog box that you can use to save the 
current system settings (*.ini) to be imported on 
another computer that has no instrument attached 
and is intended for method editing. This computer 
has to have installed all needed software including 
Thermo Platform, Thermo Xcalibur and all 
instrument drivers like HPLC drivers installed.

NOTICE Imported values will be overwritten if an 
instrument will be attached later. ▲

Terminate Closes the active window. If the active tune file 
contains unsaved changes, a dialog box warns about 
losing data when you terminate the program.

Command Description

Command Description

View > Show all Displays all windows of Q Exactive HF-X 
Tune.

Tooltips Displays a short description of an item on 
the Q Exactive HF-X Tune window when 
you rest the mouse pointer over it.

Spectrum Displays the Spectrum window.

The Spectrum Window is always visible.

Instrument Status Displays/Hides the Instrument Status 
window.

Messages Displays/Hides the Messages window.

Analysis Graphs Displays/Hides the Analysis Graphs window.

Debug Messages Displays/Hides the Debug Messages 
window.

The debug messages window is not available 
for standard users.
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NOTICE Q Exactive HF-X Tune may open some windows (the analysis 
graphs window, for example) without user interaction if new important 
information is available. ▲

Reports Menu

The Reports menu provides access to various calibration reports. The 
individual commands are available only when the respective reports have 
been created. If no reports exist (in a new system, for example), the 
Reports menu is shown grayed out and has no commands.

The Reports menu has the following commands:

Mass Calculator Displays the Mass Calculator, which helps 
you to calculate the mass of an compound of 
interest.

Installed 
instruments

Depending on the individual configuration 
of your system, additional commands may 
allow displaying windows for controlling 
other installed instruments (Accela™ AS or 
Accela Pump, for example.)

Command Description

Command Description

Calibration > Latest Opens the latest complete calibration 
report in PDF format.

Calibration > List Displays the list of up to five (5) 
complete calibration reports.

To open a report, double-click any of the 
calibration from the list.

Spectral Mass Calibration 
(neg) > Latest

Opens the latest negative mode 
calibration report in PDF format.

Spectral Mass Calibration 
(neg) > List

Displays the list of up to five (5) negative 
mode calibration reports.

To open a report, double-click any of the 
spectral mass calibration from the list.

Spectral Mass Calibration 
(pos) > Latest

Opens the latest positive mode 
calibration report in PDF format.

Spectral Mass Calibration 
(pos) > List

Displays the list of up to five (5) positive 
mode calibration reports.

To open a report, double-click any of the 
spectral mass calibration from the list.
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Help Menu

The Help menu groups commands that provide information about 
Q Exactive HF-X Tune. It has the following commands:

Evaluation > Latest Opens the latest complete evaluation 
report in PDF format.

Evaluation > List Displays the list of up to five (5) 
complete evaluation reports. To open a 
report, double-click any of the items 
from the list.

Spectral Mass Evaluation 
(neg) > Latest

Opens the latest negative mode 
evaluation report in PDF format.

Spectral Mass Evaluation 
(neg) > List

Displays the list of up to five (5) negative 
mode evaluation reports. To open a 
report, double-click any of the items 
from the list.

Spectral Mass Evaluation 
(pos) > Latest

Opens the latest positive mode 
evaluation report in PDF format.

Spectral Mass Evaluation 
(pos) > List

Displays the list of up to five (5) positive 
mode evaluation reports. To open a 
report, double-click any of the items 
from the list.

All Reports Opens a file manager window with a list 
of all previously acquired spectral mass 
calibration reports.

Command Description

Command Description

Help Overview Displays Q Exactive HF-X Tune Help.

Help Content Displays the table of contents for Q Exactive HF-X 
Tune Help.

Help Index Displays the index for Q Exactive HF-X Tune 
Help.

About Displays the About dialog box with information 
about the instrument and the current 
Q Exactive HF-X Tune version.
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Toolbar
The Q Exactive HF-X Tune toolbar provides symbol shortcuts for 
frequently used commands. It is located below the title bar of the 
Q Exactive HF-X Tune window. To activate a toolbar function, click the 
corresponding toolbar button.

Some symbols provide information about the current statuses of 
respective instrument components either by their color or by displaying 
a tooltip when you rest the mouse pointer on them.

The following functions are available:

Button Description

General instrument state

On / Standby / Off

Run by Xcalibur

Click to toggle between the instrument operating statuses On, 
Standby, and Off. The button reflects the instrument status:
• When the mass spectrometer is On, Q Exactive HF-X Tune 

displays .
• When the mass spectrometer is in Standby, Q Exactive HF-X 

Tune displays .

• When the mass spectrometer is Off, Q Exactive HF-X Tune 

displays .

The status of this button controls also the statuses of gas flow and 
syringe pump use (if present).

If the mass spectrometer is controlled by an Xcalibur sequence, 

Q Exactive HF-X Tune displays . The acquisition can only 
be stopped from Xcalibur Sequence Setup View.

Open Click to display a dialog box that you can use to find and open a 
*.mstune file that already exists. Or, choose File > Load Tune 
File.

Save Click to open a dialog box that you can use to select the location 
(disk and directory) where you want to save the tune file. Or, 
choose File > Save Tune File as.

This button is not available when the settings of the active tune 
file are not changed.
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Divert Valve A

Position 1 or Position 2

Click to switch the valve position directly. The button reflects the 
valve status (connected positions, Valve “a”).

Divert Valve B

Position 1 or Position 2

Click to switch the valve position directly. The button reflects the 
valve status (connected positions, Valve “b”).

Syringe Pump Settings

Syringe Pump On or Syringe 
Pump Off

Click to switch on/off the syringe pump (if present). A symbol in 
the lower right corner of the button indicates the current status of 
the syringe pump:
• When the syringe pump is On, Q Exactive HF-X Tune 

displays .

• When the syringe pump is Off, Q Exactive HF-X Tune 

displays .

• When the syringe pump is in an unknown status, 

Q Exactive HF-X Tune displays .

Click the down arrow to display the Syringe Pump Settings 
dialog box. Here, you can specify syringe pump parameters or 
manually operate the syringe pump.

Direct Instrument Control Click to display additional commands that allow displaying 
windows for controlling other installed instruments. The 
following systems are supported by instrument direct control:
• Thermo Scientific Accela™ 1250 Pump
• Thermo Scientific Accela Open AS autosampler
• CTC PAL™ autosampler

Communication Status Shows the actual communication status of the system:
• Green: communication with instrument is OK.
• Yellow: only service is accessible (no instrument).
• Red: communication is broken (no instrument, no service).

Button Description
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Hardware Status Shows the actual hardware status of the system (top instrument 
tree state):
• Green: all readbacks are in specifications (green hooks).
• Red: one or more readbacks are out of range.

Performance Status Shows the actual performance status of the system:
• Green: the last evaluation/calibration was successful.
• Yellow: the last evaluation/calibration was successful, but is 

out of date.
• Red: the evaluation/calibration was not successful.

By default, the performance status icon turns yellow 25 hours 
after the last successful mass calibration or check. Advanced users 
can change this value in the System node of the instrument status 
window according to their mass accuracy requirements.

Procedure active If a procedure is active (for example, system bakeout or tune) 
Q Exactive HF-X Tune displays an animated icon next to the 
performance status button.

Acquisition indicator If the mass spectrometer is acquiring data, Q Exactive HF-X 
Tune displays an animated icon next to the performance status 
button.

Button Description
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Tasks Panel
Use the windows of the tasks panel to perform procedures that maintain 
the quality of measurements with the Q Exactive HF-X mass 
spectrometer.

The tasks panel is always visible. The windows in the tasks panel can be 
minimized or maximized. Click the title bar of an individual window to 
display it.

• Instrument Control Window

• Mass Traces Window

• Calibrate Window

• Evaluate Window

• Vacuum / Bakeout Window

Instrument Control Window

Use the windows of the Instrument Control window to enter individual 
physical settings and to acquire scans. The following windows are 
available:

• Scan Parameters Window

• API Source Window (one of the following)

 ESI Source Window

 HESI Source Window

 NSI Source Window

 APCI Source Window

 APPI Source Window

 DART Source Window

 MALDI Source Window

• Acquisition Window

The Instrument Control window is always visible. Click the title bar of 
an individual window to display it. Click again to hide it. To change the 
order of windows within the Instrument Control window, drag 
individual windows by their title bars to the new places.
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Scan Parameters Window

Use the Scan Parameters window to define a scan depending on the 
selected scan mode and scan type combination. See Figure 4-2. The 
mass spectrometer updates the scan parameters only after you click 
Apply or select the Hot link check box.

The Scan Parameters window has the following parameters:

Figure 4-2. Scan Parameters window

Parameter  Description

History Click to display the Scan Parameters History dialog box. Here, select from a list of 
recent scans based on short scan descriptions. The maximum number of list items is 
100.

After a change of parameters, the history is updated when you click Apply or when 
you change the status of the Hot link check box.

Scan Type Displays the current scan type. To change the settings, click into the field to display 
the Scan Type dialog box.

Scan Range Displays the current scan range. To change the settings, click into the field to 
display the Scan Range dialog box.

Fragmentation Displays the current settings for HCD fragmentation and in-source 
CID fragmentation. If no fragmentation type is selected, the text field shows None. 
To change the settings, click into the field to display the Fragmentation dialog box.

NOTICE Automatic tuning is disabled when in-source CID fragmentation is on. ▲
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❖ To display this window

Click the Scan Parameters window title bar in the Instrument 
Control window.

Resolution Use this list box to select the mass resolution for FTMS analysis. The mass 
resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time 
increases with increasing resolution and detect time. Available options are 7500, 
15000, 30000, 45000, 60000, 120000, or 240000.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

Microscans Use this spin box to select the number of averaged transients for one scan event. To 
change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field. The 
valid range is from 1 to 10 microscans.

Lock masses Displays the active lock masses. During a scan, the mass spectrometer uses only the 
lock masses with a polarity that matches the ion mode. If no lock masses are 
selected, the text field shows Off. To change the settings, click into the field to 
display the Lock Masses dialog box.

NOTICE Q Exactive HF-X Tune allows using active lock masses in user-defined 
calibration mass lists. ▲

AGC target Use this list box to select the AGC target value. The AGC target value controls the 
number of ions that are injected into the Orbitrap analyzer. Available options are 
2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, and 5e6.

Maximum inject time Use this list box to type or click a maximum injection time for AGC. For example, 
type 160. The valid range is from 1 to 3000 milliseconds.

Buttons

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive HF-X Tune to send any changes 
immediately to the instrument. A green frame around the parameter box indicates 
an active hot link.

Parameter  Description
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ESI Source Window

Use the ESI source window to specify electrospray ionization (ESI) 
source parameters. See API Source Settings for Various LC Flow Rates 
for recommended settings. The mass spectrometer updates the 
ESI source parameters only after you click Apply or with the Hot link 
check box being selected. See Figure 4-3.

NOTICE This window is available only when the mass spectrometer has 
detected an installed ESI source. ▲

Figure 4-3. ESI source window
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The ESI source window has the following parameters:

Parameter Description

Sheath Gas Flow Rate Displays the setpoint ESI source sheath gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set the 
sheath gas flow rate to any value from 0 to 80 units. Or, enter a value in the spin 
box text field. The mass spectrometer changes the flow rate when you click Apply 
or with the Hot link check box being selected.

The Sheath Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate Displays the setpoint ESI source auxiliary gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin box 
to increment [up arrow] or decrement [down arrow] the value. You can set the 
flow rate to any value from 0 to 40 units. Or, enter a value in the spin box text 
field. The mass spectrometer changes the flow rate when you click Apply or with 
the Hot link check box being selected.

The Aux Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate Displays the setpoint ESI source sweep gas flow rate. To change the setpoint flow 
rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the flow rate to any value 
from 0 to 10 units. Or, enter a value in the spin box text field. The mass 
spectrometer changes the flow rate when you click Apply or with the Hot link 
check box being selected.

The Sweep Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Spray Voltage Displays the setpoint ESI source spray voltage (absolute value, in kilovolts). To 
change the setpoint spray voltage, click the arrows in the Spray Voltage spin box to 
increment [up arrow] or decrement [down arrow] the value. You can set the spray 
voltage to any value from 0.0 to 8.0 kV. The sign of the spray voltages changes 
automatically with the ion polarity mode: positive for positive ions and negative 
for negative ions. Or, enter a value in the spin box text field. The mass 
spectrometer changes the spray voltage when you click Apply or with the Hot link 
check box being selected.

The Spray Voltage readback is to the right of the spin box. This readback displays 
the actual spray voltage (absolute value, in kilovolts).

Spray Current This readback displays the actual ESI source spray current (in microamperes). The 
ESI spray current is typically less than 5 μA.
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❖ To display this window

Click the ESI source window title bar in the Instrument Control 
window.

Capillary Temperature Displays the setpoint ESI source heated capillary temperature (in degrees Celsius). 
To change the setpoint heated capillary temperature, click the arrows in the 
Capillary Temp spin box to increment [up arrow] or decrement [down arrow] the 
value. You can set the heated capillary temperature to any value from 0 to 450 °C. 
Or, enter a value in the spin box text field. The mass spectrometer changes the 
heated capillary temperature when you click Apply or with the Hot link check 
box being selected.

The Capillary Temperature readback is to the right of the spin box. This readback 
displays the actual temperature (in degrees Celsius) of the heated capillary.

Funnel RF Level Displays a numerical factor that the mass spectrometer uses, along with the lowest 
and highest mass, to calculate the Funnel RF amplitude.

The magnitude of the Funnel RF level affects the mass spectrum as follows:
• Decreasing the Funnel RF level will decrease the amount of fragmentation of 

fragile ions in the ion funnel. 
• Decreasing the Funnel RF level will decrease the transmission of high m/z ions 

through the ion funnel and increase the transmission of the low m/z ions. 
• Increasing the Funnel RF level will increase the amount of fragmentation of 

fragile ions in the ion funnel. 
• Increasing the Funnel RF level will increase the transmission of high m/z ions 

through the ion funnel and decrease the transmission of the low m/z ions. 

To change the Funnel RF level, click the arrows in the Funnel Level spin box to 
increment [up arrow] or decrement [down arrow] the value. You can set the 
Funnel RF level to any value from 0 to 100 (200)*. Or, enter a value in the spin 
box text field. The mass spectrometer changes the Funnel RF level when you click 
Apply or with the Hot link check box being selected.
* The value in parentheses applies only to systems with a valid High Mass Range license.

NOTICE For stable ions, the default value, 50, provides a good starting point. By 
default, the Funnel RF level remains at 50 during all calibrations. ▲

Buttons

Source Auto-Defaults This parameter is not available for this ion source type.

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive HF-X Tune to send any 
changes immediately to the instrument. A green frame around the parameter box 
indicates an active hot link.

Parameter Description
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HESI Source Window

Use the HESI source window to specify heated-electrospray ionization 
(H-ESI) source parameters. See API Source Settings for Various LC 
Flow Rates for recommended settings. The mass spectrometer updates 
the H-ESI source parameters only after you click Apply or with the Hot 
link check box being selected. See Figure 4-4.

NOTICE This window is available only when the mass spectrometer has 
detected an installed H-ESI source. The H-ESI source is the standard 
API source of the Q Exactive HF-X mass spectrometer. ▲

Figure 4-4. HESI source window
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The HESI source window has the following parameters:

Parameter Description

Sheath Gas Flow Rate Displays the setpoint H-ESI source sheath gas flow rate (in arbitrary units). 
To change the setpoint flow rate, click the arrows in the Sheath Gas Flow 
Rate spin box to increment [up arrow] or decrement [down arrow] the 
value. You can set the sheath gas flow rate to any value from 0 to 80 units. 
Or, enter a value in the spin box text field. The mass spectrometer changes 
the flow rate when you click Apply or with the Hot link check box being 
selected.

The Sheath Gas Flow Rate readback is to the right of the spin box. This 
readback displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate Displays the setpoint H-ESI source auxiliary gas flow rate (in arbitrary 
units). To change the setpoint flow rate, click the arrows in the Aux Gas 
Flow Rate spin box to increment [up arrow] or decrement [down arrow] 
the value. You can set the flow rate to any value from 0 to 40 units. Or, 
enter a value in the spin box text field. The mass spectrometer changes the 
flow rate when you click Apply or with the Hot link check box being 
selected.

The Aux Gas Flow Rate readback is to the right of the spin box. This 
readback displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate Displays the setpoint H-ESI source sweep gas flow rate. To change the 
setpoint flow rate, click the arrows in the Sweep Gas Flow Rate spin box to 
increment [up arrow] or decrement [down arrow] the value. You can set the 
flow rate to any value from 0 to 10 units. Or, enter a value in the spin box 
text field. The mass spectrometer changes the flow rate when you click 
Apply or with the Hot link check box being selected.

The Sweep Gas Flow Rate readback is to the right of the spin box. This 
readback displays the actual flow rate (in arbitrary units).

Spray Voltage Displays the setpoint H-ESI source spray voltage (absolute value, in 
kilovolts). To change the setpoint spray voltage, click the arrows in the 
Spray Voltage spin box to increment [up arrow] or decrement [down arrow] 
the value. You can set the spray voltage to any value from 0.0 to 8.0 kV. 
The sign of the spray voltages changes automatically with the ion polarity 
mode: positive for positive ions and negative for negative ions. Or, enter a 
value in the spin box text field. The mass spectrometer changes the spray 
voltage when you click Apply or with the Hot link check box being 
selected.

The Spray Voltage readback is to the right of the spin box. This readback 
displays the actual spray voltage (absolute value, in kilovolts).

Spray Current This readback displays the actual H-ESI source spray current (in 
microamperes). The H-ESI spray current is typically less than 5 μA.
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Capillary Temperature Displays the setpoint H-ESI source heated capillary temperature (in degrees 
Celsius). To change the setpoint heated capillary temperature, click the 
arrows in the Capillary Temp spin box to increment [up arrow] or 
decrement [down arrow] the value. You can set the heated capillary 
temperature to any value from 0 to 450 °C. Or, enter a value in the spin 
box text field. The mass spectrometer changes the heated capillary 
temperature when you click Apply or with the Hot link check box being 
selected.

The Capillary Temperature readback is to the right of the spin box. This 
readback displays the actual temperature (in degrees Celsius) of the heated 
capillary.

Funnel RF Level Displays a numerical factor that the mass spectrometer uses, along with the 
lowest and highest mass, to calculate the Funnel RF amplitude.

The magnitude of the Funnel RF level affects the mass spectrum as follows:
• Decreasing the Funnel RF level will decrease the amount of 

fragmentation of fragile ions in the ion funnel. 
• Decreasing the Funnel RF level will decrease the transmission of high 

m/z ions through the ion funnel and increase the transmission of the 
low m/z ions. 

• Increasing the Funnel RF level will increase the amount of 
fragmentation of fragile ions in the ion funnel. 

• Increasing the Funnel RF level will increase the transmission of high 
m/z ions through the ion funnel and decrease the transmission of the 
low m/z ions. 

To change the Funnel RF level, click the arrows in the Funnel Level spin 
box to increment [up arrow] or decrement [down arrow] the value. You can 
set the Funnel RF level to any value from 0 to 100 (200)*. Or, enter a value 
in the spin box text field. The mass spectrometer changes the Funnel RF 
level when you click Apply or with the Hot link check box being selected.
* The value in parentheses applies only to systems with a valid High Mass Range license.

NOTICE For stable ions, the default value, 50, provides a good starting 
point. By default, the Funnel RF level remains at 50 during all 
calibrations. ▲

Aux. Gas Heater Temperature Displays the setpoint temperature (in degrees Celsius) of the H-ESI source 
heater, which heats the auxiliary gas. To change the setpoint vaporizer 
temperature, click the arrows in the Heater Temp spin box to increment 
[up arrow] or decrement [down arrow] the value. You can set the vaporizer 
temperature to any value from 0 to 600 °C. Or, enter a value in the spin 
box text field. The mass spectrometer changes the vaporizer temperature 
when you click Apply or with the Hot link check box being selected.

The Heater Temperature readback is to the right of the spin box. This 
readback displays the actual temperature (in degrees Celsius) of the 
vaporizer.

Parameter Description
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❖ To display this window

Click the HESI source window title bar in the Instrument Control 
window.

NSI Source Window

Use the NSI source window to specify nanospray ionization (NSI) 
source parameters. See Figure 4-5. The mass spectrometer updates the 
NSI source parameters only after you click Apply or with the Hot link 
check box being selected.

NOTICE This window is available only when the Q Exactive HF-X 
mass spectrometer has detected an installed NSI source. ▲

Buttons

Source Auto-Defaults Displays the Autoselect ion source values dialog box.

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive HF-X Tune to send any 
changes immediately to the instrument. A green frame around the 
parameter box indicates an active hot link.

Parameter Description

Figure 4-5. NSI source window
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The NSI source window has the following parameters:

Parameter Description

Sheath Gas Flow Rate Displays the setpoint NSI source sheath gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the sheath gas flow rate to any value from 0 to 80 units. Or, enter a value in the 
spin box text field. The mass spectrometer changes the flow rate when you click 
Apply or with the Hot link check box being selected.

The Sheath Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate Displays the setpoint NSI source auxiliary gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin box 
to increment [up arrow] or decrement [down arrow] the value. You can set the 
flow rate to any value from 0 to 40 units. Or, enter a value in the spin box text 
field. The mass spectrometer changes the flow rate when you click Apply or with 
the Hot link check box being selected.

The Aux Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate Displays the setpoint NSI source sweep gas flow rate. To change the setpoint 
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the flow rate to any 
value from 0 to 10 units. Or, enter a value in the spin box text field. The mass 
spectrometer changes the flow rate when you click Apply or with the Hot link 
check box being selected.

The Sweep Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Spray Voltage Displays the setpoint NSI source spray voltage (absolute value, in kilovolts). To 
change the setpoint spray voltage, click the arrows in the Spray Voltage spin box 
to increment [up arrow] or decrement [down arrow] the value. You can set the 
spray voltage to any value from 0.0 to 8.0 kV. The sign of the spray voltages 
changes automatically with the ion polarity mode: positive for positive ions and 
negative for negative ions. Or, enter a value in the spin box text field. The mass 
spectrometer changes the spray voltage when you click Apply or with the Hot 
link check box being selected.

The Spray Voltage readback is to the right of the spin box. This readback 
displays the actual spray voltage (absolute value, in kilovolts).

Spray Current This readback displays the actual NSI source spray current (in microamperes). 
NSI spray current is typically less than 5 μA.
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Capillary Temperature Displays the setpoint NSI source heated capillary temperature (in degrees 
Celsius). To change the setpoint heated capillary temperature, click the arrows in 
the Capillary Temp spin box to increment [up arrow] or decrement [down 
arrow] the value. You can set the heated capillary temperature to any value from 
0 to 450 °C. Or, enter a value in the spin box text field. The mass spectrometer 
changes the heated capillary temperature when you click Apply or with the Hot 
link check box being selected.

The Capillary Temperature readback is to the right of the spin box. This 
readback displays the actual temperature (in degrees Celsius) of the heated 
capillary.

Funnel RF Level Displays a numerical factor that the mass spectrometer uses, along with the 
lowest and highest mass, to calculate the Funnel RF amplitude.

The magnitude of the Funnel RF level affects the mass spectrum as follows:
• Decreasing the Funnel RF level will decrease the amount of fragmentation of 

fragile ions in the ion funnel. 
• Decreasing the Funnel RF level will decrease the transmission of high m/z 

ions through the ion funnel and increase the transmission of the low m/z 
ions. 

• Increasing the Funnel RF level will increase the amount of fragmentation of 
fragile ions in the ion funnel. 

• Increasing the Funnel RF level will increase the transmission of high m/z 
ions through the ion funnel and decrease the transmission of the low m/z 
ions. 

To change the Funnel RF level, click the arrows in the Funnel Level spin box to 
increment [up arrow] or decrement [down arrow] the value. You can set the 
Funnel RF level to any value from 0 to 100 (200)*. Or, enter a value in the spin 
box text field. The mass spectrometer changes the Funnel RF level when you 
click Apply or with the Hot link check box being selected.
* The value in parentheses applies only to systems with a valid High Mass Range license.

NOTICE For stable ions, the default value, 50, provides a good starting point. By 
default, the Funnel RF level remains at 50 during all calibrations. ▲

Buttons

Source Auto-Defaults This parameter is not available for this ion source type.

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive HF-X Tune to send any 
changes immediately to the instrument. A green frame around the parameter box 
indicates an active hot link.

Parameter Description
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❖ To display this window

Click the NSI source window title bar in the Instrument Control 
window.

APCI Source Window

Use the APCI source window to set up an atmospheric pressure 
chemical ionization (APCI) experiment. See API Source Settings for 
Various LC Flow Rates for recommended settings. The mass 
spectrometer updates the APCI source parameters only after you click 
Apply or with the Hot link check box being selected. See Figure 4-6.

NOTICE This window is available only when the mass spectrometer has 
detected an installed APCI source. ▲

Figure 4-6. APCI source window
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The APCI source window has the following parameters:

Parameter Description 

Sheath Gas Flow Rate Displays the setpoint APCI source sheath gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the sheath gas flow rate to any value from 0 to 80 units. Or, enter a value in the 
spin box text field. The mass spectrometer changes the flow rate when you click 
Apply or with the Hot link check box being selected. 

The Sheath Gas Flow Rate readback is to the right of the spin box. This 
readback displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate Displays the setpoint APCI source auxiliary gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the flow rate to any value from 0 to 40 units. Or, enter a value in the spin box 
text field. The mass spectrometer changes the flow rate when you click Apply or 
with the Hot link check box being selected. 

The Aux Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate Displays the setpoint APCI source sweep gas flow rate. To change the setpoint 
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment 
[up arrow] or decrement [down arrow] the value. You can set the flow rate to 
any value from 0 to 10 units. Or, enter a value in the spin box text field. The 
mass spectrometer changes the flow rate when you click Apply or with the Hot 
link check box being selected.

The Sweep Gas Flow Rate readback is to the right of the spin box. This 
readback displays the actual flow rate (in arbitrary units).

Discharge Voltage Displays the actual APCI source discharge voltage (absolute value, in kilovolts).

Discharge Current Displays the setpoint APCI source discharge current (in microamperes). To 
change the setpoint discharge current, click the arrows in the Discharge Current 
spin box to increment [up arrow] or decrement [down arrow] the value. You can 
set the discharge current to any value from 0 to 10 μA. (A typical value is 5 μA.) 
Or, enter a value in the spin box text field. The mass spectrometer changes the 
discharge current when you click Apply or with the Hot link check box being 
selected.

The Discharge Current readback is to the right of the spin box. This readback 
displays the actual discharge current (in microamperes).
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Capillary Temperature Displays the setpoint APCI source heated capillary temperature (in degrees 
Celsius). To change the setpoint heated capillary temperature, click the arrows 
in the Capillary Temp spin box to increment [up arrow] or decrement [down 
arrow] the value. You can set the heated capillary temperature to any value from 
0.00 to 300.00 °C. Or, enter a value in the spin box text field. The mass 
spectrometer changes the heated capillary temperature when you click Apply or 
with the Hot link check box being selected.

The Capillary Temperature readback is to the right of the spin box. This 
readback displays the actual temperature (in degrees Celsius) of the heated 
capillary.

Funnel RF Level Displays a numerical factor that the mass spectrometer uses, along with the 
lowest and highest mass, to calculate the Funnel RF amplitude.

The magnitude of the Funnel RF level affects the mass spectrum as follows:
• Decreasing the Funnel RF level will decrease the amount of fragmentation 

of fragile ions in the ion funnel. 
• Decreasing the Funnel RF level will decrease the transmission of high m/z 

ions through the ion funnel and increase the transmission of the low m/z 
ions. 

• Increasing the Funnel RF level will increase the amount of fragmentation of 
fragile ions in the ion funnel. 

• Increasing the Funnel RF level will increase the transmission of high m/z 
ions through the ion funnel and decrease the transmission of the low m/z 
ions. 

To change the Funnel RF level, click the arrows in the Funnel Level spin box to 
increment [up arrow] or decrement [down arrow] the value. You can set the 
Funnel RF level to any value from 0 to 100 (200)*. Or, enter a value in the spin 
box text field. The mass spectrometer changes the Funnel RF level when you 
click Apply or with the Hot link check box being selected.
* The value in parentheses applies only to systems with a valid High Mass Range license.

NOTICE For stable ions, the default value, 50, provides a good starting point. 
By default, the Funnel RF level remains at 50 during all calibrations. ▲

Vaporizer Temperature Displays the setpoint APCI source vaporizer temperature (in degrees Celsius). 
To change the setpoint vaporizer temperature, click the arrows in the Vaporizer 
Temp. spin box to increment [up arrow] or decrement [down arrow] the value. 
You can set the vaporizer temperature to any value from 0 to 600 °C. Or, enter a 
value in the spin box text field. The mass spectrometer changes the vaporizer 
temperature when you click Apply or with the Hot link check box being 
selected. 

The Vaporizer Temperature readback is to the right of the spin box. This 
readback displays the actual temperature (in degrees Celsius) of the vaporizer.

Buttons

Source Auto-Defaults Displays the Autoselect ion source values dialog box.

Parameter Description 
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❖ To display this window

Click the APCI source window title bar in the Instrument Control 
window.

APPI Source Window

Use the APPI source window to specify atmospheric pressure chemical 
ionization (APCI) source parameters and to turn on and off the 
atmospheric pressure photoionization (APPI) lamp. See Figure 4-7. The 
mass spectrometer updates the APPI source parameters only after you 
click Apply or with the Hot link check box being selected.

NOTICE This window is available only when the mass spectrometer has 
detected an installed APPI source. ▲

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive HF-X Tune to send any 
changes immediately to the instrument. A green frame around the parameter 
box indicates an active hot link.

Parameter Description 

Figure 4-7. APPI source window
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The APPI source window has the following parameters:

Parameter Description 

Sheath Gas Flow Rate Displays the setpoint APPI source sheath gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate 
spin box to increment [up arrow] or decrement [down arrow] the value. You 
can set the sheath gas flow rate to any value from 0 to 80 units. Or, enter a 
value in the spin box text field. The mass spectrometer changes the flow rate 
when you click Apply or with the Hot link check box being selected. 

The Sheath Gas Flow Rate readback is to the right of the spin box. This 
readback displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate Displays the setpoint APPI source auxiliary gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the flow rate to any value from 0 to 40 units. Or, enter a value in the spin box 
text field. The mass spectrometer changes the flow rate when you click Apply 
or with the Hot link check box being selected. 

The Aux Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate Displays the setpoint APPI source sweep gas flow rate. To change the setpoint 
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment 
[up arrow] or decrement [down arrow] the value. You can set the flow rate to 
any value from 0 to 10 units. Or, enter a value in the spin box text field. The 
mass spectrometer changes the flow rate when you click Apply or with the Hot 
link check box being selected.

The Sweep Gas Flow Rate readback is to the right of the spin box. This 
readback displays the actual flow rate (in arbitrary units).

Discharge Voltage When APPI is selected as ionization method, the actual discharge voltage 
displays ‘0’. When either APCI or APCI+APPI is selected as ionization 
method, the actual discharge voltage displays APCI voltage readback (absolute 
value, in kilovolts).
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Discharge Current Displays the setpoint source discharge current (in microamperes). To change 
the setpoint discharge current, click the arrows in the Discharge Current spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the discharge current to any value from 0 to 80 μA. (A typical value is 5 μA.) 
Or, enter a value in the spin box text field. The mass spectrometer changes the 
discharge current when you click Apply or with the Hot link check box being 
selected.

NOTICE When APPI is selected as ionization method, changes in discharge 
current have no effect. Discharge current changes are applied only when either 
APCI or APCI+APPI is selected as ionization method. ▲

The Discharge Current readback is to the right of the spin box. This readback 
displays the actual discharge current (in microamperes).

Capillary Temperature Displays the setpoint APPI source heated capillary temperature (in degrees 
Celsius). To change the setpoint heated capillary temperature, click the arrows 
in the Capillary Temp spin box to increment [up arrow] or decrement [down 
arrow] the value. You can set the heated capillary temperature to any value 
from 0.00 to 450.00 °C. Or, enter a value in the spin box text field. The mass 
spectrometer changes the heated capillary temperature when you click Apply 
or with the Hot link check box being selected.

The Capillary Temperature readback is to the right of the spin box. This 
readback displays the actual temperature (in degrees Celsius) of the heated 
capillary.

Parameter Description 
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Funnel RF Level Displays a numerical factor that the mass spectrometer uses, along with the 
lowest and highest mass, to calculate the Funnel RF amplitude.

The magnitude of the Funnel RF level affects the mass spectrum as follows:
• Decreasing the Funnel RF level will decrease the amount of fragmentation 

of fragile ions in the ion funnel. 
• Decreasing the Funnel RF level will decrease the transmission of high m/z 

ions through the ion funnel and increase the transmission of the low m/z 
ions. 

• Increasing the Funnel RF level will increase the amount of fragmentation 
of fragile ions in the ion funnel. 

• Increasing the Funnel RF level will increase the transmission of high m/z 
ions through the ion funnel and decrease the transmission of the low m/z 
ions. 

To change the Funnel RF level, click the arrows in the Funnel Level spin box to 
increment [up arrow] or decrement [down arrow] the value. You can set the 
Funnel RF level to any value from 0 to 100 (200)*. Or, enter a value in the spin 
box text field. The mass spectrometer changes the Funnel RF level when you 
click Apply or with the Hot link check box being selected.
* The value in parentheses applies only to systems with a valid High Mass Range license.

NOTICE For stable ions, the default value, 50, provides a good starting point. 
By default, the Funnel RF level remains at 50 during all calibrations. ▲

Vaporizer Temperature Displays the setpoint APPI source vaporizer temperature (in degrees Celsius). 
To change the setpoint vaporizer temperature, click the arrows in the Vaporizer 
Temp. spin box to increment [up arrow] or decrement [down arrow] the value. 
You can set the vaporizer temperature to any value from 0 to 500 °C. Or, enter 
a value in the spin box text field. The mass spectrometer changes the vaporizer 
temperature when you click Apply or with the Hot link check box being 
selected. 

The Vaporizer Temperature readback is to the right of the spin box. This 
readback displays the actual temperature (in degrees Celsius) of the vaporizer.

Ionization Use this list box to select the ionization method. The following options are 
available:
• APCI

APCI alone
• APPI

Photoionization
• APCI + APPI

APCI in combination with APCI
Buttons

Source Auto-Defaults This parameter is not available for this ion source type.

Apply Sends all changes to the instrument.

Parameter Description 
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❖ To display this dialog box

Click the APPI source window title bar in the Instrument Control 
window.

DART Source Window

Use the DART source window to specify direct analysis in real time 
(DART™) source parameters. See Figure 4-8. The mass spectrometer 
updates the DART source parameters only after you click Apply or with 
the Hot link check box being selected.

Using a DART ion source increases the gas input into the UHV region. 
As a result, the pressure might exceed the instrument status warning 
level. This is indicated by a yellow LED in the Vacuum / Bakeout 
window. Advanced users can enable the DART ion source compatibility 
in the Instrument Status window to increase the UHV warning level.

NOTICE This window is available only when the mass spectrometer has 
detected an installed DART source. ▲

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive HF-X Tune to send any 
changes immediately to the instrument. A green frame around the parameter 
box indicates an active hot link.

Parameter Description 

Figure 4-8. DART source window
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The DART source window has the following parameters:

Parameter Description 

Sheath Gas Flow Rate Displays the setpoint DART source sheath gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the sheath gas flow rate to any value from 0 to 80 units. Or, enter a value in the 
spin box text field. The mass spectrometer changes the flow rate when you click 
Apply or with the Hot link check box being selected. 

The Sheath Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate Displays the setpoint DART source auxiliary gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin box 
to increment [up arrow] or decrement [down arrow] the value. You can set the 
flow rate to any value from 0 to 40 units. Or, enter a value in the spin box text 
field. The mass spectrometer changes the flow rate when you click Apply or with 
the Hot link check box being selected. 

The Aux Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate Displays the setpoint DART source sweep gas flow rate. To change the setpoint 
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the flow rate to any 
value from 0 to 10 units. Or, enter a value in the spin box text field. The mass 
spectrometer changes the flow rate when you click Apply or with the Hot link 
check box being selected.

The Sweep Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Spray Voltage Displays the setpoint DART source spray voltage (absolute value, in kilovolts). 
To change the setpoint spray voltage, click the arrows in the Spray Voltage spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the spray voltage to any value from 0.0 to 8.0 kV. The sign of the spray voltages 
changes automatically with the ion polarity mode: positive for positive ions and 
negative for negative ions. Or, enter a value in the spin box text field. The mass 
spectrometer changes the spray voltage when you click Apply or with the Hot 
link check box being selected.

The Spray Voltage readback is to the right of the spin box. This readback displays 
the actual spray voltage (absolute value, in kilovolts).

Spray Current This readback displays the actual DART source spray current (in microamperes). 
DART spray current is typically less than 5 μA.
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❖ To display this dialog box

Click the DART source window title bar in the Instrument Control 
window.

Capillary Temperature Displays the setpoint DART source heated capillary temperature (in degrees 
Celsius). To change the setpoint heated capillary temperature, click the arrows in 
the Capillary Temp spin box to increment [up arrow] or decrement [down arrow] 
the value. You can set the heated capillary temperature to any value from 0.00 to 
450.00 °C. Or, enter a value in the spin box text field. The mass spectrometer 
changes the heated capillary temperature when you click Apply or with the Hot 
link check box being selected.

The Capillary Temperature readback is to the right of the spin box. This 
readback displays the actual temperature (in degrees Celsius) of the heated 
capillary.

Funnel RF Level Displays a numerical factor that the mass spectrometer uses, along with the 
lowest and highest mass, to calculate the Funnel RF amplitude.

The magnitude of the Funnel RF level affects the mass spectrum as follows:
• Decreasing the Funnel RF level will decrease the amount of fragmentation of 

fragile ions in the ion funnel. 
• Decreasing the Funnel RF level will decrease the transmission of high m/z 

ions through the ion funnel and increase the transmission of the low m/z 
ions. 

• Increasing the Funnel RF level will increase the amount of fragmentation of 
fragile ions in the ion funnel. 

• Increasing the Funnel RF level will increase the transmission of high m/z ions 
through the ion funnel and decrease the transmission of the low m/z ions. 

To change the Funnel RF level, click the arrows in the Funnel Level spin box to 
increment [up arrow] or decrement [down arrow] the value. You can set the 
Funnel RF level to any value from 0 to 100 (200)*. Or, enter a value in the spin 
box text field. The mass spectrometer changes the Funnel RF level when you 
click Apply or with the Hot link check box being selected.
* The value in parentheses applies only to systems with a valid High Mass Range license.

NOTICE For stable ions, the default value, 50, provides a good starting point. By 
default, the Funnel RF level remains at 50 during all calibrations. ▲

Buttons

Source Auto-Defaults This parameter is not available for this ion source type.

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive HF-X Tune to send any 
changes immediately to the instrument. A green frame around the parameter box 
indicates an active hot link.

Parameter Description 
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MALDI Source Window

Use the MALDI source window to specify matrix-assisted laser 
desorption/ionization (MALDI) source parameters. See Figure 4-9. The 
mass spectrometer updates the MALDI source parameters only after you 
click Apply or with the Hot link check box being selected.

NOTICE This window is available only when the mass spectrometer has 
detected an installed MALDI source. ▲

Figure 4-9. MALDI source window
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The MALDI source window has the following parameters:

Parameter Description 

Sheath Gas Flow Rate Displays the setpoint MALDI source sheath gas flow rate (in arbitrary units). To 
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the sheath gas flow rate to any value from 0 to 80 units. Or, enter a value in the 
spin box text field. The mass spectrometer changes the flow rate when you click 
Apply or with the Hot link check box being selected. 

The Sheath Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate Displays the setpoint MALDI source auxiliary gas flow rate (in arbitrary units). 
To change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the flow rate to any value from 0 to 40 units. Or, enter a value in the spin box 
text field. The mass spectrometer changes the flow rate when you click Apply or 
with the Hot link check box being selected. 

The Aux Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate Displays the setpoint MALDI source sweep gas flow rate. To change the setpoint 
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the flow rate to any 
value from 0 to 10 units. Or, enter a value in the spin box text field. The mass 
spectrometer changes the flow rate when you click Apply or with the Hot link 
check box being selected.

The Sweep Gas Flow Rate readback is to the right of the spin box. This readback 
displays the actual flow rate (in arbitrary units).

Spray Voltage Displays the setpoint MALDI source spray voltage (absolute value, in kilovolts). 
To change the setpoint spray voltage, click the arrows in the Spray Voltage spin 
box to increment [up arrow] or decrement [down arrow] the value. You can set 
the spray voltage to any value from 0.0 to 8.0 kV. The sign of the spray voltages 
changes automatically with the ion polarity mode: positive for positive ions and 
negative for negative ions. Or, enter a value in the spin box text field. The mass 
spectrometer changes the spray voltage when you click Apply or with the Hot 
link check box being selected.

The Spray Voltage readback is to the right of the spin box. This readback displays 
the actual spray voltage (absolute value, in kilovolts).

Spray Current This readback displays the actual MALDI source spray current (in 
microamperes). MALDI spray current is typically less than 5 μA.
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❖ To display this dialog box

Click the MALDI source window title bar in the Instrument 
Control window.

Capillary Temperature Displays the setpoint MALDI source heated capillary temperature (in degrees 
Celsius). To change the setpoint heated capillary temperature, click the arrows in 
the Capillary Temp spin box to increment [up arrow] or decrement [down arrow] 
the value. You can set the heated capillary temperature to any value from 0.00 to 
450.00 °C. Or, enter a value in the spin box text field. The mass spectrometer 
changes the heated capillary temperature when you click Apply or with the Hot 
link check box being selected.

The Capillary Temperature readback is to the right of the spin box. This 
readback displays the actual temperature (in degrees Celsius) of the heated 
capillary.

Funnel RF Level Displays a numerical factor that the mass spectrometer uses, along with the 
lowest and highest mass, to calculate the Funnel RF amplitude.

The magnitude of the Funnel RF level affects the mass spectrum as follows:
• Decreasing the Funnel RF level will decrease the amount of fragmentation of 

fragile ions in the ion funnel. 
• Decreasing the Funnel RF level will decrease the transmission of high m/z 

ions through the ion funnel and increase the transmission of the low m/z 
ions. 

• Increasing the Funnel RF level will increase the amount of fragmentation of 
fragile ions in the ion funnel. 

• Increasing the Funnel RF level will increase the transmission of high m/z ions 
through the ion funnel and decrease the transmission of the low m/z ions. 

To change the Funnel RF level, click the arrows in the Funnel Level spin box to 
increment [up arrow] or decrement [down arrow] the value. You can set the 
Funnel RF level to any value from 0 to 100 (200)*. Or, enter a value in the spin 
box text field. The mass spectrometer changes the Funnel RF level when you 
click Apply or with the Hot link check box being selected.
* The value in parentheses applies only to systems with a valid High Mass Range license.

NOTICE For stable ions, the default value, 50, provides a good starting point. By 
default, the Funnel RF level remains at 50 during all calibrations. ▲

Buttons

Source Auto-Defaults This parameter is not available for this ion source type.

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive HF-X Tune to send any 
changes immediately to the instrument. A green frame around the parameter box 
indicates an active hot link.

Parameter Description 
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Acquisition Window

Use the Acquisition window to enter parameters for acquiring and 
storing scan data as well as to monitor the progress of the active 
acquisition. See Figure 4-10.

The Acquisition window has the following parameters:

Figure 4-10. Acquisition window

Parameter Description

Acquisition state Displays the status of the current acquisition.

Progress Displays the elapsed time of the current acquisition.

File in use Displays the name of the raw file to be acquired to disk for the current sample. To 
display the file in Qual Browser, click the  button.

This value is up to date even when Q Exactive HF-X Tune is acquiring data under 
control of Xcalibur.

Destination file Displays the full path of the folder where your *.raw files will be saved. To change the 
path, type the full path (Drive:\path) in the text box or click the  button to the right 
of the text box to browse your directories and select the folder where your *.raw files 
should be saved.

NOTICE Saving raw files on network drives typically causes problems. Preferably select a 
local path (for example, C:\Xcalibur\data). ▲
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Method file Displays the name of the instrument method (*.meth) to be used during the current 
acquisition. The tune file used in that instrument method will be used for your scan but 
other devices configured in that instrument method will not be included. Type in the 
name of the instrument method, or click the  button to the right of the text box to 
browse your computer for an instrument method file (typically saved in 
C:\Xcalibur\methods).

When the active acquisition is controlled by the settings of the parameter Acquisitions 
time, this parameter is not available. Instead, the text field shows by time.

Sample Displays the name of the current sample. To change the sample name, type the new 
name in the text field. 

Comment Displays a comment on the current sample, if available. To change the comment, type 
the new name in the text field. 

Acquisition time Displays the duration of the acquisition time. Use the option buttons to select one of 
the following settings:
• Continuously

The acquisition, once it is started, will continue until you stop (Stop button) or 
pause (Pause button) it.

• Scans
Specify the number of scans for the current acquisition. You can set the number of 
scans to any value from 1 to 10000.
To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

• Minutes
Specify the time in minutes for the current acquisition. You can set the acquisition 
time from 0.01 to 15000.00 minutes.
To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

When the active acquisition is controlled by a method file, this parameter is not 
available. Instead, the text field shows by method.

On start Use the list box to set the start mode of the data acquisition. The options are as follows:
• don’t wait

Initiates acquisition of the raw file immediately when you click Start in the 
Acquisition window.

• wait for contact closure
When you click Start in the Acquisition window, the acquisition pauses. 
Q Exactive HF-X Tune initiates acquisition of the raw file either when it receives a 
contact closure signal (for example, from an analog autosampler) or when you click 
Resume.

Parameter Description
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❖ To display this window

Click the Acquisition window title bar in the Instrument Control 
window.

Mass Traces Window

Use the Mass Traces window to display mass traces for the total ion 
current and up to five m/z values in the Analysis Graphs window. See 
Figure 4-11. You can plot mass traces when manually adjusting source 
parameters like gas flows or spray voltage. You can also optimize 
collision energy/normalized collision energy or in-source CID energy.

After acquisition Use the list box to set the instrument mode after the data acquisition has stopped. The 
options are as follows:
• stay on

The instrument remains On when the current acquisition is completed.
• enter standby mode

Sets the instrument to Standby when the current acquisition is completed.
• switch off

Switches Off the instrument when the current acquisition is completed.
Buttons

Start / Stop Allows starting and stopping data acquisition. When no acquisition is in progress, 
Q Exactive HF-X Tune displays Start. When an acquisition is in progress, 
Q Exactive HF-X Tune displays Stop. To start an acquisition, click Start. To stop an 
acquisition, click Stop. To pause an acquisition, click the Pause / Resume button.

NOTICE No Q Exactive HF-X Tune controlled data acquisition is possible if the 
instrument is controlled by Xcalibur or Pathfinder. ▲

Pause / Resume Allows pausing and resuming an acquisition in progress. When no acquisition is in 
progress, the button is inactive (gray). When an acquisition is in progress, 
Q Exactive HF-X Tune displays Pause. When an acquisition is paused, 
Q Exactive HF-X Tune displays Resume. To pause an acquisition in progress, click 
Pause. To resume an acquisition that is paused, click Resume. To stop an acquisition in 
progress, click the Start / Stop button.

NOTICE The acquisition can be started by pressing Resume if the mass spectrometer is 
waiting for contact closure. ▲

Help Displays the Help for this window.

Parameter Description
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NOTICE Make sure to tune your instrument for both ion modes if you 
want to use a switching method! Settings for both polarity modes are 
saved in the same tune file! ▲

The Mass Traces window has the following parameters:

Figure 4-11. Mass Traces window

Parameter Description

Plot

TIC Select this check box to plot the total ion current.

Masses to plot Select a check box for each m/z value that you want to plot (up to five). When 
you select a check box, the spin box becomes active. The spin box displays the 
mass-to-charge ratio to plot. You can set the mass-to-charge ratio to any value 
from m/z 50 to m/z 6000 (m/z 8000)*.
* The value in parentheses applies only to systems with a valid High Mass Range license.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter a value in the spin box text field.

Scan CE Select this option button to optimize the collision energy on the total ion 
current.

Scan NCE Select this option button to optimize the normalized collision energy on the 
total ion current.
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Calibrate Window

Use the Calibrate window of the tasks panel to perform an automatic 
optimization of the calibration parameters. See Figure 4-12. Calibration 
parameters are instrument parameters whose values do not vary with the 
type of experiment.

Standard users can choose the ion mode they want to calibrate in the 
Calmix Calibration window. Advanced users can use the Calmix 
Calibration window to calibrate the instrument with the standard 
calibration solution (calmix). Or, they can use the Customized 
Calibration window to enter parameters for a calibration with a 
calibration solution of their choosing.

NOTICE If the system was in Off mode before, it is necessary to put the 
instrument into On mode for at least 90 minutes before a mass 
calibration is performed. ▲

The calibrating procedure requires that you introduce calibration 
solution into the mass spectrometer at a steady rate for several minutes 
(or longer). You can introduce the solution directly from the syringe 
pump. Refer to the Exactive Series Operating Manual for information.

Scan in-source CID energy Select this option button to optimize the in-source CID energy on the total ion 
current.

Just plot Select this option button to plot the mass trace without optimization.
Buttons

Start Click Start to start plotting the mass traces. The instrument needs to be in On 
status to start a plotting procedure.

When plotting is in progress, the Q Exactive HF-X Tune displays Stop.

Stop Click Stop to stop plotting the mass traces.

Help Displays the Help for this window.

Parameter Description

Figure 4-12. Calibrate window
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The Calibrate window has the following parameters:

❖ To display this window

Click  in the tasks panel.

Parameter Description

Progress bar Displays the elapsed percentage of the current 
calibration procedure.

Buttons

Calibrate Click Calibrate to start an automatic 
calibration of the mass spectrometer. The 
instrument needs to be in On status to start a 
calibration. The duration of the automatic 
calibration depends on the selected check 
boxes; a complete automatic calibration 
requires about four minutes.

When calibration is in progress, 
Q Exactive HF-X Tune displays Stop.

Stop Click Stop to stop a calibration in progress.

Help Displays the Help for this window.
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Calmix Calibration Window

Use the Calmix Calibration window to select parameters and ion modes 
when performing an automatic calibration with the standard calibration 
solution (calmix). See Figure 4-13 and Figure 4-14. The window 
displays the current statuses of the individual calibration items on the 
right side.

The Calmix Calibration window has the following parameters:

Figure 4-13. Calmix Calibration window (for standard users)

Figure 4-14. Calmix Calibration window (for advanced users)

Parameter Description

In a hierarchical list of items in a tree view, advanced users can select individual parameters that they want to 
calibrate. 
If the check box is not selected, no subentry is selected. If the check box is selected, all subentries are selected. 
If the check box is filled, some subentries are selected.

Base Calibration The Base Calibration item displays a hierarchical list of items in a tree view.

This parameter is not available for standard users.

Isolation Mass and Res. (pos)
Isolation Mass and Res. (neg)

Select this check box to perform an automatic calibration for isolation mass 
and resolution of the quadrupole in the respective ion mode.

Mass Calibration (pos) Select this check box to perform an automatic calibration for all calibration 
parameters in the positive ion mode.

Use the calibration solution for positive ion mode. Refer to the Exactive 
Series Operating Manual or the Q Exactive HF-X QuickStart Guide for 
information.
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Mass Calibration (neg) Select this check box to perform an automatic calibration for all calibration 
parameters in the negative ion mode.

Use the calibration solution for negative ion mode. Refer to the Exactive 
Series Operating Manual or the Q Exactive HF-X QuickStart Guide for 
information.

HMR Mode Calibration (pos)a Select this check box to perform automatic calibrations for the High Mass 
Range (HMR) in the positive ion mode. Running these calibrations is not 
possible when HMR mode is set to Off in the instrument status window.

Use a calibration solution of ammonium hexafluorophosphate (AHFP).

-HMR eFT Parameters (pos)a Select this check box to perform an automatic eFT calibration using the 
HMR mass list. 

This parameter is not available for standard users.

-HMR Mass Calibration (pos)a Select this check box to perform an automatic mass calibration using the 
HMR mass list. If necessary, the instrument changes the scan parameters 
used for this calibration.

a These calibrations are available only on systems with a valid High Mass Range license.

Parameter Description
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Customized Calibration Window

Use the Customized Calibration window to perform a mass calibration 
with a user-defined calibration solution. Enter the m/z values on which 
to calibrate. See Figure 4-15. This window is not available for standard 
users.

NOTICE Use this window for (positive and negative) mass calibration 
only! For all other calibration procedures, use the standard calibration 
solution (calmix)! ▲

Figure 4-15. Customized Calibration window
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The Customized Calibration window has the following parameters:

Evaluate Window

Use the Evaluate window of the tasks panel to perform an automatic 
check of the instrument calibration. See Figure 4-16.

To enable an evaluation, standard users must select at least one check 
box in the Calmix Evaluation window. Advanced users must select at 
least one check box either in the Calmix Evaluation window or in the 
Customized Evaluation window.

The evaluation procedure requires that you introduce calibration 
solution (calmix) into the mass spectrometer at a steady rate for several 
minutes (or longer). You can introduce the solution directly from the 
syringe pump. Refer to the Exactive Series Operating Manual for 
information.

Parameter Description

Masses to calibrate Select a check box for each m/z value that you 
want to plot (up to ten for each ion mode). 
When you select a check box, the spin box 
becomes active. The spin box displays the 
mass-to-charge ratio to plot. You can set the 
mass-to-charge ratio to any value from m/z 50 
to m/z 6000 (m/z 8000)*.
* The value in parentheses applies only to systems with a valid 

High Mass Range license.

To change this value, click the arrows in the 
spin box to increment [up arrow] or decrement 
[down arrow] the value. Or, enter a value in the 
spin box text field.

Figure 4-16. Evaluate window
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The Evaluate window has the following parameters:

Calmix Evaluation Window

Use the Calmix Evaluation window to enable the evaluation with the 
standard calibration solution (calmix). See Figure 4-17.

Parameter Description

Progress bar Displays the elapsed percentage of the 
current evaluation procedure.

Buttons

Evaluate Click Evaluate to start an automatic 
evaluation of calibration parameters. 
The instrument needs to be in On 
status to start an evaluation.

When evaluation is in progress, 
Q Exactive HF-X Tune displays Stop.

Stop Click Stop to stop an evaluation in 
progress.

Help Displays the Help for this window.

Figure 4-17. Calmix Evaluation window (for advanced users)



Explore Q Exactive HF-X Tune
Tasks Panel

4-48 Q Exactive HF-X Software Manual (P/N BRE0012262, Revision A) Thermo Scientific

The Calmix Evaluation window has the following parameters:

Parameter Description

In a hierarchical list of items in a tree view, you can select individual parameters that you want to evaluate. 
If the check box is not selected, no subentry is selected. If the check box is selected, all subentries are selected. 
If the check box is filled, some subentries are selected.
Positive Ion Evaluation 

Select the check boxes to evaluate various parameters for the positive ion mode.

-Base Evaluation (pos) Evaluates the basic performance of the instrument in positive ion 
mode.

-Isolation Evaluation (pos) Evaluates the performance of the quadrupole in positive ion mode.

--Iso Mass/Res. Eval. (pos) Evaluates the instrument performance for quadrupole isolation and 
resolution in positive ion mode.

This parameter is not available for standard users.

--Q Transmission Evaluation (pos) Evaluates the quadrupole transmission against minimum requirements 
in positive ion mode. This evaluation requires a calibrated quadrupole 
and a stable calmix spray.

This parameter is not available for standard users.

-Mass Check (pos) Evaluates the m/z accuracy of the Orbitrap analyzer in positive ion 
mode.

-HMR Mode Check (pos)a Evaluates the basic performance of the instrument in HMR mode.

--HMR Spectral Mass Accuracy Test 
(pos)a

Performs a mass accuracy test for the HMR mode.

This parameter is not available for standard users.
Negative Ion Evaluation

Select the check boxes to evaluate various parameters for the negative ion mode.

-Base Evaluation (neg) Evaluates the basic performance of the instrument in negative ion 
mode.

-Isolation Evaluation (neg) Evaluates the performance of the quadrupole in negative ion mode.

--Iso Mass/Res. Eval. (neg) Evaluates the instrument performance for quadrupole isolation and 
resolution in negative ion mode.

This parameter is not available for standard users.

--Q Transmission Evaluation (neg) Evaluates the quadrupole transmission against minimum requirements 
in negative ion mode. This evaluation requires a calibrated quadrupole 
and a stable calmix spray.

This parameter is not available for standard users.

-Mass Check (neg) Evaluates the m/z accuracy of the Orbitrap analyzer in negative ion 
mode.
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Extra Evaluation

Select the check boxes to evaluate various parameters that are not contained in the standard evaluations.

Electronics Evaluates the performance of electronic components.

-Quadrupole RF Frequency Checks the quadrupole RF voltage.

This parameter is not available for standard users.

-Inject Flatapole RF Checks the inject flatapole RF voltage.

This parameter is not available for standard users.

-Bent Flatapole RF Checks the bent flatapole RF voltage.

This parameter is not available for standard users.

-HCD RF Checks the RF voltage of the collision cell.

This parameter is not available for standard users.

Long-term Mass Accuracy Test Performs a mass accuracy test over an extended period.

This parameter is not available for standard users.

Isolation Transmission Endurance 
Test

Tests the behavior of the mass isolation optic elements under 
permanent ion load. The procedure requires a stable calmix signal with 
TIC > 5.0E+08; it will run for about 16 minutes.

This parameter is not available for standard users.
a These evaluations are available only on systems with a valid High Mass Range license.

Parameter Description
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Customized Evaluation Window

Use the Customized Evaluation window to enter the m/z values on 
which to evaluate by using a user-defined calibration solution. See 
Figure 4-15. This window is not available for standard users.

Figure 4-18. Customized Evaluation window
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The Customized Evaluation window has the following parameters:

❖ To display this window

Click  in the Tasks window.

Parameter Description

Masses to evaluate Select a check box for each m/z value that you 
want to plot (up to ten for each ion mode). 
When you select a check box, the spin box 
becomes active. The spin box displays the 
mass-to-charge ratio to plot. You can set the 
mass-to-charge ratio to any value from m/z 50 
to m/z 6000 (m/z 8000)*.
* The value in parentheses applies only to systems with a valid 

High Mass Range license.

To change this value, click the arrows in the 
spin box to increment [up arrow] or decrement 
[down arrow] the value. Or, enter a value in the 
spin box text field.

Duration The spin box displays the duration (in minutes) 
of the evaluation procedure. You can set the 
duration to any value from 0.2 to 
2160 minutes. The default duration is 
0.5 minutes.

To change this value, click the arrows in the 
spin box to increment [up arrow] or decrement 
[down arrow] the value. Or, enter a value in the 
spin box text field.
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Vacuum / Bakeout Window

The Vacuum / Bakeout window of the tasks panel reads back the 
pressure values at the vacuum gauges and allows performing an 
instrument bakeout. See Figure 4-19.

NOTICE After the bakeout time has expired, the instrument requires a 
cooling and stabilization time of about three hours. ▲

The Vacuum / Bakeout window has the following parameters:

Figure 4-19. Vacuum / Bakeout window

Parameter Description

Vacuum

Green LEDs indicate that the readback values are sufficient for operating the mass spectrometer. If an LED 
indicates a vacuum problem, use the instrument status window for error diagnosis.

Fore vacuum This readback displays the actual pressure (in mbar) in the forevacuum line 
and ion source region as read by the Pirani gauge.

High vacuum This readback displays the actual pressure (in mbar) in the high vacuum 
chamber as read by the ion gauge.

This parameter is visible only when the ion gauge in the high vacuum 
chamber is switched on. Advanced users can switch on this gauge by using the 
shortcut menu of the Vacuum System node of the instrument status window.

UHV This readback displays the actual pressure (in mbar) in the Orbitrap chamber 
as read by the ion gauge.
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❖ To display this window

Click  in the tasks 

panel.

Bakeout

Bakeout time Enter the desired baking duration (in hours) into the spin box. The range is 4 
to 30 hours. When you click Bake out, the mass spectrometer starts the 
baking routine.

The baking script is stopped after the preset duration. Click Stop to abort the 
baking routine.

NOTICE The instrument has to cool down for another three hours before it 
can be used. ▲

Enter standby after Bakeout Select the check box to set the instrument to standby mode after the bakeout 
procedure is finished.

Progress bar Displays the elapsed percentage of the current baking procedure.

Bake out Click Bake out to start the bakeout routine. To stop a bakeout in progress, 
click the Stop button.

NOTICE Bakeout is possible only when the instrument status is Off. ▲

Stop Click Stop to abort the bakeout routine. 

NOTICE The instrument has to cool down for another three hours before it 
can be used. ▲

Help Displays the Help for this window.

Parameter Description
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Display Panel
The windows in the display panel provide real-time information about 
the instrument status, the Q Exactive HF-X Tune software, or other 
programs.

The following windows are available:

• Spectrum Window

• Instrument Status Window

• Messages Window

• Analysis Graphs Window

• Debug Messages Window

The spectrum window is always visible. The debug messages window is 
not available for standard users.

Depending on the individual configuration of your system, additional 
windows may allow controlling other installed instruments (Accela™ AS 
or Accela Pump, for example.)

Q Exactive HF-X Tune offers various ways to arrange windows in the 
display panel:

❖ To display a window in the display panel

Choose the respective command in the Windows menu.

❖ To hide a window in the display panel

• Choose the respective command in the Windows menu.

• Right-click the title bar of a window to display the shortcut menu. 
Choose Hide.

❖ To change the position of a window in the display panel

• Use the mouse to drag the window by its title bar to the new 
location, which can be even outside the Q Exactive HF-X Tune 
window.

• Within the display panel, you can dock the window to any one of 
the four sides. While you drag the window, Q Exactive HF-X Tune 
displays icons to indicate the available docking positions.

• Right-click the title bar of a docked window to display the shortcut 
menu. Choose Floating to undock the window. 

Or, double-click on the title bar of the window.
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• Right-click the title bar of an undocked window to display the 
shortcut menu. Choose Floating to dock the window to its last 
docking position.

Or, double-click the title bar of the window.

Spectrum Window

The spectrum window displays real-time data generated during 
calibration, tuning, and diagnostic tests. See Figure 4-20. The spectrum 
window is always visible.

The spectrum window allows using the mouse for zooming.

❖ To zoom in or out on a spectrum

• Click and drag with the left mouse button (hand cursor) from 
the beginning to the end of the portion you want to see 
enlarged.

• Or, use the mouse wheel for zooming. Position the mouse 
pointer within the spectrum and roll the wheel forward to zoom 
in on the spectrum area. 

• To zoom in on the spectrum with respect to one axis only, 
position the mouse pointer within the axis area and roll the 
mouse wheel forward. Roll the wheel backward to zoom out.

Figure 4-20. Spectrum window
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• To increase the zooming factor by two, keep the <Shift> key 
pressed while using the mouse wheel.

To return to a display of the full spectrum, click the  button in 
the toolbar or choose Unzoom in the shortcut menu.

Press the <Shift> key to enable mouse panning. When mouse panning 
is active (mouse pointer changes to hand cursor), you can shift the 
spectrum along the X-axis while keeping the left mouse button pressed.

The spectrum window has the following parameters:

❖ To display this window

Choose Windows > Spectrum.

Toolbar

Use the buttons in the toolbar to manipulate the spectrum display.

Parameter Description 

Header

Scan # The number of scans since the beginning of the 
last acquisition (or since the last time the mass 
spectrometer was rebooted)

μS Number of microscans

IT Inject time (in milliseconds)

NL Normalization level

Type Scan type

The scan type information comprises ion 
polarity, source type, fragmentation type and 
energy (if active), and scan range. When the 
acquisition is controlled by an instrument 
method, the information includes the current 
scan segment and the current scan event.
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The toolbar of the spectrum window has the following parameters:

Parameter Description

Click to copy the current spectrum into the clipboard.

Click to plot the current spectrum.

You can view a print preview before the spectrum is 
printed. In a Page Setup dialog box, you can set up 
printer’s parameters (paper size and orientation, for 
example). 

Click to zoom in on the Y-axis (factor 2).

Click to zoom out on the Y-axis (factor 2).

Click to normalize the Y scale: Q Exactive HF-X Tune 
always displays the largest peak in the spectrum at full 
scale (vertical scale = largest peak in spectrum).

Click to zoom in on the X-axis (factor 2).

Click to zoom out on the X-axis (factor 2).

Click to display the entire mass range.

Click to normalize the display (X-axis, Y-axis).

Click to set to fixed mode: the height of the Y-axis is set 
equal to the height of the largest peak in the current 
spectrum and remains fixed even if larger peaks occur.

Click to set the Y-axis to the height of the highest peak so 
that the largest peak in the spectrum is always displayed 
at full scale.

Click to set to creep mode: the Y scale of the mass 
spectrum automatically increases if the peak intensity 
increases, but does not decrease if the peak intensity 
decreases.

Click to toggle between mouse panning and mouse 
zooming:
• When mouse panning is active, you can shift the 

spectrum along the X-axis while keeping the left 
mouse button pressed (hand cursor). 

• When mouse zooming is active, you can zoom in the 
spectrum by using the mouse.
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Shortcut Menu

Right-click the spectrum window to display the shortcut menu. It has 
the following commands:

Instrument Status Window

The instrument status window displays real-time status information for 
the instrument components. All parameters are arranged in a tree view. 
See Figure 4-21. The Control node and the System node are not 
available for standard users.

In addition to showing numerical values of parameters, the instrument 
status window uses icons to indicate the statuses of system components. 
Thus, you can use the instrument status window for a quick error 
diagnosis.

Command Description 

Save Image As Saves the current graph as image file. A Save As 
dialog opens and you can enter the file name, 
file type, and the directory. 

Unzoom Reverts the zoom action.

Display options Opens the Display Options dialog box.

Figure 4-21. Instrument status window
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When expanded, some nodes provide shortcut menus that are displayed 
when you right-click an item. The available commands depend on the 
selected node and the user privileges. Generally, the shortcut menus 
allow changing the current settings.

NOTICE For normal operation, it is not necessary to change the settings 
in the instrument status window. It just allows monitoring the system in 
more detail (more readbacks etc.) than the other windows. ▲

❖ To display this window

Choose Windows > Instrument Status.

Messages Window

The messages window displays real-time information about the statuses 
of the instrument, the control service, or other programs. For further 
analysis, you can copy the content of the messages window to a text 
editor.

❖ To copy content from the messages window to a text editor

1. Select part of the content with the mouse, or
press <Ctrl> + <A> to select the complete content of the messages 
window.

2. Press <Ctrl> + <C> to copy the text to the clipboard.

3. Open a document in the text editor.

4. Press <Ctrl> + <V> to insert the copied text into the document.

The messages window has the following parameters:

Parameter Description

The messages are sorted with respect to time. To change the sort order, 
click the respective table column header. To invert the sort order, click 
again.

Priority The message priority is indicated by symbols:

Info; status is normal / command successful

Warning; no user action required

Error; user action required

Fatal error; program cannot proceed

Source The message source is indicated by symbols:
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❖ To display this window

Choose Windows > Messages.

Analysis Graphs Window

The analysis graphs window displays real-time data generated during 
calibration, tuning, and diagnostic tests. See Figure 4-22. To save data 
displayed in the window, choose Save Image As in the shortcut menu of 
the window.

The analysis graphs window allows using the mouse for zooming.

❖ To zoom in or out on an analysis graph

• Click and drag with the left mouse button (hand cursor) from 
the beginning to the end of the portion you want to see 
enlarged.

• Or, use the mouse wheel for zooming. Position the mouse 
pointer within the graph and roll the wheel forward to zoom in 
on the graph area.

Message from Q Exactive HF-X Tune program

Message from instrument

Message from service

Time Time and date of the message

Description Displays the message text.

Parameter Description

Figure 4-22. Analysis Graphs window
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• To zoom in on the graph with respect to one axis only, position 
the mouse pointer within the axis area and roll the mouse wheel 
forward. Roll the wheel backward to zoom out.

• To increase the zooming factor by two, keep the <Shift> key 
pressed while using the mouse wheel.

To return to a display of the full spectrum, click the  button in 
the toolbar or choose Unzoom in the shortcut menu.

Press the <Shift> key to enable mouse panning. When mouse panning 
is active (mouse pointer changes to hand cursor), you can shift the graph 
along both axes while keeping the left mouse button pressed.

❖ To display this window

Choose Windows > Analysis Graphs.

Toolbar

The toolbar of the analysis graphs window has the following parameters:

Shortcut Menu

Right-clicking on the analysis graphs window displays the shortcut 
menu. It has the following commands:

Parameter Description

Click to copy the current graph into the clipboard.

Click to plot the current graph.

You can view a print preview before the graph is printed. 
In a Page Setup dialog box, you can set up printer’s 
parameters (paper size and orientation, for example). 

Click to normalize the display (X-axis, Y-axis).

Command Description 

Save Image As Saves the current graph as image file. A Save As 
dialog opens and you can enter the file name, 
file type, and the directory.

Unzoom Reverts the zoom action.
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Debug Messages Window

The debug messages window displays messages that can be used during 
method development. The debug messages window is not available for 
standard users. For further analysis, you can copy the content of the 
debug messages window to a text editor.

❖ To copy content from the debug messages window to a text editor

1. Select part of the content with the mouse, or
press <Ctrl> + <A> to select the complete content of the messages 
window.

2. Press <Ctrl> + <C> to copy the text to the clipboard.

3. Open a document in the text editor.

4. Press <Ctrl> + <V> to insert the copied text into the document.

The debug messages window has the following parameters:

❖ To display this window

Choose Windows > Debug Messages.

Parameter Description

The messages are sorted with respect to time. To change the sort order, 
click the respective table column header. To invert the sort order, click 
again.

Priority The message priority is indicated by symbols:

Debugging message

Info; status is normal / command successful

Warning; no user action required

Error; user action required
 Fatal error; program cannot proceed

Source The message source is indicated by symbols:

Message from Q Exactive HF-X Tune program.

Message from instrument.

Message from service.

Time Time and date of the message

Description Displays the message text.
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Shortcut Menu of the Debug Messages Window

The debug messages window has a shortcut menu that is displayed when 
you right-click into the window. Use the commands of the shortcut 
menu to configure the scope of the messages displayed in the window. 
Click a command to activate it; click it again to deactivate it.

The following message priorities can be displayed:

• Debug

• Log

• Info

• Warning

• Error

• Fatal

For each message priority, the following message sources are available:

• Instrument

• Service

• Application

A  icon in front of a message source shows that it is selected. A  
icon in front of a message priority shows that it is shown for all three 
message sources. A  icon in front of a message priority shows that it 
is shown for one or two message sources.

In addition to the commands for configuring the content of the debug 
messages window, the Clear list command allows removing the 
complete content of the window.
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Dialog Boxes
This section provides a reference to the dialog boxes in 
Q Exactive HF-X Tune.

Dialog Boxes Displayed from the Menu Bar

• About Dialog Box

• License Dialog Box

• Mass Calculator

Dialog Boxes Displayed from the Toolbar

• Syringe Pump Settings Dialog Box

Dialog Boxes Displayed from the Scan Parameters Window

• Fragmentation Dialog Box

• Scan Parameters History Dialog Box

• Scan Range Dialog Box

• Scan Type Dialog Box

Dialog Boxes for Editing Lock Masses

• Collection Modification Dialog Box

• Delete Lock Mass Collection Dialog Box

• Lock Masses Dialog Box

• Lock Mass Removal Dialog Box

• Lock Mass Replacement Dialog Box

• Name Change Dialog Box

• New Lock Mass Collection Dialog Box

Dialog Boxes Displayed from the Spectrum Window

• Display Options Dialog Box
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About Dialog Box

Use the About dialog box to display information about the instrument, 
the current Q Exactive HF-X Tune version, and the active licenses. To 
copy the instrument identification to the clipboard, click the  button.

The About dialog box has the following parameters:

❖ To display this dialog box

Choose Help > About.

Autoselect Ion Source Values Dialog Box

Use the Autoselect ion source values dialog box to automatically apply 
suitable parameters for a HESI ion source or APCI ion source in 
dependence on a LC flow rate. See Figure 4-24.

See “Default Parameters and Ranges for HESI-2 and APCI” on page 6-6 
for a list of the involved parameters and their values.

Parameter Description

Buttons

OK Saves your changes and closes the dialog box.

Add license Displays the License dialog box.

Back / Next Display various dialog boxes with legal 
information and information about third party 
licenses used by Q Exactive HF-X Tune.

Help Displays the Help for this dialog box.

Figure 4-23. Autoselect ion source values dialog box
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The Autoselect ion source values dialog box has the following 
parameters:

❖ To display this dialog box

On the HESI source window or the APCI source window, click 
Source Auto-Defaults.

License Dialog Box

Use the License dialog box to enter licenses that activate additional 
features. See Figure 4-24.

Parameter Description

LC Flow rate (μl/min) Use this spin box to specify the volume of 
solvent solution passing through the liquid 
chromatography system per unit time (in 
microliters per minute).

To change this value, click the arrows in the 
spin box to increment [up arrow] or 
decrement [down arrow] the value. Or, enter 
a value in the spin box text field. The 
acceptable range of values is 0 to 2000.

Buttons

Apply Auto-Defaults Applies suitable values for the following 
source parameters:
• Capillary temperature
• Vaporizer temperature
• Sheath gas flow
• Auxiliary gas flow
• Sweep gas flow
• Spray voltage (for HESI)
• Discharge Current (for APCI)

Figure 4-24. License dialog box
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The License dialog box has the following parameters:

❖ To display this dialog box

1. Choose Help > About to display the About dialog box.

2. In the About dialog box, click Add license.

Mass Calculator

Use the Mass Calculator to calculate the exact mass of an compound of 
interest.

The Mass Calculator has the following parameters:

Parameter Description

License key Use the text box to enter the license key.
Buttons

OK Saves your changes and closes the dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.

Figure 4-25. Mass Calculator (Tune)

Parameter Description

Compound

Formula Use the text field to specify the basic composition of the compound. Click the 
down arrow to display a list of the last entered compounds.

The syntax rules and interpretation accept the kind of formula that is also 
accepted on the Spectrum Simulation page (Isotope Simulation area) of the 
Qual Browser.
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Type Use the Type list to specify the formula type used in the Formula field:
• Chemical formula Formula is defined as the resulting elemental 

composition of the entered formula. This is the default selection.
• Peptide Formula is defined as the sum of all of the entered amino acids 

additionally terminated with H at the N-terminus and OH at the 
C-terminus.

• Amino Acid Formula is defined as the sum of all of the entered amino acids.

Independent of the entry in the Species field, the elemental composition and the 
mass of the compound, Formula is completely determined by the given formula 
and selected formula type.

Species Use this text field to define adducts or modifications of the active compound 
that are expected to be formed.

The Species field can be used in two ways:

• Click the down arrow to display a list of predefined adducts for each 
polarity:

- +H, +Na, +K, +NH4 for positive polarity

- -H, +Cl, +OH, +HCOO for negative polarity

- an empty entry to express adducts (for example, radical cations) for both 
polarities.

The corresponding set will be displayed depending on the selected polarity. 

Selecting an adduct (A) will result in the strict behavior of applying one unit 
A to the compound and using “+H” or “-H” adduct depending on the 
charge state and active polarity.

“+K” = [M + K+ + (z-1)H+]z+; for example, MRFA, +K, CS=2, positive pol. 
= [M + K+ + H+]2+

• Enter the modifications of the compound by using squared brackets and at 
least M as representation of the basic compound (for example, [M + Na + K] 
or [2M + Na]). The predefined adducts can be entered, too. This definition 
is used without additional auto dependencies, like adding protons. 

Charge state Use the list box to select the resulting charge state. Available options are 1+ to 
100+ for positive polarity and 1– to 100– for negative polarity. The default 
charge state is 1+ for positive polarity and 1– for negative polarity.

Polarity Use the option buttons to select the applied polarity. The default polarity is 
positive.

m/z This text field displays the calculated mass-to-charge ratio, with five decimal 
places (for example, 524.26496).

Composition This text field displays the determined total formula (for example, C23 H38 N7 
O5 S).

Parameter Description
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❖ To display the Mass Calculator

Choose Windows > Mass Calculator.

Syringe Pump Settings Dialog Box

Use the Syringe Pump Settings dialog box to specify parameters of the 
syringe and the syringe pump. See Figure 4-26. Additionally, use the 
dialog box to manually operate the syringe pump.

NOTICE Advanced users can select the syringe pump type and enter 
parameters for the syringe pump in the instrument status window. ▲

The Syringe Pump Settings dialog box has the following parameters:

Figure 4-26. Syringe Pump Settings dialog box

Parameter Description

Syringe type Use this list box to specify the syringe type (Hamilton, Unimetrics, or 
Other). If you select Hamilton or Unimetrics, you must specify the volume 
of the syringe in the Volume list box. If you select Other, you must specify 
the inside diameter of the syringe in the Syringe inner diameter spin box.

Volume (μL) Use this list box to specify the syringe volume for Hamilton and Unimetrics 
syringes. The acceptable values depend on the syringe type:
• Hamilton:

0.5, 1, 2, 5, 10, 25, 50, 100, 250, and 500 μL.
• Unimetrics:

10, 25, 50, 100, 250, 500, 1000, 2500, 5000, 10000, 25000, and 
50000 μL.

Syringe inner diameter (mm) Use this spin box to specify the inside diameter for syringes other than 
Hamilton and Unimetrics syringes. The acceptable range of values is 0.1 to 
35 mm.

To change this value, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. Or, enter a value in the spin 
box text field.
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❖ To display this dialog box

In the toolbar, right-click the  symbol.

Scan Parameters History Dialog Box

Use the Scan Parameters History dialog box to select from a list of recent 
scans based on short scan descriptions. See Figure 4-27. Select a scan 
from the list to populate all scan parameters in the Scan Parameters 
window with the parameters from that scan.

Flow rate (μL/min) Use this spin box to specify the volume of solvent solution passing through 
the syringe pump per unit time (in microliters per minute). The acceptable 
range of values depends on the selected syringe volume or syringe inner 
diameter.

To change this value, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. Or, enter a value in the spin 
box text field.

Buttons

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Manual Control Sets the syringe pump to manual control. Use the buttons on the syringe 
pump to switch it on and off. When the syringe pump is under manual 

control, Q Exactive HF-X Tune displays .

Start Switches on the syringe pump. When the syringe pump is On, 

Q Exactive HF-X Tune displays .

Stop Switches off the syringe pump. When the syringe pump is Off, 

Q Exactive HF-X Tune displays .

Parameter Description



Explore Q Exactive HF-X Tune
Dialog Boxes

Thermo Scientific Q Exactive HF-X Software Manual (P/N BRE0012262, Revision A) 4-71

If the Hot link check box is selected in the Scan Parameters window, 
selecting another list item immediately changes the instrument 
parameters.

❖ To display this dialog box

In the Scan Parameters window, click the History field.

Scan Type Dialog Box

Use the Scan Type dialog box to select the scan type to be used during 
the currently selected scan event. See Figure 4-28.

Figure 4-27. Scan Parameters History dialog box

Figure 4-28. Tune—Scan Type dialog box
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The Scan Type dialog box has the following parameters:

Parameter Description

Full MS - SIM Select this option to enable a Full MS scan (isolation width > 10 amu) or a selected 
ion monitoring (isolation width 10 amu) scan type.

AIF - MS/MS Select this option to enable All Ion Fragmentation (isolation width > 10 amu) or 
the MS/MS scan type (isolation width  10 amu). When you select this option, the 
Isolation area becomes available.

When you select this option, Q Exactive HF-X Tune automatically selects the 
NCE check box in the Fragmentation dialog box.

Isolation

Use the Isolation area to set the scan range of the selected scan type.

Minimum Use this spin box to select the minimum value for the scan range (in mass-to-charge 
ratio units) used during the currently selected scan event.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. You can enter any value from 50.0 to 2500 
(7950.0)a.

Maximum Use this spin box to select the maximum value for the scan range (in mass-to-charge 
ratio units) used during the currently selected scan event.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. You can enter any value from 50.4 to 6000.0 
(100.0 to 8000.0)a.

Center Use this spin box to select the center mass (in mass-to-charge ratio units) of the 
scan range.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. You can enter any value from 50.2 to 4250.0 
(75.0 to 7975.0)a.

Precursor Use this spin box to select the mass of a precursor ion of interest.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. You can enter any value from m/z 50.2 to 4000 
(75.0 to 7975.0)a.

Width Use this spin box to select either the width of the scan range (in mass-to-charge 
ratio units) used for a SIM scan or the isolation width for the precursor ion of 
interest during an MS/MS scan.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. 

For Full MS scans and AIF scans, you can enter any value from m/z 0.4 to 5600.0 
(50.0 to 7950.0)a. For SIM and MS/MS scans, you can enter any value from 
m/z 0.4 to 10.

a The values in parentheses apply only to systems with a valid High Mass Range license.
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❖ To display this dialog box

In the Scan Parameters window, click the Scan type field.

Scan Range Dialog Box

Use the Scan range dialog box to specify the scan range of the data 
acquisition. See Figure 4-29. The scan range affects the amount of 
stored and transmitted data.

The Scan Range dialog box allows setting either minimum and 
maximum or center and width of the scan range. If you change one pair 
of values, the other pair is changed accordingly. 

NOTICE The ratio for maximum-to-minimum should not exceed 15. If 
necessary, Q Exactive HF-X Tune will correct the settings automatically. 
This rule does not apply to systems with a valid High Mass Range 
license. ▲

Figure 4-29. Scan range dialog box



Explore Q Exactive HF-X Tune
Dialog Boxes

4-74 Q Exactive HF-X Software Manual (P/N BRE0012262, Revision A) Thermo Scientific

The Scan range dialog box has the following parameters:

❖ To display this dialog box

In the Scan Parameters window, click the Scan range field.

Parameter Description

Minimum Use this spin box to select the minimum value for the 
scan range (in mass-to-charge ratio units) used during 
the currently selected scan event.

To change the value, click the arrows in the spin box 
to increment [up arrow] or decrement [down arrow] 
the value. You can enter any value from 50.0 to 
2500.0.

Maximum Use this spin box to select the maximum value for the 
scan range (in mass-to-charge ratio units) used during 
the currently selected scan event.

To change the value, click the arrows in the spin box 
to increment [up arrow] or decrement [down arrow] 
the value. You can enter any value from 50.4 to 
6000.0 (100.0 to 8000.0)a.

a The values in parentheses apply only to systems with a valid High Mass Range license.

Center Use this spin box to select the center mass (in 
mass-to-charge ratio units) of the scan range.

To change the value, click the arrows in the spin box 
to increment [up arrow] or decrement [down arrow] 
the value. You can enter any value from 50.2 to 
4250.0 (75.0 to 7975.0)a.

Width Use this spin box to select the width of the scan range 
(in mass-to-charge ratio units) used during the 
currently selected scan event.

To change the value, click the arrows in the spin box 
to increment [up arrow] or decrement [down arrow] 
the value. You can enter any value from 0.4 to 5600.0 
(50.0 to 7950.0)a.
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Fragmentation Dialog Box

Use the Fragmentation dialog box to activate a fragmentation with 
in-source CID or the HCD collision cell. You can specify the 
fragmentation voltages to be used. See Figure 4-30.

The Fragmentation dialog box has the following parameters:

Figure 4-30. Tune—Fragmentation dialog box

Parameter Description

In-source CID Activates the in-source CID.

To change the CID collision energy, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the CID collision energy to any 
value from 0.1 to 100 eV.*
* On instruments with a valid High Mass Range license, a maximum CID collision energy of 150 eV is possible, with an 

installed NSI source even 200 eV.

NOTICE Automatic tuning is disabled when in-source CID fragmentation is on. To use 
automatic tuning, clear this check box. ▲

HCD

Activates the HCD collision cell. When you select this check box, Q Exactive HF-X Tune automatically 
changes the scan type, if necessary.

NOTICE When HCD fragmentation is on, automatic tuning comprises only HCD relevant parameters. ▲
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❖ To display this dialog box

In the Scan Parameters window, click into the Fragmentation field.

Collection Modification Dialog Box

Use this dialog box to modify a lock mass collection by importing lock 
masses from an xml file See Figure 4-33. This dialog box appears only 
when the xml file contains information about lock mass collections that 
differs from the available lock mass collections.

NCE / CE Use the option buttons to specify whether to use normalized collision energy (NCE) or 
collision energy (CE) for HCD fragmentation. Thus, you can apply the same absolute 
HCD collision energy for internal standards (ISTDs) and the corresponding analytes. 

NCE is a dimensionless number that is approximately equivalent to the HCD collision 
energy (in eV) for a reference ion of mass 500 and charge 1. The actual HCD energy is 
calculated on basis of mass and charge of the selected precursor ion.

To change the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can enter any value from 10 to 200.

Charge Enter the charge state of the ion to be fragmented. The available range is 1 to 5. The 
required collision energy for fragmenting an ion depends on its charge state. The higher 
the charge state, the lower the required collision energy. The algorithm for calculating the 
absolute collision energy is based on empirical data taken from measurements on peptides. 
For example, the required absolute collision energy to fragment a [M+2H]2+ ion is about 
90 percent of that of the corresponding [M+H]+ ion. For a [M+3H]3+ ion, the value 
decreases to 85 percent.

The spin box is active only if the HCD check box is selected.

Parameter Description

Figure 4-31. Collection Modification dialog box
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The Collection Modification dialog box has the following parameters:

❖ To display this dialog box

1. Choose Import > Merge with file content in the shortcut menu of 
the Lock Masses dialog box.

2. In the file selection dialog box, select an xml file to import from.

Lock Masses Dialog Box

Use the Lock Masses dialog box to edit lock mass lists. See Figure 4-32. 
The table shows all available lock masses. Lock mass collections store 
information about lock mass usage.

The Lock Masses dialog box has the following parameters:

Parameter Description

OK Saves your changes and closes the dialog box. The lock 
mass collection is updated with the data contained in the 
xml file.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.

Figure 4-32. Tune—Lock Masses dialog box

Parameter Description

Lock mass lists

Lock mass lists Use the list box to select an existing lock mass collection.
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❖ To display this dialog box

In the Scan Parameters window, click into the Lock Masses field.

Shortcut Menu of the Lock Masses dialog box

The Lock Masses dialog box has a shortcut menu that is displayed when 
you right-click into the dialog box. 

Displays the New Lock Mass Collection dialog box where you can enter the 
name for a new lock mass collection.

Deletes the active lock mass collection. The lock masses themselves are still 
available.

This button is not available when no lock mass collection is selected.

Displays the Name Change dialog box where you can edit the name of the active 
lock mass collection.

This button is not available when no lock mass collection is selected.
Available lock masses

The table displays the properties of the available lock masses and whether they are used in the 
selected lock mass collection. To change the sort order, click the respective table column header. To 
invert the sort order, click again.

Lock mass table • Use
Select the check box to use the lock mass. A  indicates that the lock mass 
is used in the active lock mass collection. The lock mass is displayed in the 
Lock masses field of the Scan Parameters window.

• Polarity
Click the symbol to change the polarity of the lock mass.

NOTICE During a scan, the Q Exactive HF-X mass spectrometer uses only the 
lock masses with a polarity that matches the active ion mode. ▲

• m/z
Enter the mass of the lock mass into the field (with a maximum of five 
decimals).

• Comment
Enter a comment for the lock mass into the field. This field is optional.

Creates a new lock mass.

Deletes the selected lock masses.

Parameter Description
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It has the following commands:

Command Description 

Select all masses in use Selects all masses used in the active lock mass collection.

This command is not available when no lock mass is used.

Import > Merge with clipboard Appends the content of the clipboard to the available lock masses.

NOTICE The clipboard stores lock mass data as tabulator-separated text 
files. When the data in the clipboard are not in this format, the 
command is not available. ▲

Import > Replace by clipboard Replaces the available lock masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text 
files. When the data in the clipboard are not in this format, the 
command is not available. ▲

Import > Merge with file content Opens a dialog box so that you can select a .csv, .txt, or .xml file that 
contains a list of lock masses. The content of the file is appended to the 
available lock masses.

See Exporting and Importing Lock Masses for information about the 
format of lock mass files.

Import > Replace by file content Opens a dialog box so that you can select a .csv, .txt, or .xml file that 
contains a list of lock masses. All available lock masses are replaced by 
the masses contained in the imported file. The present lock masses are 
removed from all existing lock mass lists. You have to confirm your 
action in the Lock mass replacement dialog box.

See Exporting and Importing Lock Masses for information about the 
format of lock mass files.

Export > Copy selected to clipboard Copies the data of the selected lock mass to the clipboard.

Export > Copy all to clipboard Copies the data of all available lock masses to the clipboard.

Export > Copy selected to file Opens the dialog box, where you can save the data of the selected lock 
mass(es) as a .csv, .txt, or .xml file.

See Exporting and Importing Lock Masses for information about the 
format of lock mass files.

Export > Copy all to file Opens the dialog box, where you can save the data of all available lock 
masses as a .csv, .txt, or .xml file.

See Exporting and Importing Lock Masses for information about the 
format of lock mass files.
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Lock Mass Removal Dialog Box

Use this dialog box to delete one or more lock masses that are selected in 
the Lock Masses dialog box. See Figure 4-33.

The Lock Mass Removal dialog box has the following parameters:

❖ To display this dialog box

In the Lock Masses dialog box, click the  button.

Lock Mass Replacement Dialog Box

Use this dialog box to replace all available lock masses by masses 
contained either in a csv, txt, or xml file or in the clipboard. See 
Figure 4-33.

Figure 4-33. Lock Mass Removal dialog box

Parameter Description

OK Saves your changes and closes the dialog box. The lock 
masses are now removed from the table in the Lock 
Masses dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.

Figure 4-34. Lock Mass Replacement dialog box
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The Lock Mass Replacement dialog box has the following parameters:

❖ To display this dialog box

Choose Import > Replace by file content or Import > Replace by 
clipboard in the shortcut menu of the Lock Masses dialog box.

New Lock Mass Collection Dialog Box

Use this dialog box to enter a name for the lock mass collection that is 
displayed in the Lock Masses dialog box. See Figure 4-35.

The New Lock Mass Collection dialog box has the following 
parameters:

Parameter Description

OK Removes the lock masses and replaces them by the 
imported lock masses. The present lock mass collections 
become void.

Cancel Closes the dialog box.

Help Displays the Help for this dialog box.

Figure 4-35. New Lock Mass Collection dialog box

Parameter Description

Name of lock mass 
collection

Use this text field to enter the name for the new 
lock mass collection.

Buttons

OK Saves your changes and closes the dialog box. 
The name of the lock mass collection is now 
displayed in the list box of the Lock Masses 
dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.
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❖ To display this dialog box

In the Lock Masses dialog box, click the  button.

Delete Lock Mass Collection Dialog Box

Use this dialog box to delete an existing lock mass collection. See 
Figure 4-36. The lock masses themselves are not deleted.

The Delete Lock Mass Collection dialog box has the following 
parameters:

❖ To display this dialog box

In the Lock Masses dialog box, click the  button.

Figure 4-36. Delete Lock Mass Collection dialog box

Parameter Description

OK Saves your changes and closes the dialog box. The name 
of the lock mass collection is now removed from the list 
box of the Lock Masses dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.
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Name Change Dialog Box

Use this dialog box to change the name of an existing lock mass 
collection. See Figure 4-37.

The Name Change dialog box has the following parameters:

❖ To display this dialog box

In the Lock Masses dialog box, click the  button.

Figure 4-37. Name Change Dialog Box

Parameter Description

Name of lock mass 
collection

Use this text field to enter the new name for the 
lock mass collection.

Buttons

OK Saves your changes and closes the dialog box. 
The name of the lock mass collection is now 
displayed in the list box of the Lock Masses 
dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.
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Display Options Dialog Box

Use this dialog box to modify the appearance of the displayed mass 
spectrum in the spectrum window. See Figure 4-38.

The Display Options dialog box has the following parameters:

❖ To display this dialog box

In the shortcut menu of the spectrum window, choose Display 
options.

Figure 4-38. Display Options Dialog Box

Parameter Description

Decimal places for m/z Use this list box to set how many decimal 
places of precision are shown when mass 
positions are annotated on mass spectra. The 
valid range is 0 to 5.

Show resolution Select this check box to have 
Q Exactive HF-X Tune annotate mass peaks 
with the mass resolution. 

Show charge state Select this check box to have 
Q Exactive HF-X Tune annotate mass peaks 
with the charge state. 

Show flags Select this check box to have 
Q Exactive HF-X Tune indicate peaks that 
are contained in the active lock mass 
collection.

NOTICE The scan parameters window must 
show entries for lock masses. ▲

Buttons

OK Saves your changes and closes the dialog box.

Help Displays the Help for this dialog box.
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Chapter 5 Procedures in Q Exactive HF-X Tune

This chapter describes procedures that you may need when using 
Q Exactive HF-X Tune.

Contents

• Adding a License

• Using Lock Masses and Lock Mass Collections

• Performing a System Bakeout

• Changing Default Settings of Q Exactive HF-X Tune

• Using License-Specific Settings in Q Exactive HF-X Tune
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Adding a License
Use the License dialog box to enter licenses that activate additional 
features. 

❖ To add a license

1. Copy the license key that you received from Thermo Fisher 
Scientific to the clipboard.

2. In Q Exactive HF-X Tune, choose Help > About to display the 
About dialog box.

3. In the About dialog box, click Add license to display the License 
dialog box.

4. Paste the license code from the clipboard into the text field.

5. Click OK to save your input and close the License dialog box.

The About dialog box now displays the expiration date of the new 
license.
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Using Lock Masses and Lock Mass Collections
This section provides instructions for using lock masses and lock mass 
collections.

 The following topics are available:

• Adding a Lock Mass

• Deleting Lock Masses

• Exporting and Importing Lock Masses

• Creating a new Lock Mass Collection

• Renaming a Lock Mass Collection

• Adding a Lock Mass to a Lock Mass Collection

• Removing a Lock Mass from a Lock Mass Collection

• Deleting a Lock Mass Collection

Adding a Lock Mass

❖ To add a lock mass

1. In the Lock Masses dialog box, click the  button. A new row 
appears at the end of the lock mass table. See Figure 5-1.

2. Enter the data for the new lock mass into the new table row:

a. Select the Use check box if you want to use the new lock mass in 
the active lock mass collection.

Figure 5-1. Adding a new lock mass



Procedures in Q Exactive HF-X Tune
Using Lock Masses and Lock Mass Collections

5-4 Q Exactive HF-X Software Manual (P/N BRE0012262, Revision A) Thermo Scientific

b. Click the cell in the Polarity column until the correct sign 
appears:  for positive or  for negative.

c. Enter the m/z value for the new lock mass (with a maximum of 
five decimals).

d. Optionally, enter a comment for the new lock mass.

The new lock mass is now available to be used.

Deleting Lock Masses

❖ To delete lock masses

1. In the Lock Masses dialog box, select one lock mass or several lock 
masses:

• To select a single lock mass, click into the respective table row.

• To select adjacent lock masses, click the first table row. Then 
hold down the <Shift> key while you click the last row.

• To select nonadjacent lock masses, click the first table row. Then 
hold down the <Ctrl> key while you click the other rows that 
you want to add to the selection.

2. Click the  button. The Lock Mass Removal dialog box appears 
and requests your confirmation for deleting the listed lock masses.

3. Click OK to confirm your input and to close the dialog box. All 
selected lock masses are removed from the list in the Lock Masses 
dialog box.

Exporting and Importing Lock Masses

Q Exactive HF-X Tune allows exporting lock mass data to the clipboard 
or to a file. Other applications can then use the data. You can also copy 
the export files to other computers where Q Exactive HF-X Tune is 
installed. So you can reuse the lock masses without having to recreate 
them. To reuse the lock masses, import the data either from the 
clipboard or from a lock mass file.

With a spreadsheet, a text editor, or an XML editor, you can create lock 
mass files even without using Q Exactive HF-X Tune.

Lock Mass Files

Q Exactive HF-X Tune uses the following file formats for exporting and 
importing lock mass data:

• Comma-separated value lists (.csv)
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• Tabulator-separated text files (.txt)

• XML files (.xml)

Lock mass data are stored in the following order:

1. Usage status: True for used, False for unused

2. Ion polarity: positive mode or negative mode

3. m/z: up to five decimals

4. Comment: optional

The clipboard stores lock mass data as tabulator-separated text files. In 
contrast to . csv and .txt files, .xml files additionally store information 
about lock mass collections and lock mass usage.

Exporting Lock Masses

Q Exactive HF-X Tune allows exporting lock mass data to the clipboard 
or to a file.

❖ To export selected lock masses to the clipboard

1. In the Lock Masses dialog box, select the lock masses you want to 
export:

• To select a single lock mass, click into the respective table row.

• To select adjacent lock masses, click the first table row. Then 
hold down the <Shift> key while you click the last row.

• To select nonadjacent lock masses, click the first table row. Then 
hold down the <Ctrl> key while you click the other rows that 
you want to add to the selection.

2. Right-click into the dialog box to display the shortcut menu.

3. Choose Export > Copy selected to clipboard to copy the selected 
lock mass to the clipboard.

❖ To export all lock masses to the clipboard

1. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

2. Choose Export > Copy all to clipboard to copy all available lock 
mass to the clipboard.

❖ To export some lock masses to a file

1. In the Lock Masses dialog box, select the lock masses you want to 
export:
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• To select a single lock mass, click into the respective table row.

• To select adjacent lock masses, click the first table row. Then 
hold down the <Shift> key while you click the last row.

• To select nonadjacent lock masses, click the first table row. Then 
hold down the <Ctrl> key while you click the other rows that 
you want to add to the selection.

2. Right-click into the dialog box to display the shortcut menu.

3. Choose Export > Copy selected to file to open the file selection 
dialog box. See Figure 5-2.

a. Browse to the destination of the export file.

b. Select the format of the export file.

c. Enter a new name for the export file or select an existing file.

d. Click Save to export the selected lock masses to the file. If you 
want to overwrite an existing file, you have to confirm your 
action in a dialog box. The file selection dialog box is closed.

Figure 5-2. Selecting the lock mass export file
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❖ To export all lock masses to a file

1. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

2. Choose Export > Copy all to file to open the file selection dialog 
box. See Figure 5-3.

a. Browse to the destination of the export file.

b. Select the format of the export file.

c. Enter a new name for the export file or select an existing file.

d. Click Save to export the lock masses to the file. If you want to 
overwrite an existing file, you have to confirm your action in a 
dialog box. The file selection dialog box is closed.

Importing Lock Masses

Q Exactive HF-X Tune allows importing lock mass data from the 
clipboard or from a file. The imported lock masses either are added to 
the present lock masses or they replace them.

❖ To add lock masses from the clipboard

1. Copy lock mass data in an appropriate format to the clipboard. See 
Lock Mass Files for information about the requirements.

2. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

3. Choose Import > Merge with clipboard to import the lock mass 
data from the clipboard to the lock mass table.

NOTICE The clipboard stores lock mass data as tabulator-separated text 
files. When the data in the clipboard are not in this format, the 
command is not available. ▲

Figure 5-3. Selecting the lock mass export file
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4. The lock mass list in the Lock Masses dialog box displays additional 
rows for the imported lock masses.

❖ To add lock masses from a file

1. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

2. Choose Import > Merge with file content to open the file selection 
dialog box. See Figure 5-4.

a. Browse to the destination of the import file.

b. Select the format of the import file.

c. Select one of the displayed files.

d. Click Open to import the lock masses to Q Exactive HF-X 
Tune. The dialog box is closed.

3. If you are importing an xml file that contains information about 
lock mass collections that differs from the present lock mass 
collections, the Collection modification dialog is displayed. Click 
OK to confirm the operation and to close the dialog box.

4. The lock mass list in the Lock Masses dialog box displays additional 
rows for the imported lock masses.

❖ To replace all lock masses by clipboard data

1. Copy lock mass data in an appropriate format to the clipboard. See 
Lock Mass Files for information about the requirements.

2. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

3. Choose Import > Replace by clipboard to import the lock mass 
data from the clipboard to the lock mass table.

Figure 5-4. Selecting the lock mass import file
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NOTICE The clipboard stores lock mass data as tabulator-separated 
text files. When the data in the clipboard are not in this format, the 
command is not available. ▲

4. The Lock Mass Replacement dialog box is displayed. Click OK to 
confirm the import.

5. The Lock Mass Replacement dialog box is closed. The lock mass list 
in the Lock Masses dialog box displays only the imported lock 
masses.

❖ To replace all lock masses from a file

1. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

2. Choose Import > Replace by file content.

3. The Lock Mass Replacement dialog box is displayed. Click OK to 
confirm the import.

4. The Lock Mass Replacement dialog box is closed. The file selection 
dialog box is displayed. See Figure 5-5.

a. Browse to the destination of the import file.

b. Select the format of the import file.

c. Select one of the displayed files.

d. Click Open to import the lock masses to Q Exactive HF-X 
Tune. The dialog box is closed.

5. The lock mass list in the Lock Masses dialog box displays only the 
imported lock masses.

Figure 5-5. Selecting the lock mass import file
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If you have imported lock mass data from an xml file that contained 
information about lock mass collections and lock mass usage, the 
dialog box displays the corresponding information.

Creating a new Lock Mass Collection

❖ To create a lock mass collection

1. In the Lock Masses dialog box, click the  button.

2. In the New Lock Mass Collection dialog box, enter a name for the 
new lock mass collection. See Figure 5-6.

3. Click OK to confirm your input and to close the dialog box.

4. The name of the new lock mass collection appears in the list box of 
the Lock Masses dialog box.

Renaming a Lock Mass Collection

❖ To rename a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass 
collection in the list box.

Figure 5-6. Creating a lock mass collection
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2. Click the  button. The Name Change dialog box is displayed. 
See Figure 5-7.

3. In the text field, replace the old name of the lock mass collection 
with the new name.

4. Click OK to confirm your input and to close the dialog box.

5. In the Lock Masses dialog box, the new lock mass collection is 
displayed in the list box.

Adding a Lock Mass to a Lock Mass Collection

❖ To add a lock mass to a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass 
collection in the list box.

2. Select the Use check box in the table row of the lock mass.

3. A  indicates that the lock mass is used in the active lock mass 
collection.

Removing a Lock Mass from a Lock Mass Collection

❖ To remove a lock mass from a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass 
collection in the list box.

2. Clear the Use check box in the table row of the lock mass.

3. A  indicates that the lock mass is not used in the active lock mass 
collection.

Figure 5-7. Changing the name of a lock mass collection
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Deleting a Lock Mass Collection

❖ To delete a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass 
collection in the list box.

2. Click the  button.

3. In the Delete Lock Mass Collection dialog box, click OK to confirm 
your action and to close the dialog box.

4. The name of the lock mass collection is removed from the list box of 
the Lock Masses dialog box.
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Performing a System Bakeout
The system bakeout of the mass spectrometer removes unwanted gases 
or molecules (collected or remaining) from the high vacuum region of 
the instrument. Ions can collide with those gases or molecules resulting 
in lower overall sensitivity. Therefore, Thermo Fisher Scientific 
recommends baking out the instrument if the high vacuum decreases 
noticeable during routine operation.

Bakeout is mandatory after maintenance or service work is performed in 
the analyzer region where the system is vented. You should bake out an 
instrument that has been vented for at least twelve hours (12 hours) 
before you can start using it again.

In case the system has been vented during a power failure, it is necessary 
to bake out the system to obtain the operating vacuum.

NOTICE Before you start the bakeout, ensure that the pumps are up and 
running at their operating speed. If you have just switched on the mass 
spectrometer, this will take about 10 minutes. To check the pump speed, 
open the Instruments Status window and expand the Vacuum System 
node of the Instrument tree. ▲

❖ To perform a system bakeout

1. In the Q Exactive HF-X Tune window, click on the On/Standby 
button to put the instrument in Off condition. (See image in 
margin.)

2. In the Tasks panel, click  to 
display the Vacuum / Bakeout window.

3. Enter the desired baking duration (in hours) into the spin box. The 
range is 4 to 30 hours. See Figure 5-8.

Figure 5-8. Vacuum / Bakeout window
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4. Click Bake out. A dialog box shows the duration of the baking 
procedure. See Figure 5-9. Click Yes to confirm the message.

5. The message box disappears and the baking procedure starts. The 
instrument indicates the active bakeout procedure by a flashing 
Vacuum LED at the front side. Additionally, the Q Exactive HF-X 
Tune software displays a corresponding message box.

6. The baking of the instrument stops after the preset duration. The 
Vacuum LED keeps flashing until the cooling and stabilization time 
(of about 3 hours) is finished.

Click Stop in the Vacuum / Bakeout window to abort the baking 
routine before the preset time.

Figure 5-9. Bakeout message box
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Changing Default Settings of Q Exactive HF-X Tune
Advanced users can use the instrument status window to change default 
settings of Q Exactive HF-X Tune.

Displaying the High Vacuum Readback

The High Vacuum readback in the Vacuum / Bakeout window is visible 
only when the ion gauge in the high vacuum chamber is switched on. 
Advanced users can switch on this gauge manually.

❖ To switch on the High Vacuum readback in the Vacuum / Bakeout 
window

1. Click  in the tasks 

panel to display the Vacuum / Bakeout window.

2. If the instrument status window is not visible, choose Windows > 
Instrument Status.

3. In the instrument status window, click Instrument > Vacuum 
System.

4. Right-click the High Vacuum parameter to display the shortcut 
menu.

5. Choose Turn on to switch on the ion gauge in the high vacuum 
chamber.

6. The Vacuum / Bakeout window now displays the High Vacuum 
readback.

To extend the lifetime of the ion gauge in the high vacuum chamber, it 
is switched off again after a preset time of about thirty minutes.

Contents

• Displaying the High Vacuum Readback

• Entering Parameters for the Syringe Pump

• Changing the Settings for the Performance Status Check

• Enabling the DART Ion Source Compatibility

• Changing the Sweep Gas Flow in Standby Mode
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Entering Parameters for the Syringe Pump

The syringe contact of the Q Exactive HF-X mass spectrometer allows 
controlling established syringe pumps by Q Exactive HF-X Tune by 
means of the RS-232 serial interface. Suitable syringe pumps are the 
Chemyx Fusion 100 pump (available from Thermo Fisher Scientific) 
and the Harvard Apparatus Model 11 Plus Advanced pump. Advanced 
users can select the syringe pump type and enter parameters for the 
syringe pump in the instrument status window.

❖ To enter parameters for the syringe pump

1. If the instrument status window is not visible, choose Windows > 
Instrument Status.

2. In the instrument status window, click Instrument > System > 
Configuration settings > Peripherals. The Peripherals node 
displays parameters for the syringe pump. See Figure 5-10.

3. To change the settings for a parameter, right-click the parameter 
entry to display the shortcut menu. If necessary, change the values of 
the following parameters:

• Syringe Pump Controller Type: In the list box, select either Type 
Harvard (for Harvard Apparatus Model 11 Plus Advanced 
pump) or Type Chemyx (for Chemyx Fusion 100 pump).

Figure 5-10. Instrument status window—Peripherals node
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• Syringe Type Harvard Serial Com Speed: Enter the baud rate for 
the interface into the input field. Available options are 1200, 
2400, 4800, 9600, and 19200 bauds. Press the <Enter> key to 
confirm your input.

• Syringe Type Chemyx Serial Com Speed: Enter the baud rate for 
the interface into the input field. Available options are 1200, 
2400, 4800, 9600, and 19200 bauds. Press the <Enter> key to 
confirm your input.

See the manual that came with the syringe pump for the correct 
baud rate.

Changing the Settings for the Performance Status Check

By default, the performance status icon on the toolbar turns yellow 
25 hours after the last successful mass calibration or check. Advanced 
users can change this value in the System node of the instrument status 
window according to their mass accuracy requirements.

❖ To change the settings for the performance status check

1. If the instrument status window is not visible, choose Windows > 
Instrument Status.
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2. In the instrument status window, click Instrument > System > 
Configuration settings > Performance Check. The Mass 
calibration due time (h) field displays the current validity period of 
the mass calibration (25 hours, for example). See Figure 5-11.

3. To change the value, right-click the number in the text field to 
display the shortcut menu.

4. In the Set text field, enter the new validity period (40, for example). 
See Figure 5-12. You can enter a value between 1 and 500 hours.

5. Press the <Enter> key to confirm your input. The shortcut menu 
disappears and the new value is displayed in the instrument status 
window.

Figure 5-11. Instrument status window—Performance Check node

Figure 5-12. Changing the calibration validity period
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Enabling the DART Ion Source Compatibility

Using a DART ion source increases the gas input into the UHV region. 
As a result, the pressure might exceed the instrument status warning 
level. This is indicated by a yellow LED in the Vacuum / Bakeout 
window. Advanced users can enable the DART ion source compatibility 
in the Instrument Status window to increase the UHV warning level to 
5E-09 mbar.

❖ To enable the DART ion source compatibility

1. If the instrument status window is not visible, choose Windows > 
Instrument Status.

2. In the instrument status window, click Instrument > System > 
Configuration settings > Performance Check > DART Ion 
Source Compatibility.

3. To change the value, right-click the entry in the text field to display 
the shortcut menu.

4. In the Set text field, select Enabled. See Figure 5-13. The shortcut 
menu disappears and the new value is displayed in the instrument 
status window.

Changing the Sweep Gas Flow in Standby Mode

Advanced users can leave some sweep gas on during standby to 
positively pressurize the ion source. Studies have shown that this can 
reduce the amount and size of the particles that get into the system and 
onto the ion optics.

Figure 5-13. Instrument status window—DART Ion Source Compatibility
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NOTICE Users who use nitrogen gas from a limited supply (gas bottles, 
for example) may want to switch off the sweep gas flow during 
standby. ▲

❖ To change the sweep gas flow during standby

1. If the instrument status window is not visible, choose Windows > 
Instrument Status.

2. In the instrument status window, click Instrument > System > 
Configuration settings > Sweep Gas Flow During Standby.

3. To change the value, right-click the number in the text field to 
display the shortcut menu.

4. In the Set text field, enter the new value (2, for example). See 
Figure 5-15. You can enter a value between 0 (no sweep gas) and 
10 arbitrary units.

5. Press the <Enter> key to confirm your input. The shortcut menu 
disappears and the new value is displayed in the instrument status 
window.

Figure 5-14. Instrument status window—Sweep gas flow during standby

Figure 5-15. Changing the sweep gas flow



Procedures in Q Exactive HF-X Tune
Using License-Specific Settings in Q Exactive HF-X Tune

Thermo Scientific Q Exactive HF-X Software Manual (P/N BRE0012262, Revision A) 5-21

Using License-Specific Settings in Q Exactive HF-X Tune
For advanced users, the instrument status window provides various 
parameters that are available only when the corresponding license is 
installed.

Disabling the HMR Mode or the Intact Protein Mode

On instruments with a valid High Mass Range license or Intact Protein 
license, advanced users can use the instrument status window to 
temporarily disable the features that are provided by the corresponding 
mode.

If both licenses are installed on your system, only the following settings 
are available:

The following instruction for disabling the HMR mode works in the 
same way for the Protein mode.

❖ To disable the HMR Mode

1. If the instrument status window is not visible, choose Windows > 
Instrument Status.

2. In the instrument status window, click Instrument > Control > 
Settings > HMR mode.

Mode Setting

High Mass Range (HMR) Mode Off On Off

Intact Protein Mode Off Off On

Figure 5-16. Instrument status window—HMR mode
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3. To change the value, right-click the text field to display the shortcut 
menu.

4. In the Set list box, select Off. The shortcut menu disappears and the 
new value is displayed in the instrument status window.

To enable the HMR mode again, select On in the shortcut menu.

Setting the HCD Trapping Gas Pressure

HCD trapping enables a better trapping of large molecules. It is 
available on instruments with a valid High Mass Range license or Intact 
Protein license.

The trapping gas pressure is normalized to the standard operating 
pressure difference in the trapping region. A value <1 decreases the 
pressure compared to the standard pressure, a value >1 increase the 
pressure compared to the standard pressure. The default value for Intact 
Protein mode is 0.2 and the default value for HMR mode is 1.0.

❖ To change the HCD trapping gas pressure

1. If the instrument status window is not visible, choose Windows > 
Instrument Status.

2. In the instrument status window, do one of the following:

• Click Instrument > Control > Settings > Intact Protein mode.

• Click Instrument > Control > Settings > HMR mode.

Figure 5-17. Switching off the HMR mode
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3. Right-click the text field to display the shortcut menu. In the Set list 
box, select On. The shortcut menu disappears and the new value is 
displayed in the instrument status window. If the other mode option 
is available, it is set to Off.

4. Right-click Trapping gas pressure setting to display the shortcut 
menu.

5. In the Set rel. pressure field, enter the new value (1, for example). 
For Intact Protein mode, you can enter a value between 0.1 and 1. 
For HMR mode, you can enter a value between 1 and 1.5.

6. Press the <Enter> key to confirm your input. The shortcut menu 
disappears and the new value is displayed in the instrument status 
window.

Figure 5-18. Instrument status window—Trapping gas pressure

Figure 5-19. Changing the trapping gas pressure
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Averaging Spectra

On instruments with a valid High Mass Range license or Intact Protein 
license, advanced users can use the instrument status window to enable 
the rolling averaging of the acquired spectra. This increases the 
signal-to-noise ratio at the expense of the speed of signal changes. 
Averaging can be used only when either HMR mode or Intact Protein 
mode is enabled.

❖ To enable the averaging of spectra

1. If the instrument status window is not visible, choose Windows > 
Instrument Status.

2. In the instrument status window, click Instrument > Control > 
Settings > Define Scan > Averaging.

3. To change the value, right-click the number in the text field to 
display the shortcut menu.

4. In the Set text field, enter the new value (100, for example). You can 
enter either 0 or 1 (no averaging) or an integer between 2 and 1000.

Figure 5-20. Instrument status window—Averaging

Figure 5-21. Enabling averaging spectra
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5. Press the <Enter> key to confirm your input. The shortcut menu 
disappears and the new value is displayed in the instrument status 
window.

Performing Calibrations and Evaluations for HMR Mode

The mass calibration for the HMR mode supports values up to 
m/z 8000. It is available only in positive polarity. Ammonium 
hexafluorophosphate (AHFP) ions can be detected up to m/z 8000 and 
are suitable for mass calibrations and evaluations in HMR mode.

NOTICE AHFP is corrosive. Read the MSDS for further information. ▲

❖ To calibrate in HMR mode

1. Prepare an HMR calibration solution containing 1 mg/mL 
ammonium hexafluorophosphate (AHFP or NH4PF6) in 
isopropanol/water 50/50%. 

2. In the instrument status window, make sure that HMR mode is set 
to On.

3. In the Calmix Calibration window, select the HMR Mass 
Calibration (pos) check box. The following scan parameter values 
are used for this calibration:

Also, the m/z values of the ions contained in the HMR mass list are 
used.

4. In the HESI source window, use the following settings:

5. Start injecting the AFHP solution.

6. In the Calibrate window, click Calibrate to start the calibration.

Scan range 630.0 to 6670.0 m/z
In-source CID 100 eV
Resolution 140000
AGC target 3e6

Sheath gas flow rate 5
Spray voltage 3.8 kV
Capillary temperature 320 °C
Funnel RF level 200
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NOTICE The high concentration of the AFHP solution might cause the 
contamination of the ion source. Try to spray this solution as short as 
possible. Rinse and spray the source with pure solvent or calmix right 
afterwards. ▲

Mass Calibration List for HMR Mode

On instruments with a valid High Mass Range license, advanced users 
can use the instrument status window to display the list of masses used 
for mass calibrations and evaluations in HMR mode. They can also 
change the used masses, if necessary.

❖ To display the HMR mass list

1. If the instrument status window is not visible, choose Windows > 
Instrument Status.

2. In the instrument status window, click Instrument > Control > 
Procedures > HMR Mass List > Positive ions. A list of seven 
masses in the range between m/z 670 and m/z 6049 is displayed.

Figure 5-22. HMR Mass List—AHFP
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Chapter 6 Reference Information

This chapter provides reference information for the following:

Contents

• Log Files

• Tune Files and Calibration Files

• API Source Settings for Various LC Flow Rates

• One-Letter Abbreviations for Amino Acids
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Log Files
Log files (*.log) are created for a Q Exactive HF-X mass spectrometer. 
The default directory for the log files is 
C:\Xcalibur\system\Exactive\log. The Instrument Configuration 
window shows the actual path.

Additional log files are created every time the Exactive window service 
starts. The file name shows date and time of the service start, as shown 
in the following example:

Thermo Exactive--2008-10-22--08-17-22.log

NOTICE The system automatically deletes all log files that are older than 
18 months. ▲

Each line in a log file is a message. A message has several properties that 
are listed at the beginning of the line, followed by the message body.

Properties are enclosed in brackets. A property is a property name 
followed by an equal sign followed by the property value. These 
properties exist:

Access to the log files is regulated by the Microsoft™ Windows user 
account or group account. Full access to the log files is granted to 
Administrators. Members of the Power User group can read, delete, and 
modify these files. Standard users can read these files.

Abbreviation Meaning

Time Time of the message. The current local time is displayed 
followed by the time offset to UTC.

Acc Windows™ account name that caused this message; 
“(none)” is used for an instrument source. Other known 
values are “ExactiveUser” and “Xcalibur_System”.

User User name description of the Windows account

Comp Computer name on which this message was caused, 
“(none)” is used for an instrument source.

App Application name that caused this message; “(none)” is 
used for an instrument source.

PID Process identifier of the application process

Inst Instrument affected

Conn Connection in charge for the communication with the 
instrument

Type Type of the message. Message types are “info”, 
“warning”, “error” and “FATAL error”
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Tune Files and Calibration Files
Tune files and calibration files contain information for operating the 
instrument.

Tune Files

Tuning optimizes voltage settings for API source and ion transfer optics 
to ensure highest sensitivity. The resulting tune file (*.mstune) is specific 
to a particular analyte and solvent flow rate.

During installation of the instrument, the service engineer creates a tune 
file HESI_Installation.mstune in the folder C:\Xcalibur\methods\. Use 
this file as a starting point for optimizing the mass spectrometer for your 
specific measurement requirements. Use this folder to store your 
personal tune files.

NOTICE Do not overwrite the default tune file 
C:\Xcalibur\methods\HESI_Installation.mstune! ▲

Calibration File

After having tuned the Q Exactive HF-X mass spectrometer, calibrate 
the instrument to ensure the mass accuracy of the measurement results. 
Calibration parameters are instrument parameters whose values do not 
vary with the type of experiment. They are stored automatically in a 
calibration file (*.mscal) in the folder 
C:\Xcalibur\system\Exactive\instrument\msx_instrument_files\.

The file master_cal.mscal contained in this folder is the calibration file 
used for operating the instrument. It will be overwritten with new 
calibration values every time a calibration procedure is successful.

NOTICE Never save or change files in the folder 
C:\Xcalibur\system\Exactive\instrument\msx_instrument_files\! Files in 
this folder are automatically managed by the instrument software. ▲
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API Source Settings for Various LC Flow Rates
The ESI, H-ESI, and HESI-II probes can generate ions from liquid 
flows of 1 μL/min to 1.0 mL/min. With this flow rate range you can use 
a variety of separation techniques: capillary LC, microbore LC, and 
analytical LC. An optional nanospray ion source is available for 
sub-microliter analysis. The APCI probe can generate ions from liquid 
flows as low as 50 μL/min, but typical flow rates are from 0.2 to 
2.0 mL/min. Within this range of flow rates, you can use separation 
techniques such as microbore LC, analytical LC, and semi-preparative 
LC.

As you change the rate of flow of solvents entering the mass 
spectrometer, you must adjust several of the mass spectrometer 
parameters:

• For ESI, adjust the temperatures of the ion transfer tube and adjust 
the gas flow rates for the sheath gas and auxiliary gas.

• For H-ESI, adjust the temperatures of the ion transfer tube and the 
vaporizer, and adjust the gas flow rates for the sheath gas and 
auxiliary gas.

• For APCI, adjust the temperatures of the ion transfer tube and the 
vaporizer, and adjust the gas flow rates for the sheath gas and 
auxiliary gas.

In general, the higher the rate of liquid flowing into the mass 
spectrometer, the higher the temperature of the ion transfer tube (and 
vaporizer) and the higher the gas flows. 

Table 6-1 provides guidelines for setting H-ESI operating parameters for 
various LC solvent flow rates. Table 6-2 provides guidelines for setting 
ESI operating parameters. Table 6-3 provides guidelines for setting 
APCI operating parameters.

Table 6-1. Guidelines for setting operating parameters for LC/H-ESI/MS

Liquid flow rate
(μL/min)

Capillary (ion transfer 
tube) temperature
(°C)a

Vaporizer 
temperature
(°C)b

Sheath gas 
pressure
(arbitrary units)

Auxiliary gas flow
(arbitrary units)

Spray voltage
(V)

5 275 Off to 50 5 0 to 10c +3500 (-2500)d

200 275 300 to 400 45 30 (H-ESI probe)
10 (HESI-II probe)

+3500 (-2500) 
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500 300 300 to 400 
(H-ESI probe)
300 to 500 
(HESI-II 
probe)

55 50 (H-ESI probe)
15 (HESI-II probe)

+3500 (-2500)

1000 325 350 to 450 
(H-ESI probe)
500 (HESI-II 
probe)

65 60 (H-ESI probe) 
20 (HESI-II probe)

+3500 (-2500)

a Always optimize the Funnel RF voltage when you change the temperature of the ion transfer tube.
b Compound dependent
c Aux gas flow must be greater than 0 if the vaporizer is on.
d Negative ion mode

Table 6-1. Guidelines for setting operating parameters for LC/H-ESI/MS, continued

Liquid flow rate
(μL/min)

Capillary (ion transfer 
tube) temperature
(°C)a

Vaporizer 
temperature
(°C)b

Sheath gas 
pressure
(arbitrary units)

Auxiliary gas flow
(arbitrary units)

Spray voltage
(V)

Table 6-2. Guidelines for setting operating parameters for LC/ESI/MS

Liquid flow 
rate
(μL/min)

Suggested column ID
size (mm)

Spray voltage
(V)

Capillary 
temperature
(°C)

Sheath gas
(arbitrary units)

Auxiliary gas
(arbitrary units)

less than 10 Capillary 3000 (-2500)a 200 to 250 5 to 30 Off

50 to 100 1.0 3000 (-2500) 250 to 300 10 to 30 5 to 10

200 to 400 2.1 to 4.6 3500 (-2500) 300 to 350 20 to 40 10 to 20

greater than 
400

4.6 4000 (-3500) 350 30 to 75 10 to 40

a Negative ion mode

Table 6-3. Guidelines for setting operating parameters for LC/APCI/MS

Liquid flow rate
(μL/min)

Capillary temperature
(°C)

APCI vaporizer 
temperature
(°C)

Sheath gas
(arbitrary units)

Auxiliary gas
(arbitrary units)

Corona discharge 
current
(μA)

200 250 350 25 5 +4 (-10)a

1000 250 450 45 5 +4 (-10)
a Negative ion mode
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Default Parameters and Ranges for HESI-2 and APCI

Table 6-4 and Table 6-5 list the parameters and values that 
Q Exactive HF-X Tune uses when you click Source Auto-Defaults in 
the HESI source window or the APCI source window.

NOTICE Spray Voltage is a “tunable” parameter, which can optimize at 
low voltages (for example, 500–1000 V) for some compounds. ▲

NOTICE The APCI Discharge Current in negative ion mode generally 
requires a higher current than positive ion mode. This parameter should 
be optimized for the target compound up to a maximum of 100 μA. ▲

Table 6-4. Default Parameters and Ranges for HESI-2

Liquid flow rate
(μL/min)

Capillary temp.
(°C)

Vaporizer temp.
(°C)

Sheath gas press.
(arbitrary units)

Auxiliary gas flow
(arbitrary units)

Sweep gas flow
(arbitrary units)

Spray voltage
(V)

5 275 50 5 3 0 +3500 (-2500)

10 275 100 15 5 0 +3500 (-2500)

50 275 150 30 10 1 +3500 (-2500)

100 275 200 35 10 1 +3500 (-2500)

200 275 400 45 10 2 +3500 (-2500)

600 300 450 55 15 3 +3500 (-2500)

1000 325 500 65 20 4 +3500 (-2500)

Table 6-5. Default Parameters and Ranges for APCI

Liquid flow rate
(mL/min)

Capillary temp.
(°C)

Vaporizer temp.
(°C)

Sheath gas press.
(arbitrary units)

Auxiliary gas flow
(arbitrary units)

Sweep gas flow
(arbitrary units)

Discharge Current
(μA)

0.2 225 350 20 5 0 4a (20b)

0.6 250 400 25 5 0 4a (40b)

1.0 275 450 30 5 0 4a (60b)
a Positive ion mode
b Negative ion mode
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One-Letter Abbreviations for Amino Acids
The following table assists you in using the Mass Calculator.

One letter Name Formula

A Alanine C3H5NO

C Cysteine C3H5NOS

D Aspartate C4H5NO3 

E Glutamate C5H7NO3

F Phenylalanine C9H9NO 

G Glycine C2H3NO 

H Histidine C6H7N3O

I Isoleucine C6H11NO

K Lysine C6H12N2O

L Leucine C6H11NO

M Methionine C5H9NOS

N Asparagine C4H6N2O2

O Ornithine C5H11N2O

P Proline C5H7NO 

Q Glutamine C5H8N2O2 

R Arginine C6H12N4O 

S Serine C3H5NO2 

T Threonine C4H7NO2 

V Valine C5H9NO 

W Tryptophan C11H10N2O 

Y Tyrosine C9H9NO2 
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Glossary

This section lists and defines terms used in this manual. It also includes acronyms, metric prefixes, symbols, and 
abbreviations.

A

A  ampere

AC  alternating current

ADC  analog-to-digital converter; a device that converts 
data from analog to digital form.

adduct ion  An ion formed by the joining together of 
two species, usually an ion and a molecule, and often 
within the ion source, to form an ion containing all 
the constituent atoms of both species. 

AGC  See Automatic Gain Control (AGC).

APCI  See atmospheric pressure chemical ionization 
(APCI).

APCI corona discharge current  The ion current 
carried by the charged particles in the APCI source. 
The voltage on the APCI corona discharge needle 
supplies the potential required to ionize the particles. 
The APCI corona discharge current is set; the APCI 
corona discharge voltage varies, as required, to 
maintain the set discharge current.

See also corona discharge and APCI corona discharge 
voltage.

APCI corona discharge voltage  The high voltage that 
is applied to the corona discharge needle in the APCI 
source to produce the APCI corona discharge. The 
corona discharge voltage varies, as required, to 
maintain the set APCI spray current.

See also APCI spray current.

APCI manifold  The manifold that houses the APCI 
sample tube and nozzle, and contains the plumbing 
for the sheath and auxiliary gas.

APCI needle, corona discharge  A needle to which a 
sufficiently high voltage (typically ±3 to ±5 kV) is 
applied to produce a chemical ionization plasma by 
the corona discharge mechanism.

See also chemical ionization (CI), chemical ionization 
(CI) plasma, atmospheric pressure chemical ionization 
(APCI), and corona discharge.

APCI nozzle  The nozzle in the APCI probe that sprays 
the sample solution into a fine mist.

See also atmospheric pressure chemical ionization 
(APCI).

APCI sample tube  A fused silica tube that delivers 
sample solution to the APCI nozzle. The APCI 
sample tube extends from the sample inlet to the 
APCI nozzle.

See also atmospheric pressure chemical ionization 
(APCI), and API stack.

APCI source   Contains the APCI probe assembly, 
APCI manifold, and API stack.

See also atmospheric pressure chemical ionization 
(APCI), APCI manifold, and API stack.

APCI spray current  The ion current carried by the 
charged particles in the APCI source. The APCI 
corona discharge voltage varies, as required, to 
maintain the set spray current.

APCI vaporizer  A heated tube that vaporizes the 
sample solution as the solution exits the sample tube 
and enters the atmospheric pressure region of the 
APCI source.

See also atmospheric pressure chemical ionization 
(APCI).

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
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API  See atmospheric pressure ionization (API).

API atmospheric pressure region  The first of two 
chambers in the API source. Also referred to as the 
spray chamber.

API capillary-skimmer region  The area between the 
capillary and the skimmer, which is surrounded by the 
tube lens. It is also the area of first-stage evacuation in 
the API source.

API heated capillary  A tube assembly that assists in 
desolvating ions that are produced by the ESI or 
APCI probe.

See also API heated capillary voltage. 

API heated capillary voltage  The DC voltage applied 
to the heated capillary. The voltage is positive for 
positive ions and negative for negative ions.

See also API source and API heated capillary.

API ion transfer capillary  A tube assembly that assists 
in desolvating ions that are produced by the ESI, NSI, 
or APCI probe.

See also API ion transfer capillary offset voltage and 
API ion transfer capillary temperature.

API ion transfer capillary offset voltage  A DC voltage 
applied to the ion transfer capillary. The voltage is 
positive for positive ions and negative for negative 
ions.

See also API source and API ion transfer capillary.

API ion transfer capillary temperature  The 
temperature of the ion transfer capillary, which should 
be adjusted for different flow rates.

See also API source and API ion transfer capillary.

API source  The sample interface between the LC and 
the mass spectrometer. It consists of the API probe 
(ESI or APCI) and API stack. 

See also atmospheric pressure ionization (API), ESI 
source, APCI source, ESI probe, and API stack. 

API spray chamber  The first of two chambers in the 
API source. In this chamber the sample liquid exits 
the probe and is sprayed into a fine mist (ESI or NSI) 
or is vaporized (APCI) as it is transported to the 
entrance end of the ion transfer capillary. 

API spray shield  A stainless steel, cylindrical vessel 
that, in combination with the ESI or APCI flange, 
forms the atmospheric pressure region of the 
API source. 

See also atmospheric pressure ionization (API).

API stack  Consists of the components of the 
API source that are held under vacuum and includes 
the API spray shield, API ion transfer capillary, 
API tube lens, skimmer, the ion transfer capillary 
mount, and the tube lens and skimmer mount. 

See also atmospheric pressure ionization (API) and 
API source.

API tube lens  A lens in the API source that separates 
ions from neutral particles as they leave the ion 
transfer capillary. A potential applied to the tube lens 
focuses the ions toward the opening of the skimmer 
and helps to dissociate adduct ions.

See also API tube lens offset voltage, API source, 
API ion transfer capillary, and adduct ion.

API tube lens and skimmer mount  A mount that 
attaches to the heated capillary mount. The tube lens 
and skimmer attach to the tube lens and skimmer 
mount.

API tube lens offset voltage  A DC voltage applied to 
the tube lens. The value is normally tuned for a 
specific compound.

See also API tube lens, adduct ion, and source CID. 

AP-MALDI  See atmospheric pressure matrix-assisted 
laser desorption/ionization (AP-MALDI).

APPI   See Atmospheric Pressure Photoionization 
(APPI).

ASCII  American Standard Code for Information 
Interchange

atmospheric pressure chemical ionization (APCI)  A 
soft ionization technique done in an ion source 
operating at atmospheric pressure. Electrons from a 
corona discharge initiate the process by ionizing the 
mobile phase vapor molecules. A reagent gas forms, 
which efficiently produces positive and negative ions 
of the analyte through a complex series of chemical 
reactions. 

See also electrospray ionization (ESI).
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atmospheric pressure ionization (API)  Ionization 
performed at atmospheric pressure by using 
atmospheric pressure chemical ionization (APCI), 
electrospray ionization (ESI), or nanospray ionization 
(NSI). 

atmospheric pressure matrix-assisted laser 
desorption/ionization (AP-MALDI)  Matrix-assisted 

laser desorption/ionization in which the sample target 
is at atmospheric pressure.

See also matrix-assisted laser desorption/ionization 
(MALDI).

Atmospheric Pressure Photoionization (APPI)  A soft 
ionization technique in which an ion is generated 
from a molecule when it interacts with a photon from 
a light source. 

atomic mass unit  Atomic Mass Unit (u) defined by 
taking the mass of one atom of carbon12 as being 
12u; unit of mass for expressing masses of atoms or 
molecules.

Automatic Gain Control (AGC)  Sets the ion injection 
time to maintain the optimum quantity of ions for 
each scan. With AGC on, the scan function consists of 
a prescan and an analytical scan.

See also ion injection time.

auxiliary gas  The outer-coaxial gas (nitrogen) that 
assists the sheath (inner-coaxial) gas in dispersing 
and/or evaporating sample solution as the sample 
solution exits the APCI, ESI, or H-ESI nozzle.

auxiliary gas flow rate  The relative rate of flow of 
auxiliary gas (nitrogen) into the API source reported 
in arbitrary units.

auxiliary gas inlet  An inlet in the API probe where 
auxiliary gas is introduced into the probe.

See also auxiliary gas and atmospheric pressure 
ionization (API).

auxiliary gas plumbing  The gas plumbing that delivers 
outer coaxial nitrogen gas to the ESI or APCI nozzle.

auxiliary gas valve  A valve that controls the flow of 
auxiliary gas into the API source.

B

b  bit

B  byte (8 b)

baud rate  data transmission speed in events per second

BTU  British thermal unit, a unit of energy

C

°C  degrees Celsius

CE  central electrode (of the Orbitrap analyzer);

European conformity. Mandatory European marking 
for certain product groups to indicate conformity with 
essential health and safety requirements set out in 
European Directives.

centroid data  Data used to represent mass spectral 
peaks in terms of two parameters: the centroid (the 
weighted center of mass) and the intensity. The data is 
displayed as a bar graph. The normalized area of the 
peak provides the mass intensity data. 

cfm  cubic feet per minute

chemical ionization (CI)  The formation of new 
ionized species when gaseous molecules interact with 
ions. The process can involve transfer of an electron, 
proton, or other charged species between the 
reactants. 

chemical ionization (CI) plasma  The collection of 
ions, electrons, and neutral species formed in the ion 
source during chemical ionization. 

See also chemical ionization (CI).

CI  See chemical ionization (CI).

CID  See collision-induced dissociation (CID).

cm  centimeter

cm3  cubic centimeter

collision gas   A neutral gas used to undergo collisions 
with ions.

collision-induced dissociation (CID)  An ion/neutral 
process in which an ion is dissociated as a result of 
interaction with a neutral target species. 



Glossary: comma-separated values text file–ESI

G-4 Q Exactive HF-X Software Manual (P/N BRE0012262, Revision A) Thermo Scientific

comma-separated values text file  A comma-delimited 
text file. The extension of a comma-separated values 
text file is csv. This file format can be read by a text 
editor program, such as Microsoft™ Notepad, or by a 
spreadsheet program, such as Microsoft Excel™. 

consecutive reaction monitoring (CRM) scan type  A 
scan type with three or more stages of mass analysis 
and in which a particular multi-step reaction path is 
monitored. 

Convectron™ gauge  A thermocouple bridge gauge that 
is sensitive to the pressure as well as the thermal 
conductivity of the gas used to measure pressures 
between X and Y.

corona discharge  In the APCI source, an electrical 
discharge in the region around the corona discharge 
needle that ionizes gas molecules to form a chemical 
ionization (CI) plasma, which contains CI reagent 
ions. 

See also chemical ionization (CI) plasma and 
atmospheric pressure chemical ionization (APCI).

CPU  central processing unit (of a computer)

CRM  See consecutive reaction monitoring (CRM) scan 
type.

C-Trap  curved linear trap

<Ctrl>  control key on the terminal keyboard

D

d  depth

Da  dalton

DAC  digital-to-analog converter

damping gas  Helium gas introduced into the ion trap 
mass analyzer that slows the motion of ions entering 
the mass analyzer so that the ions can be trapped by 
the RF voltage fields in the mass analyzer.

DART  Direct Analysis in Real Time

data-dependent scan  A scan mode that uses specified 
criteria to select one or more ions of interest on which 
to perform subsequent scans, such as MS/MS or 
ZoomScan. 

DC  direct current

divert/inject valve  A valve on the mass spectrometer 
that can be plumbed as a divert valve or as a loop 
injector. 

DS  data system

DSP  digital signal processor

E

ECD  See electron capture dissociation (ECD).

EI  electron ionization

electron capture dissociation (ECD)  A method of 
fragmenting gas phase ions for tandem mass 
spectrometric analysis. ECD involves the direct 
introduction of low energy electrons to trapped gas 
phase ions.

See also electron transfer dissociation (ETD) and 
infrared multiphoton dissociation (IRMPD).

electron multiplier  A device used for current 
amplification through the secondary emission of 
electrons. Electron multipliers can have a discrete 
dynode or a continuous dynode. 

electron transfer dissociation (ETD)  A method of 
fragmenting peptides and proteins. In electron 
transfer dissociation (ETD), singly charged reagent 
anions transfer an electron to multiply protonated 
peptides within the ion trap mass analyzer. This leads 
to a rich ladder of sequence ions derived from cleavage 
at the amide groups along the peptide backbone. 
Amino acid side chains and important modifications 
such as phosphorylation are left intact.

See also fluoranthene.

electrospray ionization (ESI)  A type of atmospheric 
pressure ionization that is currently the softest 
ionization technique available to transform ions in 
solution into ions in the gas phase.

EMBL  European Molecular Biology Laboratory

<Enter>  Enter key on the terminal keyboard

ESD  ElectroStatic Discharge. Discharge of stored static 
electricity that can damage electronic equipment and 
impair electrical circuitry, resulting in complete or 
intermittent failures.

ESI  See electrospray ionization (ESI).
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ESI flange  A flange that holds the ESI probe in 
position next to the entrance of the heated capillary, 
which is part of the API stack. The ESI flange also 
seals the atmospheric pressure region of the API 
source and, when it is in the engaged position against 
the spray shield, compresses the high-voltage 
safety-interlock switch. 

ESI probe  A probe that produces charged aerosol 
droplets that contain sample ions. The ESI probe is 
typically operated at liquid flows of 1 μL/min to 
1 mL/min without splitting. The ESI probe includes 
the ESI manifold, sample tube, nozzle, and needle.

ESI source  Contains the ESI probe and the API stack.

See also electrospray ionization (ESI), ESI probe, and 
API stack.

ESI spray current  The flow of charged particles in the 
ESI source. The voltage on the ESI spray needle 
supplies the potential required to ionize the particles.

ESI spray voltage  The high voltage that is applied to 
the spray needle in the ESI source to produce the 
ESI spray current. In ESI, the voltage is applied to the 
spray liquid as it emerges from the nozzle.

See also ESI spray current.

ETD  See electron transfer dissociation (ETD).

eV  Electron Volt. The energy gained by an electron that 
accelerates through a potential difference of one volt.

Extensible Markup Language  See XML (Extensible 
Markup Language).

external lock mass  A lock that is analyzed in a separate 
MS experiment from your sample. If you need to run 
a large number of samples, or if accurate mass samples 
will be intermingled with standard samples, you might 
want to use external lock masses. These allow more 
rapid data acquisition by eliminating the need to scan 
lock masses during each scan.

See also internal lock mass.

F

f  femto (10-15)

°F  degrees Fahrenheit

.fasta file  extension of a SEQUEST™ search database 
file

ft  foot

Fast Fourier Transform (FFT)  An algorithm that 
performs a Fourier transformation on data. A Fourier 
transform is the set of mathematical formulae by 
which a time function is converted into a 
frequency-domain function and the converse. 

FFT  See Fast Fourier Transform (FFT).

fluoranthene  A reagent anion that is used in an 
electron transfer dissociation (ETD) experiment.

firmware  Software routines stored in read-only 
memory. Startup routines and low-level input/output 
instructions are stored in firmware.

forepump  The pump that evacuates the foreline. A 
rotary-vane pump is a type of forepump.

Fourier Transform - Ion Cyclotron Resonance Mass 
Spectrometry (FT-ICR MS)  A technique that 

determines the mass-to-charge ratio of an ion by 
measuring its cyclotron frequency in a strong 
magnetic field. 

fragment ion  A charged dissociation product of an 
ionic fragmentation. Such an ion can dissociate 
further to form other charged molecular or atomic 
species of successively lower formula weights. 

fragmentation  The dissociation of a molecule or ion to 
form fragments, either ionic or neutral. When a 
molecule or ion interacts with a particle (electron, ion, 
or neutral species) the molecule or ion absorbs energy 
and can subsequently fall apart into a series of charged 
or neutral fragments. The mass spectrum of the 
fragment ions is unique for the molecule or ion. 

FT  Fourier Transformation

FT-ICR MS  See Fourier Transform - Ion Cyclotron 
Resonance Mass Spectrometry (FT-ICR MS).

FTMS  Fourier Transformation Mass Spectrometry

full-scan type  Provides a full mass spectrum of each 
analyte or parent ion. With the full-scan type, the 
mass analyzer is scanned from the first mass to the last 
mass without interruption. Also known as single-stage 
full-scan type.
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FWHM  See peak width at half height.

G

g  gram

G  Gauss; giga (109)

GC  gas chromatograph; gas chromatography

GC/MS  gas chromatography / mass spectrometer

GUI  graphical user interface

H

h  hour

h  height

handshake  A signal that acknowledges that 
communication can take place.

HCD  See higher energy collision-induced dissociation 
(HCD).

header information  Data stored in each data file that 
summarizes the information contained in the file.

H-ESI probe  Heated-electrospray ionization (H-ESI) 
converts ions in solution into ions in the gas phase by 
using electrospray ionization (ESI) in combination 
with heated auxiliary gas.

higher energy collision-induced dissociation (HCD)  

Collision-induced dissociation that occurs in the 
HCD cell of the Orbitrap mass analyzer. The 
HCD cell consists of a straight multipole mounted 
inside a collision gas-filled tube. A voltage offset 
between C-Trap and HCD cell accelerates parent ions 
into the collision gas inside the HCD cell, which 
causes the ions to fragment into product ions. The 
product ions are then returned to the Orbitrap 
analyzer for mass analysis. HCD produces triple 
quadrupole-like product ion mass spectra.

high performance liquid chromatography (HPLC)  

Liquid chromatography in which the liquid is driven 
through the column at high pressure. Also known as 
high pressure liquid chromatography.

HPLC  See high performance liquid chromatography 
(HPLC).

HV  high voltage

Hz  hertz (cycles per second)

I

ICR  ion cyclotron resonance

ID  inside diameter

IEC  International Electrotechnical Commission

IEEE  Institute of Electrical and Electronics Engineers

in.  inch

infrared multiphoton dissociation (IRMPD)  In 
infrared multiphoton dissociation (IRMPD), multiply 
charged ions consecutively absorb photons emitted by 
a infrared laser until the vibrational excitation is 
sufficient for their fragmentation. The fragments 
continue to pick up energy from the laser pulse and 
fall apart further to ions of lower mass.

See also electron capture dissociation (ECD).

instrument method  A set of experiment parameters 
that define Xcalibur operating settings for the 
autosampler, liquid chromatograph (LC), mass 
spectrometer, divert valve, syringe pump, and so on. 
Instrument methods are saved as file type .meth.

internal lock mass  A lock that is analyzed during the 
same MS experiment as your sample and is contained 
within the sample solution or infused into the 
LC flow during the experiment. Internal lock masses 
provide the most accurate corrections to the data.

See also external lock mass.

I/O  input/output

ion gauge  Measures the pressure in the mass analyzer 
region (high vacuum region) of the vacuum manifold.

ion injection time  The amount of time that ions are 
allowed to accumulate in the ion trap mass analyzer 
when AGC is off. With AGC on, the ion injection 
time is set automatically (up to the set maximum ion 
injection time) based on the AGC target value. 

See also: Automatic Gain Control (AGC).

ion optics  Focuses and transmits ions from the 
API source to the mass analyzer.
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ion source  A device that converts samples to gas-phase 
ions.

ion sweep cone  A removable cone-shaped metal cover 
that fits on top of the API ion transfer capillary and 
acts as a physical barrier to protect the entrance of the 
capillary. 

ion sweep gas  Extra nitrogen gas that flows along the 
axis of the API ion transfer capillary (between the ion 
sweep cone and the capillary block) towards the API 
spray. The sweep gas flow is thus countercurrent to the 
flow of the ions. 

See also ion sweep gas pressure.

ion sweep gas pressure  The rate of flow of the sweep 
gas (nitrogen) into the API source. A measurement of 
the relative flow rate (in arbitrary units) to provide the 
required flow of nitrogen gas out from the Ion Sweep 
cone towards the API spray. 

See also ion sweep gas.

IRMPD  See infrared multiphoton dissociation 
(IRMPD).

K

k  kilo (103, 1000)

K  kilo (210, 1024)

KEGG  Kyoto Encyclopedia of Genes and Genomes

kg  kilogram

L

l  length

L  liter

LAN  local area network

lb  pound

LC  See liquid chromatography (LC).

LC/MS  See liquid chromatography / mass spectrometry 
(LC/MS).

LED  light-emitting diode

LHe  liquid helium

liquid chromatography (LC)  A form of elution 
chromatography in which a sample partitions between 
a stationary phase of large surface area and a liquid 
mobile phase that percolates over the stationary phase. 

liquid chromatography / mass spectrometry 
(LC/MS)  An analytical technique in which a 

high-performance liquid chromatograph (LC) and a 
mass spectrometer (MS) are combined.

LN2  liquid nitrogen

lock mass  A known reference mass in the sample that is 
used to correct the mass spectral data in an accurate 
mass experiment and used to perform a real-time 
secondary mass calibration that corrects the masses of 
other peaks in a scan. Lock masses with well-defined, 
symmetrical peaks work best. You can choose to use 
internal lock mass or external lock mass.

log file  A text file, with a log file extension, that is used 
to store lists of information.

M

μ  micro (10-6)

m  meter; milli (10-3)

M  mega (106)

M+  molecular ion

MALDI  See matrix-assisted laser desorption/ionization 
(MALDI).

matrix-assisted laser desorption/ionization 
(MALDI)  A method of ionizing proteins where a direct 

laser beam is used to facilitate vaporization and 
ionization while a matrix protects the biomolecule 
from being destroyed by the laser.

See also atmospheric pressure matrix-assisted laser 
desorption/ionization (AP-MALDI).

MB  Megabyte (1048576 bytes)

MH+  protonated molecular ion
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microscan  One mass analysis (ion injection and storage 
or scan-out of ions) followed by ion detection. 
Microscans are summed, to produce one scan, to 
improve the signal-to-noise ratio of the mass spectral 
data. The number of microscans per scan is an 
important factor in determining the overall scan time. 

min  minute

mL  milliliter

mm  millimeter

MRFA  A peptide with the amino acid sequence 
methionine–arginine–phenylalanine–alanine.

MS  mass spectrometer; mass spectrometry

MS scan modes  Scan modes in which only one stage of 
mass analysis is performed. The scan types used with 
the MS scan modes are full-scan type and selected ion 
monitoring (SIM) scan type.

MSDS  Material Safety Data Sheet

MS/MS  Mass spectrometry/mass spectrometry, or 
tandem mass spectrometry is an analytical technique 
that involves two stages of mass analysis. In the first 
stage, ions formed in the ion source are analyzed by an 
initial analyzer. In the second stage, the mass-selected 
ions are fragmented and the resultant ionic fragments 
are mass analyzed.

MSn scan mode  The scan power equal to 1 to 10, 
where the scan power is the power n in the expression 
MSn. MSn is the most general expression for the scan 
mode, which can include the following:

• The scan mode corresponding to the one stage of 
mass analysis in a single-stage full-scan experiment 
or a selected ion monitoring (SIM) experiment

• The scan mode corresponding to the two stages of 
mass analysis in a two-stage full-scan experiment or 
a selected reaction monitoring (SRM) experiment

• The scan mode corresponding to the three to ten 
stages of mass analysis (n = 3 to n = 10) in a 
multi-stage full-scan experiment or a consecutive 
reaction monitoring (CRM) experiment

See also MS scan modes and MS/MS. 

multipole  A symmetrical, parallel array of (usually) 
four, six, or eight cylindrical rods that acts as an ion 
transmission device. An RF voltage and DC offset 
voltage are applied to the rods to create an electrostatic 
field that efficiently transmits ions along the axis of 
the multipole rods.

m/z  Mass-to-charge ratio. An abbreviation used to 
denote the quantity formed by dividing the mass of an 
ion (in u) by the number of charges carried by the ion.
For example, for the ion C7H7

2+, m/z=45.5.

N

n  nano (10-9)

nanospray ionization (NSI)  A type of electrospray 
ionization (ESI) that accommodates very low flow 
rates of sample and solvent on the order of 1 to 
20 nL/min (for static nanospray) or 100 
to 1000 nL/min (for dynamic nanospray). 

NCBI  National Center for Biotechnology Information 
(USA)

NIST  National Institute of Standards and Technology 
(USA)

NMR  Normal Mass Range

NSI  See nanospray ionization (NSI).

O

octapole  An octagonal array of cylindrical rods that acts 
as an ion transmission device. An RF voltage and 
DC offset voltage applied to the rods create an 
electrostatic field that transmits the ions along the axis 
of the octapole rods.

OD  outside diameter

Orbitrap mass analyzer  The Orbitrap™ mass analyzer 
consists of a spindle-shape central electrode 
surrounded by a pair of bell-shaped outer electrodes. 
Ions inside the mass analyzer orbit in stable 
trajectories around the central electrode with 
harmonic oscillations along it. 
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Two detection electrodes record an image current of 
the ions as they undergo harmonic oscillations. A 
Fourier transformation extracts different harmonic 
frequencies from the image current. An ion's 
mass-to-charge ratio m/z is related to the frequency f 
of its harmonic oscillations and to the instrumental 
constant k by: m/z = k/f 2

OT  Orbitrap

See Orbitrap mass analyzer.

OVC  outer vacuum case

  ohm

P

p  pico (10-12)

Pa  pascal

parent ion  An electrically charged molecular species 
that can dissociate to form fragments. The fragments 
can be electrically charged or neutral species. A parent 
ion can be a molecular ion or an electrically charged 
fragment of a molecular ion. Also called a precursor 
ion.

parent mass  The mass-to-charge ratio of a parent ion. 
The location of the center of a target parent-ion peak 
in mass-to-charge ratio (m/z) units. Also known as 
precursor mass. 

See also parent ion.

PCB  printed circuit board

PDA detector  Photodiode Array detector is a linear 
array of discrete photodiodes on an integrated circuit 
chip. It is placed at the image plane of a spectrometer 
to allow a range of wavelengths to be detected 
simultaneously.

PE  protective earth

peak  A maximum in a graph of intensity versus time or 
intensity versus mass. The position of the maximum is 
said to be the position of the peak. 

peak end  The end of a chromatographic peak occurs 
when the detection signal decreases to a value less than 
the current threshold criteria. 

See also peak start.

peak height  (peak dimension) The distance from the 
peak maximum to the peak base, measured 
perpendicular to the ordinate. 

peak start  The start of a chromatograph peak occurs 
when the detection signal increases to a value greater 
than the current threshold criteria. 

See also peak end.

peak width  The distance across a peak measured at a 
selected peak-height level, in minutes or mass units. 
The peak-height level is usually specified as a 
percentage of the maximum peak height.

See also peak width at half height.

peak width at half height  The full width of a peak at 
half its maximum height, sometimes abbreviated 
FWHM. 

See also peak width and peak end. 

PID  proportional / integral / differential

P/N  part number

p-p  peak-to-peak voltage

ppm  parts per million

PQD  pulsed-Q dissociation

precursor ion  An electrically charged molecular species 
that can dissociate to form fragments. The fragments 
can be electrically charged or neutral species. A 
precursor ion (PR) can be a molecular ion or an 
electrically charged fragment of a molecular ion. Also 
known as parent ion.

precursor mass  Mass of the corresponding precursor 
(or parent) ion or molecule.

profile data   Data representing mass spectral peaks as 
point-to-point plots, with each point having an 
associated intensity value.

r

z
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psig  pounds per square inch, gauge

PTM  posttranslational modification

pulsed Q dissociation (PQD)  Collision-induced 
dissociation that involves precursor ion activation at 
high Q, a time delay to allow the precursor to 
fragment, and then a rapid pulse to low Q where all 
fragment ions are trapped. The fragment ions can 
then be scanned out of the ion trap mass analyzer and 
detected. PQD eliminates the “1/3 Rule” low mass 
cut-off for MS/MS data.

Q

quadrupole  A symmetrical, parallel array of four 
hyperbolic rods that acts as a mass analyzer or an ion 
transmission device. As a mass analyzer, one pair of 
opposing rods has an oscillating radio frequency (RF) 
voltage superimposed on a positive direct current 
(DC) voltage. The other pair has a negative DC 
voltage and an RF voltage that is 180 degrees out of 
phase with the first pair of rods. This creates an 
electrical field (the quadrupole field) that efficiently 
transmits ions of selected mass-to-charge ratios along 
the axis of the quadrupole rods.

R

RAM  random access memory

raw data  Uncorrected liquid chromatograph and mass 
spectrometer data obtained during an acquisition. 
Xcalibur and Xcalibur-based software store this data in 
a file that has a .raw file extension. 

resolution  The ability to distinguish between two 
points on the wavelength or mass axis.

retention time (RT)  The time after injection at which 
a compound elutes. The total time that the compound 
is retained on the chromatograph column. 

RF  radio frequency

RF lens  A multipole rod assembly that is operated with 
only radio frequency (RF) voltage on the rods. In this 
type of device, virtually all ions have stable trajectories 
and pass through the assembly. 

RF voltage  An AC voltage of constant frequency and 
variable amplitude that is applied to the ring electrode 
or endcaps of the mass analyzer or to the rods of a 
multipole. Because the frequency of this AC voltage is 
in the radio frequency (RF) range, it is referred to as 
RF voltage. 

RMS  root mean square

ROM  read-only memory

rotary-vane pump  A mechanical vacuum pump that 
establishes the vacuum necessary for the proper 
operation of the turbomolecular pump. (Also called a 
roughing pump or forepump.) 

RS-232  An accepted industry standard for serial 
communication connections. This Recommended 
Standard (RS) defines the specific lines and signal 
characteristics used by serial communications 
controllers to standardize the transmission of serial 
data between devices.

RT  An abbreviated form of the phrase retention time 
(RT). This shortened form is used to save space when 
the retention time (in minutes) is displayed in a 
header, for example, RT: 0.00-3.75.

S

s  second

scan mode and scan type combinations  A function 
that coordinates the three processes in the 
MS detector: ionization, mass analysis, and ion 
detection. You can combine the various scan modes 
and scan types to perform a wide variety of 
experiments. 

selected ion monitoring (SIM) scan type  A scan type 
in which the mass spectrometer acquires and records 
ion current at only one or a few selected 
mass-to-charge ratio values. 

See also selected reaction monitoring (SRM) scan 
type.

selected reaction monitoring (SRM) scan type  A scan 
type with two stages of mass analysis and in which a 
particular reaction or set of reactions, such as the 
fragmentation of an ion or the loss of a neutral moiety, 
is monitored. In SRM a limited number of product 
ions is monitored. 
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SEM  secondary electron multiplier

Serial Peripheral Interface (SPI)  hardware and 
firmware communications protocol

serial port  An input/output location (channel) for 
serial data transmission.

sheath gas  The inner coaxial gas (nitrogen), which is 
used in the API source to help nebulize the sample 
solution into a fine mist as the sample solution exits 
the ESI or APCI nozzle. 

sheath gas flow rate  The rate of flow of sheath gas into 
the API source. A measurement of the relative flow 
rate (in arbitrary units) that needs to be provided at 
the sheath gas inlet to provide the required flow of 
sheath gas to the ESI or APCI nozzle. 

sheath gas inlet  An inlet in the API probe where sheath 
gas is introduced into the probe. 

sheath gas plumbing  The gas plumbing that delivers 
sheath gas to the ESI or APCI nozzle. 

sheath gas pressure  The rate of flow of sheath gas 
(nitrogen) into the API source. A measurement of the 
relative flow rate (in arbitrary units) that needs to be 
provided at the sheath gas inlet to provide the required 
flow of inner coaxial nitrogen gas to the ESI or APCI 
nozzle. A software-controlled proportional valve 
regulates the flow rate. 

See also sheath gas. 

sheath gas valve  A valve that controls the flow of 
sheath gas into the API source. The sheath gas valve is 
controlled by the data system. 

signal-to-noise ratio (S/N)  The ratio of the signal 
height (S) to the noise height (N). The signal height is 
the baseline corrected peak height. The noise height is 
the peak-to-peak height of the baseline noise. 

SIM  See selected ion monitoring (SIM) scan type.

skimmer  A vacuum baffle between the higher pressure 
capillary-skimmer region and the lower pressure 
region. The aperture of the skimmer is offset with 
respect to the bore of the ion transfer capillary. 

source CID  A technique for fragmenting ions in an 
atmospheric pressure ionization (API) source. 
Collisions occur between the ion and the background 
gas, which increase the internal energy of the ion and 
stimulate its dissociation. 

SPI  See Serial Peripheral Interface (SPI).

SRM  See selected reaction monitoring (SRM) scan 
type.

sweep gas  Nitrogen gas that flows out from behind the 
sweep cone in the API source. Sweep gas aids in 
solvent declustering and adduct reduction.

See also sweep gas flow rate.

sweep gas flow rate  The rate of flow of sweep gas into 
the API source. A measurement of the relative flow 
rate (in arbitrary units) to provide the required flow of 
nitrogen gas to the sweep cone of the API source.

See also sweep gas.

syringe pump  A device that delivers a solution from a 
syringe at a specified rate.

T

T  Tesla

target compound  A compound that you want to 
identify or quantitate or that a specific protocol (for 
example, an EPA method) requires that you look for. 
Target compounds are also called analytes, or target 
analytes.

TIC  See total ion current (TIC).

TMP  See turbomolecular pump.

Torr  A unit of pressure, equal to 1 mm of mercury and 
133.32 Pa.

total ion current (TIC)  The sum of the ion current 
intensities across the scan range in a mass spectrum.

tube lens offset   The voltage offset from ground that is 
applied to the tube lens to focus ions toward the 
opening of the skimmer.

See also source CID.
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Tune Method  A defined set of mass spectrometer tune 
parameters for the ion source and mass analyzer. Tune 
methods are defined by using the instrument 
software’s tune window and saved as tune file.

A tune method stores tune parameters only. 
(Calibration parameters are stored separately, not with 
the tune method.)

tune parameters  Instrument parameters whose values 
vary with the type of experiment.

turbomolecular pump  A vacuum pump that provides 
a high vacuum for the mass spectrometer and detector 
system.

TWA  time weighted average

U

u  atomic mass unit

UHV  ultra high vacuum

ultra-high performance liquid chromatography 
(U-HPLC)  See high performance liquid 

chromatography (HPLC).

Ultramark 1621  A mixture of 
perfluoroalkoxycyclotriphosphazenes used for ion trap 
calibration and tuning. It provides ESI singly charged 
peaks at m/z 1022.0, 1122.0, 1222.0, 1322.0, 1422.0, 
1522.0, 1622.0, 1722.0, 1822.0, and 1921.9.

UMR  Universal Mass Range

V

V  volt

V AC  volts alternating current

V DC  volts direct current

vacuum manifold  A thick-walled, aluminum chamber 
with machined flanges on the front and sides and 
various electrical feedthroughs and gas inlets that 
encloses the API stack, ion optics, mass analyzer, and 
ion detection system.

vacuum system  Components associated with lowering 
the pressure within the mass spectrometer. A vacuum 
system includes the vacuum manifold, pumps, 
pressure gauges, and associated electronics.

vent valve  A valve that allows the vacuum manifold to 
be vented to air or other gases. A solenoid-operated 
valve.

vol  volume

W

w  width

W  watt

WEEE   European Union Waste Electrical and 
Electronic Equipment Directive. Provides guidelines 
for disposal of electronic waste.

X

XML (Extensible Markup Language)  A 
general-purpose markup language that is used to 
facilitate the sharing of data across different 
information systems, particularly via the Internet.
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display panel 4-4
Divert Valves page 3-11
duration, of bakeout 4-53
dynamic exclusion 3-48, 3-59, 3-66
Dynamic RT 3-51–3-52

E
eFT calibration 4-44
elapsed time

of current acquisition 4-37
of current procedure 4-42, 4-47, 4-53

error diagnosis 4-52, 4-58
ESI

auxiliary gas flow rate 4-16
sheath gas flow rate 4-16
source window 4-15
spray current 4-16
spray voltage 4-16
sweep gas flow rate 4-16

Evaluate window 4-46
evaluation procedure 4-46
Exactive window service 6-2
Exclusion List dialog box 3-83
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header information 3-4–3-5
Help menu 3-4
H-ESI

heater temperature 4-20
sheath gas flow rate 4-19
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Hot link 4-13–4-14

I
image files 4-58, 4-61
importing

data from csv files or txt files 3-75
lock masses 5-7

Inclusion List dialog box 3-78
inclusion masses list 3-42, 3-49, 3-51, 3-54
inject time 4-56
inside diameter, for syringes 4-69
in-source CID

activation 4-75
collision energy 3-35, 3-37, 3-39, 3-42, 3-49–3-50, 3-54, 3-60, 

3-67, 3-70, 3-72, 4-75
settings 4-13

installed instruments 4-4, 4-7, 4-10, 4-54
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instrument bakeout 4-52
Instrument Configuration program 3-2–3-3
Instrument Configuration window 1-1
Instrument Control panel 4-12
instrument files 1-2
instrument identification 4-65
instrument method 3-4–3-5, 4-38, 4-56
Instrument Setup window 3-2
instrument status 1-2, 4-9
instrument status warn level 4-31, 5-19
instrument status window

shortcut menus 4-59
Vacuum System node 4-52

instrument type 1-2
Intact Protein 5-21–5-22, 5-24
ion polarity 4-56
ion source region 4-52
ionization method 4-30
IP address 1-2
isolation offset 3-45, 3-50, 3-52, 3-55–3-56, 3-64, 3-69
isolation width 3-44, 3-49, 3-52, 3-63, 3-68, 4-72
isolation window 3-44, 3-49, 3-52, 3-63, 3-68
isotope clusters 3-47, 3-59

L
license

key 4-67, 5-2
settings 4-65, 5-2

License dialog box 4-66, 5-2
list, of recent scans 4-13
lock mass collection

deleting 4-82
name 4-81, 4-83

Lock Mass Replacement dialog box 4-81
lock masses 3-28

creating 4-78
editing 3-75, 3-78, 3-83, 4-77
exporting 5-4
usage 4-14, 4-84

Lock Masses dialog box 3-75, 4-77
log file 1-2
Loop count 3-44, 3-52, 3-54, 3-56, 3-63

M
mains failure 5-13
MALDI

sheath gas flow rate 4-35
source 4-34
source heated capillary temperature 4-36
source window 4-34
spray current 4-35

spray voltage 4-35
sweep gas flow rate 4-35

manual control, of syringe pump 4-70
mass accuracy 5-17
Mass Calculator 3-92, 4-7, 4-67
mass calibration 5-18
mass difference, of the potential neutral loss 3-88
mass resolution 3-36–3-37, 3-39–3-40, 3-43–3-44, 3-49, 3-51, 
3-54–3-55, 3-61, 3-63, 3-67, 3-70, 3-72, 4-14, 4-84
Mass Traces window 4-39
maximum audit record length 1-2
maximum injection time 3-36–3-37, 3-39–3-40, 3-43–3-44, 
3-49, 3-51, 3-54–3-55, 3-61–3-63, 3-68, 3-70, 3-72, 4-14
maximum value, for apex trigger 3-46, 3-58, 3-65
maximum value, for scan range 3-36, 3-38, 3-40–3-41, 3-43, 
3-61–3-62, 3-71, 3-73, 4-72, 4-74
menu bar 4-3
messages window 4-59
Method Editor 3-6
microscan 3-35, 3-37, 3-39–3-40, 3-43–3-44, 3-49, 3-51, 3-54–
3-55, 3-60–3-61, 3-63, 3-67, 3-70, 3-72, 4-14, 4-56
minimum value, for apex trigger 3-46, 3-58, 3-65
minimum value, for scan range 3-36, 3-38, 3-40–3-41, 3-43, 
3-61–3-62, 3-71, 3-73, 4-72, 4-74
mouse

panning 4-56–4-57, 4-61
wheel 4-55, 4-60
zooming 4-57

MSX count 3-44, 3-56, 3-63, 3-68

N
nanospray ionization 4-21
negative ion mode, calibration 4-44
network address 1-2
network drives 4-37
Neutral Losses dialog box 3-87
noise level 4-56
normalized collision energy (NCE) 3-81, 4-76
NSI

sheath gas flow rate 4-22
source 4-21
source window 4-21
spray current 4-22
spray voltage 4-22
sweep gas flow rate 4-22

number, of scans 4-56

O
Oracle audit database 1-2
Orbitrap chamber 4-52
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P
page setup 3-4
Parallel Reaction Monitoring (PRM)

description 3-23
properties 3-50

Pathfinder 4-39
peptide-like isotopic distributions 3-47, 3-66
performance status 2-2, 4-11, 5-17
Pirani gauge 4-52
polarity 3-35, 3-37, 3-39, 3-42, 3-49–3-50, 3-54, 3-60, 3-67, 3-70–
3-71, 3-76, 3-80, 3-85, 4-14
positive ion mode, calibration 4-43–4-44
precision, of mass positions 4-84
precursor mass 4-72
pressure values 4-52
print preview 4-57, 4-61
printer’s parameters 4-57, 4-61
printing 3-4, 3-74
pumping, the system 5-13

Q
Q Exactive HF-X Tune

version 4-65
window 4-2

quadrupole
calibration 4-43
transmission 4-48

Qual Browser 4-37

R
removing, gases 5-13
Reports menu 4-7
resolution 3-36–3-37, 3-39–3-40, 3-43–3-44, 3-49, 3-51, 3-54–
3-55, 3-61, 3-63, 3-67, 3-70, 3-72, 4-14
retention time correction 3-51–3-52
RS-232 5-16

S
sample name 4-38
scan event 4-56
Scan Groups pane 3-19
Scan Parameters History dialog box 4-70
Scan Parameters window 4-13
scan range 4-13, 4-56, 4-73
Scan range dialog box 4-73
scan segment 4-56
scan type 4-13, 4-56
segmented master scans 3-36, 3-43
selected ion monitoring (SIM) 4-72

Sequence Setup View 4-9
setup parameters 3-2–3-3
shortcut menus

analysis graphs window 4-61
debug messages window 4-63
instrument status window 4-59
Lock Masses dialog box 4-78
spectrum window 4-58
Status page 2-1
tray icon 4-2

source type 4-56
spectral multiplexing 3-44, 3-49, 3-52, 3-55–3-56, 3-63, 3-68
spectrum window

display options 4-84
toolbar 4-56
visibility 4-54
zooming 4-55

standby mode 4-9, 4-39, 4-53
Status page, of Information view 2-1
status, of current acquisition 4-37
Stepped CE 3-72
Summary page 3-74
sweep gas flow, during standby 5-20
switch positions

of switching valves 3-31
of syringe pump 3-30–3-32
of tune files 3-30

syringe
diameter 3-32
type 3-32, 4-69
volume 3-32, 4-69

syringe pump
interface 5-16
manual control 4-70
operating status 3-31, 4-10
parameters 4-69

system bakeout 5-13
system settings 4-6
system tray, in Microsoft Windows 4-2

T
Tag Masses dialog box 3-90
tasks panel 4-3, 4-12
text editor 4-59
third party licenses 4-65
title bar 3-76, 3-81, 3-86, 3-88, 3-91, 4-3
toggling, between mouse panning and mouse zooming 4-57
toolbars

analysis graphs window 4-61
spectrum window 4-57
Tune window 4-9

tooltip 4-6
TopN 3-22, 3-42, 3-44, 3-56, 3-63
total ion current (TIC), plotting 4-40
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trapping gas pressure 5-22
tune file 4-5, 6-3
Tune Files pane 3-9
Tune Method 4-3, 4-5, 4-9

U
UHV warning level 5-19
user role 4-3, 4-5

V
Vacuum / Bakeout window 4-52
vacuum gauges 4-52
Vacuum System node 4-52
validity period, of mass calibration 5-18
valve position 4-10

View bar 3-3

W
width, of scan range 3-36, 3-38, 3-40–3-41, 3-43, 3-61–3-62, 
3-71, 3-73, 4-72, 4-74

X
Xcalibur 4-9, 4-37, 4-39

Z
zooming

analysis graphs window 4-55, 4-60
spectrum window 4-55
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